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or pending trademarks of Merck KGaA. All other trademarks are acknowledged.



End User License Agreement
During installation the EULA below is presented:

EMD MILLIPORE CORPORATION SOFTWARE LICENSE AGREEMENT
PLEASE READ THE FOLLOWING TERMS AND CONDITIONS CAREFULLY
BEFORE DOWNLOADING, INSTALLING OR USING THE SOFTWARE OR ANY
ACCOMPANYING DOCUMENTATION (COLLECTIVELY, THE “SOFTWARE”).
THE TERMS AND CONDITIONS OF THIS SOFTWARE LICENSE AGREEMENT
(“AGREEMENT”) GOVERN USE OF THE SOFTWARE UNLESS YOU AND EMD
MILLIPORE CORPORATION (“EMD MILLIPORE”) HAVE EXECUTED A
SEPARATE AGREEMENT GOVERNING USE OF THE SOFTWARE.

EMD Millipore is willing to license the Software to you only upon the condition that you
accept all the terms contained in this Agreement. By clicking on the “I accept” button
below or by downloading, installing or using the Software, you have indicated that you
understand this Agreement and accept all of its terms. If you are accepting the terms of this
Agreement on behalf of a Company or other legal entity, you represent and warrant that
you have the authority to bind that Company or other legal entity to the terms of this Agree-
ment, and, in such event, “you” and “your” will refer to that Company or other legal entity.
If you do not accept all the terms of this Agreement, then EMD Millipore is unwilling to
license the Software to you, and you must return the Software to EMD Millipore for a full
refund, if you have paid for the license to the Software, or, if EMD Millipore has made the
Software available to you without charge, you must destroy all copies of the Software.
Your right to return the Software for a refund expires 30 days after the date of purchase.

1 Grant of License. Conditioned upon your compliance with the terms and conditions of
this Agreement, EMD Millipore grants you a non-exclusive and non-transferable license to
Execute (as defined herein) the executable form of the Software on a single computer,
solely for your internal business purposes. You may make a single copy of the Software for
backup purposes, provided that you reproduce on it all copyright and other proprietary
notices that are on the original copy of the Software. EMD Millipore reserves all rights in
the Software not expressly granted to you in this Agreement. For purposes of this Agree-



ment, “Execute” and “Execution” means to load, install, and run the Software in order to
benefit from its functionality as designed by EMD Millipore.

2 Restrictions. Except as expressly specified in this Agreement, you may not: (a) copy
(except in the course of loading or installing) or modify the Software, including but not lim-
ited to adding new features or otherwise making adaptations that alter the functioning of the
Software; (b) transfer, sublicense, lease, lend, rent or otherwise distribute the Software to
any third party; or (c) make the functionality of the Software available to multiple users
other than the users of the single computer for which it is licensed through any means,
including but not limited to uploading the Software to a network or file-sharing service or
through any hosting, application services provider, service bureau, software-as-a-service
(SaaS) or any other type of services. You acknowledge and agree that portions of the Soft-
ware, including but not limited to the source code, file formats, and the specific design and
structure of individual modules or programs, constitute or contain trade secrets of EMD Mil-
lipore and its licensors. Accordingly, you agree not to disassemble, decompile or reverse
engineer the Software or data files, in whole or in part, or permit or authorize a third party
to do so, except to the extent such activities are expressly permitted by law notwithstanding
this prohibition.

3 Ownership. The copy of the Software is licensed, not sold. You own the media on which
the Software is recorded, but EMD Millipore retains ownership of the copy of the Software
itself, including all intellectual property rights therein. The Software is protected by United
States copyright law and international treaties. You will not delete or in any manner alter
the copyright, trademark, and other proprietary rights notices or markings appearing on the
Software as delivered to you.

4 Term. The license granted under this Agreement remains in effect for a period of 75
years, unless earlier terminated in accordance with this Agreement. You may terminate the
license at any time by destroying all copies of the Software in your possession or control.
The license granted under this Agreement will automatically terminate, with or without
notice from EMD Millipore, if you breach any term of this Agreement. Upon termination,
you must at EMD Millipore’ option either promptly destroy or return to EMD Millipore all
copies of the Software in your possession or control.

5 Limited Warranty. EMD Millipore warrants that, for thirty (30) days following the date of
purchase (or delivery, if EMD Millipore has made the Software available to you without
charge), the Software will perform in all material respects in accordance with the Docu-
mentation. As your sole and exclusive remedy and EMD Millipore’ entire liability for any
breach of this limited warranty, EMD Millipore will at its option and expense promptly cor-
rect or replace the Software so that it conforms to this limited warranty. EMD Millipore
does not warrant that the Software will meet your requirements that the Software will oper-
ate in the combinations that you may select for Execution, that the operation of the Soft-
ware will be error-free or uninterrupted, or that all Software errors will be corrected. The



warranty set forth in this Section 5 does not apply to the extent that EMD Millipore
provides you with the Software (or portions of the Software) for beta, evaluation, testing or
demonstration purposes.

6 DISCLAIMER. THE LIMITED WARRANTY SET FORTH IN SECTION 5 IS IN
LIEU OF AND EMD MILLIPORE EXPRESSLY DISCLAIMS ALL OTHER
WARRANTIES AND CONDITIONS, EXPRESS OR IMPLIED, INCLUDING BUT
NOT LIMITED TO ANY IMPLIED WARRANTIES AND CONDITIONS OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT, AND ANY WARRANTIES AND CONDITIONS ARISING
OUT OF COURSE OF DEALING OR USAGE OF TRADE. NO ADVICE OR
INFORMATION, WHETHER ORAL OR WRITTEN, OBTAINED FROM EMD
MILLIPORE OR ELSEWHERE WILL CREATE ANY WARRANTY OR
CONDITION NOT EXPRESSLY STATED IN THIS AGREEMENT.

7 Limitation of Liability. EMD MILLIPORE’ TOTAL LIABILITY TO YOU FROM
ALL CAUSES OF ACTION AND UNDER ALL THEORIES OF LIABILITY WILL
BE LIMITED TO THE AMOUNTS PAID TO EMD MILLIPORE BY YOU FOR THE
SOFTWARE OR, IN THE EVENT THAT EMD MILLIPORE HAS MADE THE
SOFTWARE AVAILABLE TO YOU WITHOUT CHARGE, EMD MILLIPORE’
TOTAL LIABILITY WILL BE LIMITED TO $100. IN NO EVENT WILL EMD
MILLIPORE BE LIABLE TO YOU FOR ANY SPECIAL, INCIDENTAL,
EXEMPLARY, PUNITIVE OR CONSEQUENTIAL DAMAGES (INCLUDING
LOSS OF DATA, BUSINESS, PROFITS OR ABILITY TO EXECUTE) OR FOR
THE COST OF PROCURING SUBSTITUTE PRODUCTS ARISING OUT OF OR IN
CONNECTION WITH THIS AGREEMENT OR THE EXECUTION OR
PERFORMANCE OF THE SOFTWARE, WHETHER SUCH LIABILITY ARISES
FROM ANY CLAIM BASED UPON CONTRACT, WARRANTY, TORT
(INCLUDING NEGLIGENCE), STRICT LIABILITY OR OTHERWISE, AND
WHETHER OR NOT EMD MILLIPORE HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH LOSS OR DAMAGE. THE FOREGOING LIMITATIONS
WILL SURVIVE AND APPLY EVEN IF ANY LIMITED REMEDY SPECIFIED IN
THIS AGREEMENT IS FOUND TO HAVE FAILED OF ITS ESSENTIAL
PURPOSE.

8 U.S. Government End Users. The Software and Documentation are “commercial items”
as that term is defined in FAR 2.101, consisting of “commercial computer software” and
“commercial computer software documentation,” respectively, as such terms are used in
FAR 12.212 and DFARS 227.7202. If the Software and Documentation are being
acquired by or on behalf of the U.S. Government, then, as provided in FAR 12.212 and
DFARS 227.7202-1 through 227.7202-4, as applicable, the U.S. Government’s rights in
the Software and Documentation will be only those specified in this Agreement.



9 Export Law. You agree to comply fully with all U.S. export laws and regulations to
ensure that neither the Software nor any technical data related thereto nor any direct
product thereof are exported or re-exported directly or indirectly in violation of, or used for
any purposes prohibited by, such laws and regulations.

10 General. This Agreement will be governed by and construed in accordance with the
laws of the State of Washington, without regard to or application of conflict of laws rules or
principles. The United Nations Convention on Contracts for the International Sale of
Goods will not apply. You may not assign or transfer this Agreement or any rights granted
hereunder, by operation of law or otherwise, without EMD Millipore’ prior written con-
sent, and any attempt by you to do so, without such consent, will be void. Except as
expressly set forth in this Agreement, the exercise by either party of any of its remedies
under this Agreement will be without prejudice to its other remedies under this Agreement
or otherwise. All notices or approvals required or permitted under this Agreement will be in
writing and delivered by confirmed facsimile transmission, by overnight delivery service, or
by certified mail, and in each instance will be deemed given upon receipt. All notices or
approvals will be sent to the addresses set forth in the applicable ordering document or
invoice or to such other address as may be specified by either party to the other in accord-
ance with this section. The failure by either party to enforce any provision of this Agree-
ment will not constitute a waiver of future enforcement of that or any other provision. Any
waiver, modification or amendment of any provision of this Agreement will be effective
only if in writing and signed by authorized representatives of both parties. If any provision
of this Agreement is held to be unenforceable or invalid, that provision will be enforced to
the maximum extent possible, and the other provisions will remain in full force and effect.
This Agreement is the complete and exclusive understanding and agreement between the
parties regarding its subject matter, and supersedes all proposals, understandings or com-
munications between the parties, oral or written, regarding its subject matter, unless you
and EMD Millipore have executed a separate agreement. Any terms or conditions con-
tained in your purchase order or other ordering document that are inconsistent with or in
addition to the terms and conditions of this Agreement are hereby rejected by EMD Mil-
lipore and will be deemed null.

11 Contact Information. If you have any questions regarding this Agreement, you may con-
tact EMD Millipore at 645 Elliott Avenue, Suite 100, Seattle, WA 98119. DURING
INSTALLATION, IF YOU AGREE TO THE FOREGOING TERMS AND
CONDITIONS AND DESIRE TO COMPLETE INSTALLATION OF THE
SOFTWARE, PLEASE CLICK THE “I ACCEPT” BUTTON. OTHERWISE, PLEASE
CLICK THE “I DO NOT ACCEPT” BUTTON AND THE INSTALLATION
PROCESS WILL STOP.



Disclaimers

The screen shots presented in this manual were created using the Microsoft® Windows®
XP operating system and may vary slightly from those created using other operating sys-
tems.The Amnis® ImageStream® cell analysis system is for research use only and not for
use in diagnostic procedures.

Technical Assistance

Amnis - part of EMD Millipore
645 Elliott Ave. W. Suite 100
Seattle, WA
Phone: 206-374-7000
Toll free: 800-730-7147
www.amnis.com

http://www.amnis.com/
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Chapter 1

Welcome to IDEAS® 6.2
Welcome to the IDEAS version 6.2 application documentation for ImageStream and
FlowSight data analysis.

How to use this manual
This manual provides instruction for using the Amnis IDEAS® application to analyze
data files from the Amnis ImageStream and FlowSight cell analysis systems.

The intuitive user interface of the IDEAS applicationmakes it easy for you to explore
and analyze data. The application can quantify cellular activity by performing stat-
istical analyses on thousands of events and, at the same time, permit visual con-
firmation of any individual event. Furthermore, you can operate the application in a
batch processingmode and store specific analysis templates for either repeated use
or sharing with colleagues.

The fastest way to put the IDEAS application to work is to first skim through this
manual—becoming familiar with the application’s structure, compensation, file types,
and analysis tools—and then use the application wizards on some sample exper-
imental data to begin exploring the power that the application provides. This manual
has been integrated into the IDEAS application to provide searchable and context
sensitive help. Typing F1 while in the application opens the help files.
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What's New in IDEAS 6.2

What's New in IDEAS 6.2

IDEAS 6.2 offers numerous improvements for analyzing data from any
ImageStream or FlowSight instrument. Please refer to the web site for the latest
improvements and updates to this manual.

Feature values in IDEAS are now being saved in binary format to
reduce the file size and facilitate faster analysis. Therefore, daf
files generated using IDEAS 6.2 cannot be opened using previous
versions. The .daf files created by previous versions of IDEAS
may be opened by IDEAS 6.2. However, if the files are edited and
saved, they will no longer be able to be opened by previous ver-
sions.

Workflow Enhancements
1 Statistics reports can now be viewed in IDEAS.
2 The ability to segment .rif files is now available in both single file load and batch

mode.
3 Acquisition analysis can be carried into IDEAS: Analysis performed on the instru-

ment (feature definitions/regions/populations and analysis area plots) can now be
carried over to IDEAS. This means that the user can now choose to use the
acquisition analysis as a custom default template for every .rif file.

4 Region definitions in a template now have the property that can be set to pre-
serve regions in .daf files. This means that when a template with a region thus
defined is applied to a daf file, the region co-ordinates will be taken from the exist-
ing ones in the daf and not from the template when the new daf is created. If no
region with the same name exists in the daf file, the template definition will be
applied. See the section 'Using the regionmanager' in chapter 3 for more inform-
ation.

5 Processed batches can be selected for re-processing. This is especially useful
when the batches contain many files from different folders.

6 Daf file batching now allows for updating existing dafs with additional fea-
tures/masks as well as modifications to the analysis area. In the event that the
template contains features that are not already present in the daf, only these fea-
tures are computed. Previously, new feature creation only occurred from the cif
to daf processing.

7 Acquisition analysis performed during acquisitionmay now be used when open-
ing a rif file in IDEAS both individually and during batching. This allows the carry-
over of the graphs, regions, and populations set up in INSPIRE for analysis in
IDEAS.

Masks and Features
1 There are four new masks: LevelSet, AdaptiveErode, Watershed and Com-

ponent. Please see chapter 4 for details on the new masks.
2 The Spot Mask was modified to take a lower radius value for the tophat oper-

ation.
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Chapter 1

3 TheObject mask was modified to not mask pixels outside of themain object.
4 The Spot Count feature has a new parameter that is used to determine if spots

are connected. This is helpful for spots that are on the diagonal. See the Spot
Count feature definition in chapter 4 for more information.

Reporting
1 In version 6.2 and later additional information has been added to the printed report

to assist users in tracking changes that may have beenmade in the files. This
includes file names, laser information, compensationmatrix and region coordin-
ates.
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Setting Up the IDEAS® Application

Setting Up the IDEAS® Application
This chapter describes the hardware and software requirements for
the application, which includes the procedures for installing, remov-
ing, and upgrading the application. The following subsections cover
this information:

Setting Up the IDEAS® Application

Installing the IDEAS Application

Setting Your Computer to Run the IDEAS® Application

Viewing and Changing the Application Defaults

Hardware and Software Requirements
This section states theminimum and the recommended hardware and software
requirements for running the IDEAS application.

Hardware Requirements
Theminimum hardware requirements are 4GB of RAM and a dual core Intel pro-
cessor. However, due to the large size of the image files that the ImageStream cell
analysis system creates, a larger amount of RAM will prevent paging and thus
increase performance.

Software Requirements
IDEAS 6.2 64 bit version requires that theWindows 7 or 8 operating system be
installed on your computer. IDEAS 32 bit version requires Windows XP, Windows
2000 or later version of the operating system. The latest service pack and any crit-
ical updates for the operating systemmust be included. Youmust also install the
Microsoft .NET Framework 2.0, which requires Microsoft Internet Explorer 5.01 or
later.

Important: If the software requirements are not met, Setup will not block installation
nor provide any warnings.

Note that service packs and critical updates are available from theMicrosoft Secur-
ity Web Site.

Installing the IDEASApplication
If the IDEAS application has previously been installed, the previous version will be
removed during installation.

To install IDEAS software

1 Download the application Setup file from your account at www.amnis.com.
2 View the contents in My Computer orWindows Explorer.
3 Double-click Setup.exe.
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Chapter 1

4 Follow the instructions until the installation process has completed.
5 MadCap help viewer is installed and opened during installation or upgrade.
6 Select the language and check box to not show this dialog again.
7 An icon appears on the desktop and IDEAS Application appears on the All Pro-

grams menu.

Setting Your Computer to Run the IDEAS® Application

Setting the Screen Resolution
Confirm that the screen resolution is adequate for the IDEAS application. To be able
to view the entire application window, youmust set the width of the screen res-
olution to aminimum of 1024 pixels.

To set the screen resolution

1 From the Start menu, select Control Panel, and then click Display.
2 Click the Settings tab to set the screen resolution.

Viewing File Name Extensions
When loading a file, the IDEAS application uses the file name extension to determ-
ine the file type. It will be easier for you to distinguish raw image files, compensated
image files, and data analysis files from each other if Windows Explorer does not
hide the extensions.

To view file name extensions

1 InWindows Explorer, go to Tools > Folder Options.
2 Click the View tab, andmake sure that the Hide extensions for known file types

check box is not selected.
3 Click OK.

Copying the Example Data Files
Copy data files to a single directory on your hard drive. Sample data files are avail-
able on your workstation or at www.amnis.com/login for customers with an account.

To copy the example data files

1 Copy the data files.
2 Right-click the directory that contains the data files, and click Properties.
3 Clear the Read-only check box.
4 Click OK.
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Setting Up the IDEAS® Application

Viewing and Changing the Application Defaults
To view or change these defaults, chooseApplication Defaults from
the Options menu, Each tab allows you to view or change the
default settings.
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The Directories tab contains the default Data, Template, Batch or Compensation
Matrix file directories.
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Setting Up the IDEAS® Application

The Populations tab contains the default color or symbol for populations. To change
the default settings, click on the color to or choose a default symbol from the list.

TheMasks tab contains the default mask color. To change the color of themask
click on the color button.
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TheGraph Displaytab contains the default settings for graphs in the analysis area
including graph size, font sizes and the default list of statistics shown for a graph.
Check the box next to the statistic to have it show below the graphs when statistics
are shown for a graph. The settings may be updated on all or selected graphs in the
analysis area.

TheGraph Export tab contains the default settings for exporting graphs including
the graph size, font size, options to include legend, cursor sample name and
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Setting Up the IDEAS® Application

statistics. Select the Defaults button to use the graph export settings when export-
ing graphs or select the Graph button to use the settings as they appear in the ana-
lysis area for the graph.
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TheImage Export tab contains the default settings for image export when copying
and pasting from IDEAS for reporting into other programs.
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Setting Up the IDEAS® Application

The Colors tab contains themapping of dark and light mode colors.
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Chapter 2: Overview of IDEAS
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Chapter 2

Overview of the IDEAS® Application
This chapter provides an overview of the IDEAS application user
interface, the files that the IDEAS application creates and uses, the
recommended directory organization and an overview of the work-
flow.

Understanding the Data Analysis Workflow

Overview of compensation, analysis tools and file structure

The Amnis cell analysis systems possess unique capabilities that neither flow cyto-
metry nor microscopy alone can deliver. The IDEAS application provides an image
gallery to view every cell in the data file along with linked graphical data for confident
gating and image confirmation. The application contains powerful algorithms that
facilitate and quantify the image analysis of ImageStream and FlowSight QI data.
Examples include the analysis of molecule co-localization and translocation, the ana-
lysis of cell-to-cell contact regions and signaling interactions, the detection of rare
molecules and cells, and a comprehensive classification of large numbers of cells.
The IDEAS application acquires data from INSPIRE™, compensates the images,
and allows the user to evaluate images with data analysis tools. For more inform-
ation about the QI and non-QI FlowSight data see Comparing the FlowSight basic,
Quantitative Imaging and ImageStream data files.

Note: Feature values in IDEAS 6.2 and later versions are
now being saved in binary format to reduce the file size and
facilitate faster analysis. Therefore, daf files generated using
IDEAS 6.2 cannot be opened using previous versions. The
.daf files created by previous versions of IDEAS may be
opened by IDEAS 6.2. However, if the files are edited and
saved, they will no longer be able to be opened by previous
versions.
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Comparing the FlowSight basic, Quantitative Imaging and ImageStream data files

Comparing the FlowSight basic, Quantitative Imaging and
ImageStream data files

There are three types of instruments that collect data for Image Analysis in IDEAS:
The FlowSight without Quantitative Imaging (QI), The FlowSight with the QI upgrade
and the ImageStream. There are some differences in the available features and ana-
lysis that can be done. The table below outlines these differences.

FlowSight - basic FlowSight - QI ImageStream

Default template
INSPIRE features
and acquisition ana-
lysis

IDEAS default fea-
ture set - analysis

IDEAS default fea-
ture set - no analysis

Default compensation
matrix INSPIRE matrix No compensation No compensation

New feature calculation Combined features
only Unlimited Unlimited

User defined masks No Yes Yes

Default mask
INSPIRE mask cal-
culated during
acquisition

Default (Object)
mask computed in
IDEAS

Default (Object)
mask computed in
IDEAS

Wizards
Open File, Display
Properties and
Begin Analysis

Complete set Complete set

Building blocks All All All
Merging files No Yes Yes

Compensation Intensity and
Images only

All features and
Images

All features and
Images

Create new files from
populations No Yes Yes

Data comparison

.
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Understanding the Data Analysis Workflow
Data analysis in IDEAS begins with opening a raw image file (.rif) that was collected
and saved using INSPIRE. Then, an existing compensationmatrix or a new com-
pensationmatrix is applied to the .rif file and two additional files are created, the .cif
(compensated image file) and .daf (data analysis file).

A compensationmatrix performs fluorescence compensation, which removes fluor-
escence that leaks into other channels. SeeOverview of Compensation for more
information about compensation. A compensated image can accurately depict the
correct amount of fluorescence in each cell image. Compensation is defined as the
correction of the fluorescence crosstalk. When creating the .cif the IDEAS applic-
ation also automatically performs corrections to the raw imagery using values saved
from the instrument at the time of data collection. These corrections include
flowspeed normalization, brightfield gains, and spatial registry.

A template is used to define the features, graphs, image display properties and ana-
lysis for the .daf. Within the .daf file, the user can perform many analyses using the
tools and wizards within the application and save the results as a template file (.ast).

The IDEAS application then calculates feature values and shows the data as spe-
cified by the selected template.

Once a data analysis file (.daf file) or compensated image file (.cif file) is saved, it
can be opened directly for data analysis. You would only open a .cif if you wanted to
change the template or a .rif file to change the compensation.

The diagram on the next page displays this workflow.
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Understanding the Data Analysis Workflow

Overview of Data Analysis Workflow

1 Create a compensationmatrix using the single color control files. Open an exper-
imental .rif file or from the Compensationmenu choose Create New Matrix.

2 A .cif and .daf file are automatically created. Analyze the experimental file using
data analysis tools in the .daf file to create an analysis template.

3 Create a statistics report table within the .daf file and save the data file, as an
anlaysis template.

Note: this is usually done on the positive and negative controls to create the appro-
priate analysis and then applied to the rest of the experimental files in the next step.

4 Perform batch processing, applying compensation and template files created
above.
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Overview of the Data File Types
Data from the Amnis cell analysis systems are collected andmanaged using three
types of data files: raw image file (.rif), compensated image file (.cif), and data ana-
lysis file (.daf).

This section describes each file type and the table summarizes the features of each
file.

Raw Image File (.rif)
The INSPIRE application saves the digital image data, pixel intensities and location
that were acquired by the instrument to a .rif file.

A .rif file contains:

• Pixel intensity data (counts and location) collected for each object that the
instrument detected.

• Instrument settings that were used for data collection.
• Calibration values from ASSIST.
• Compensationmatri x if used while acquiring data.

Compensated Image File (.cif)
The IDEAS application creates a .cif file when the user opens a .rif file and applies a
compensationmatrix. The segmentation algorithm automatically defines the bound-
aries of each object, creating amask that is used for calculating feature values. The
applied compensationmatrix performs pixel-by-pixel fluorescence compensation
prior to segmentation.During the creation of the .cif file, the applicationmakes cor-
rections to the imagery. These corrections include:

• Removal of artifacts from variability in the flow speed, camera background,
and brightfield gains.

• Alignment of the objects to subpixel accuracy, which allows the viewing of
compensated imagery, composite imagery and the calculation of multi-image
feature values, such as the Internalization value.

• Coincident objects are cut apart to place into individual image frames. Note
that this will increase the number of objects in the file.

Multiple .cif files can be created from a single .rif file by applying a different fluor-
escence compensationmatrix or correction each time a .rif file is opened and choos-
ing a unique name for the .cif file. Similarly, you can create a new .daf file from a
single .cif file by creating a new name and applying a different analysis template.

Data Analysis File (.daf)
The IDEAS application creates a .daf file while it is loading a .cif file into a template
file (.ast). The .daf file is the interface to visualize and analyze the imagery that the
.cif file contains andmust reside in the same directory as the corresponding .cif file.

The .daf file contains:
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Overview of the Data File Types

• Feature definitions
• Population definitions
• Calculated feature values
• Image display settings
• Definitions for graphs and statistics

Loading a .daf file restores the application to the same state it was in when the file
was saved, i.e., with the same views, graphs, and populations. In IDEAS versions
3.0 or later, a .daf file may be used as a template.

Note: When a .daf file is opened, the .cif file must be located in the same directory
as the .daf file since the .daf file points to images used for analysis that are stored in
the associated .cif file.

Template (.ast)
The IDEAS application saves the set of instructions for an analysis session in a .daf
file to a template (.ast file). Note that a template contains no data; it simply contains
the structure for the analysis. This structure includes definitions for:

• Features
• Graphs
• Regions
• Populations

The .ast also contains settings for:

• Image viewing
• Image names
• Statistics

The \templates subdirectory (under the directory where the IDEAS application
was installed) contains the default template, named defaulttemplate.ast. Because a
template is required for loading a .cif file, youmust use the default template to create
the first .daf file. After you save a custom template, you can use it for any sub-
sequent loads of .cif files.

Note: The default templatemay change between releases of the IDEAS application
software. In IDEAS versions 3.0 or later, a .daf file may be used as a template. The
default template contains over 200 calculated features per object. An expanded tem-
plate is also available that includes over 600 calculated features per object. The
FlowSight without the Quantitative Imaging upgrade has a limited set of features
available.

Compensation Matrix File (.ctm)
The IDEAS application saves the compensation values that are created and saved
during the spectral compensation of control files to a compensationmatrix file (.ctm
file). This file has no associated object data; it is created and saved to be applied to
experimental files. The compensationmatrix can be created in IDEAS using single
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color control files after acquisition or during acquisition. See the INSPIRE or
FlowSight manual for more information.

Review of Data File Types

File Acronym and
Name

File Creation Description

.rif
Raw Image File Created in INSPIRE

Contains instrument setup data, pixel intensity data,
and uncorrected image data from the INSPIRE applic-
ation. The IDEAS application uses the .rif file to create
a compensated image file (.cif file).

.cif
Compensated
Image File

User creates a .cif
from the .rif and .ctm

Contains imagery that has been corrected for variations
in the camera background, camera gains, flow speed,
and vertical and horizontal positioning between chan-
nels.
Serves as a database of images used for feature-value
calculations and imagery display.
The IDEAS application also performs fluorescence com-
pensation, if necessary, when creating a .cif file.
The IDEAS application loads the .cif file into a template
to create a data analysis file (.daf file)

.daf
Data Analysis File References the .cif

Themain working data file that contains the calculated
feature values, the graphs, and the statistics used for
analysis. The .daf file references the .cif.

.ast
Template File Created from the .daf

This file contains no data; it contains the structure for
the analysis, such as, definitions for features, graphs,
regions, and populations; image viewing settings;
image names; and statistics settings.

.ctm
Compensation
Matrix File

User creates new
.ctm when opening a
.rif or during acquis-
ition

Contains compensation values that are created and
saved during the spectral compensation of control .rif
files. This file has no associated object data; it is cre-
ated and saved to be applied to experimental .rif files.

Table 1: Review of Data File Types

Note about Case Sensitivity: Even thoughWindows does not treat file names as
case sensitive, the IDEAS application depends on the case-sensitive .rif, .cif, and
.daf file name extensions to identify the file types. Avoid the use of illegal characters
for file names such as: “\/:*?<>!”.
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Chapter 3: Getting Started with IDEAS
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Getting Started with the IDEAS Application
This chapter is divided into two sections. First, guided analysis is
described using the analysis wizards and second, advanced ana-
lysis with more detailed instructions that describe how to open, com-
pensate, merge, save, and create data files without using the
wizards. Building blocks are also discussed which provide a short
cut method to building commonly used graphs.

Guided analysis makes it easy to start analyzing your data. Once
you are familiar with the basic analysis available you may want to
perform more advanced analysis.

Note that data files from FlowSight without the Quantitative Imaging
upgrade have a limited feature set and limited wizard analysis.

General Outline of data analysis:
Note that these steps apply to any type of data analysis whether you use a wizard or
not.

1 Open one data file (the + or - control).
2 Create and save a compensationmatrix for the experiment.
3 Using an application wizard or the begin analysis wizard:

• Select focused cells.
• Select single cells (or conjugates).
• Select channels for subpopulationmarkers and gate to define subpopulations.
• Gate on positive cells for the channels you wish to use for morphological ana-

lysis.
4 By using an application wizard evaluate the feature for your analysis and refine

as needed. Or follow the feature finder wizard to find the feature that separates
your populations.Note that if themorphological differences are in separate files
this may require merging both a + and - control before beginning step 1.

5 Refine the analysis and save the template.
6 Perform batch analysis on all data files in the experiment using the compensation

matrix and analysis template.
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Guided Analysis
Data analysis always begins with opening a data file. The Start Analysis button will
step you through opening a file, setting the image display mapping and choosing an
analysis wizard.

Application wizards are available to guide you through an analysis. The wizards can

be accessed from theGuided Analysis menu or the wizard tool or at the end of
the Start Analysis routine.

The following wizards are available:
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ApplicationWizards
General:

• Open FileWizard:
— Guides you through the process of opening a data file and setting image

display mapping in the image gallery.
• Display Properties:

— Sets image display mapping in the image gallery.

• Begin Analysis:
— Guides you through finding focused, single, positive cells.

• Feature Finder:
— Guides you through finding focused, single, positive cells.positive cell-

s.and exploring features that separate chosen truth populations.

Application specific:

• Apoptosis Wizard
— Guides you through the process of creating the features and graphs for ana-

lyzing apoptosis.
• Cell Cycle - Mitosis Wizard

— Guides you through the process of creating the features and graphs for ana-
lyzing the cell cycle and enumeratingmitotic events.

• Co-localizationWizard
— Guides you through the process of creating the features and graphs for ana-

lyzing the co-localization of 2 probes.
• InternalizationWizard

— Guides you through the process of creating the features and graphs for ana-
lyzing the internalization of a probe.

• Nuclear LocalizationWizard
— Guides you through the process of creating the features and graphs for ana-

lyzing the nuclear localization of a probe.
• Shape ChangeWizard

— Guides you through the process of creating the features and graphs for ana-
lyzing the circular shape of a cell using a surface stain or brightfield image.

• Spot Wizard
— Guides you through the process of creating themask, feature and graphs

for analyzing fluorescently labeled spots in images.

The wizard window is organized so that the instructions for each step are written in
the left side of the window, the stepwise progress through the wizard is shown in the
list on the right side and theremay be tips provided at the bottom of the window.
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Click Next to progress through the wizard or Exit to stop at any time. Some steps
are optional and a Skip button is provided. Follow the instructions in the wizard to
complete an analysis.
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Open FileWizard:
This wizard will guide you through the opening of a data file and setting the image dis-
play mapping. Use this wizard to open a file if you are not using one of the applic-
ation specific wizards.

To begin, double-click on the Start Analysis button

Step 1: Select the data file to open.Click on the folder and navigate to the file you
wish to open.

Tip: You can limit the view to specific file types (.daf, .cif or .rif) by using the drop-
downmenu ‘Files of type:’ in the Select Data File window.

A .daf file will open directly without further input, a .cif file will require a template and
a .rif file will require a template and a compensationmatrix. If the template or com-
pensationmatrix boxes are left blank, the default template and/or matrix will be
applied. For more information on opening data files seeOpening data files .

Step 2: Apply compensation This step occurs when opening a .rif. Choose a com-
pensationmatrix or create one. See compensation for more information. Click Next.

Step 3: Apply analysis template This step occurs when opening a .rif or .cif.
Choose a template file if one exists or leave blank to use the default template. Click
Next.

Step 4: Name your files It is recommended that you keep the default names.
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Step 5: Select a wizard to begin analysis. Select a wizard to begin analysis or
manually create your analysis template.

Tip: Every wizard begins the samewith set of graphs for choosing focused, single,
positive events. The specific application wizards will also create special features
and or masks specific to the application.
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Display PropertiesWizard
This wizard is automatically run when you use the other analysis wizards or the
Open File wizard. It is also available to run in any open data file from theGuided Ana-
lysis menu or from the wizard icon. This wizard will set the image display mapping
for the channel images you select and create a view of selected images. Brightfield
and scatter images will be automatically selected.

To begin, select wizards from theGuided Analyis menu or click the wizard icon in
the analysis area toolbar.

TheWizards window opens.

Double-click on the Display Properties option and follow the instructions.

The Display Properties adjusts themapping of the pixel intensities to the display
range for optimizing the display and creates a view that includes the chosen chan-
nels. This is for display only and does not effect the pixel values. For more inform-
ation on image display see Setting the ImageGallery Properties.

- 30 -



Guided Analysis

Begin AnalysisWizard
This wizard is available once a data file is open and will guide you through choosing
the focused cells, then single cells, then choosing subsets of fluorescent positive
cells for phenotypic analysis before progressing on to amorphological analysis.

The wizards selection screen will appear once the data file is open. If you have an
open data file and want to access this wizard, chooseWizards from theGuided Ana-
lysis menu or click on the wand tool.

To begin, double-click on Begin Analysis

Step 1. Gate cells in best focus

A histogram of the brightfield channel Gradient RMS values for the 'All' population
has been added to the analysis area. Click on the bins in the histogram to view the
images in each bin. The cells with better focus have higher Gradient RMS, values.
Begin your region at the bin after the Gradient RMS value you wish to exclude and
continue the region to themaximum in the plot. Youmay choose an already existing
population.

Step 2. Gate single cells

A scatter plot of the brightfield Area versus Aspect Ratio for the population chosen in
step one has been added to the analysis area. Single cells will have an intermediate
Area value and a high Aspect Ratio. Click on the dots to view the image associated
with that dot. Note that the image is surrounded by a light green line and the image
next to it in the image gallery is not it's neighbor in the plot. The images are presen-
ted in the order defined by the drop-downmenu above the image gallery.Youmay
choose an already existing population.

Step 3. Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Intens-
ity. Click Next to add the scatter plot to the analysis area. Click Skip if you do not
wish to use this step. Draw regions in the scatter plot to identify as many pop-
ulations as you want. This step will be repeated until you choose Skip or Finish.

The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.
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Feature FinderWizard
The feature finder wizard will guide you through the process of choosing a feature for
morphological analysis when a specific application wizard is not appropriate. This
wizard is available once a data file is open and will guide you through choosing the
focused cells, then single cells, then choosing subsets of fluorescent positive cells
for phenotypic analysis before progressing on to choosing a feature for mor-
phological analysis.

Open a data file that contains images of both phenotypes you wish to separate.Note
that it may be necessary tomerge two files together if the populations are in sep-
arate files. Open the data file using the Start Analysis button or by choosingWizards
from theGuided Analysis menu. The wizards selection screen will appear once the
data file is open. If you have an open data file and want to access this wizard,
chooseWizards from theGuided Analysis menu or click the wand icon.

To begin, double-click on Feature Finder

Step 1. Gate cells in best focus

A histogram of the brightfield channel Gradient RMS values for the 'All' population
has been added to the analysis area. Click on the bins in the histogram to view the
images in each bin. The cells with better focus have higher Gradient RMS, values.
Begin your region at the bin after the Gradient RMS value you wish to exclude and
continue the region to themaximum in the plot. Youmay choose an already existing
population. Click Next.

Step 2. Gate single cells

A scatter plot of the brightfield Area versus Aspect Ratio for the population chosen in
step one has been added to the analysis area. Single cells will have an intermediate
Area value and a high Aspect Ratio. Click on the dots to view the image associated
with that dot. Note that the image is surrounded by a light green line and the image
next to it in the image gallery is not it's neighbor in the plot. The images are presen-
ted in the order defined by the drop-downmenu above the image gallery.Youmay
choose an already existing population.Click Next.

Step 3. Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Intens-
ity and include the channel(s) you are going to use for morphological analysis. Click
Next to add the scatter plot to the analysis area. Click Skip if you do not wish to use
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this step. Draw regions in the scatter plot to identify as many populations as you
want. This step will be repeated until you choose Skip or Finish.

Step 4. Assign truth populations

Choose two truth populations of cells that represent onemorphological phenotype dif-
ference you wish to separate. Use the tagging tool icon to hand-tag images or select
pre-existing gated populations. Note: If there aremore than one phenotypic dif-
ferences, repeat the process for each with new truth populations.

Step 5. Select channels and feature categories

Choose the channel and feature category you wish to explore. Multiple rows may be
entered. The features in the table below will be created and calculated. All of the
default features, newly created features and user defined features in the chosen cat-
egories will be evaluated for their ability to separate the truth populations. The three
highest ranking features for each category will be saved and available for evaluation.

Step 7. Results

The top ranking features are listed in the table with their category and channel. A
Statistics table is added to the analysis area that lists the features with the RD Mean
for the truth populations. RD is the Fischer's discriminant ratio which is the dif-
ference in themeans divided by the sum of the standard deviations for the two pop-
ulations. The larger the RD value, the better the separation afforded by the feature. A
scatter plot is added to the analysis area of the truth populations for the top two fea-
tures.

It may be necessary to refine your results. Visually verify themorphology and sep-
aration for the features listed. Additional features may be quickly plotted by selecting
them in the list and clicking 'Plot Features'. To return to the truth population assign-
ment step click 'Refine populations'. To choose different channels or categories
click 'Change Category'.
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Youmay also wish tomake new masks and features using thesemasks manually if
they are not in the table below.

Feature
category Feature name Mask used

Location
Location Features are in X,Y pixel coordinates from an origin
in the upper left corner, pixels or contour
Delta Centroid XY Feature
The distance between the Centroids of the intensity weighted and
non-intensity weighted image

channel mask

Shape
Shape Features define the mask shape and have units that
vary with the feature.
Aspect Ratio Feature
The ratio of theMinor Axis divided by theMajor Axis. Object

Circularity Feature
The degree of themask’s deviation from a circle. Object

Describes the density of intensities within the object. Object

Elongatedness Feature
The ratio of the Height/Width which use the bounding box. Object

Lobe Count Feature
The number of lobes in a cell. (Also see Symmetry) Object

Shape Ratio Feature
The ratio of Thickness Min/Length features. Object

Symmetry 2, 3, 4 Features
These three features measure the tendency of the object to have a
single axis of elongation, a three-fold and a four-fold variation of the
shapes. See also Lobe Count Feature.

Object

Size Size-based Features are in microns.

Area Feature
The size of themask in squaremicrons.

Object,
Threshold
30,50,70%

Height Feature
Based on a bounding rectangle, theWidth is the smaller side and
the Height is the longer side of the rectangle.

Object

Length Feature
Measures the longest part of themask. Object

Major Axis andMinor Axis Features
Describes the widest part of themask and the narrowest part of the
mask, respectively.

Object

Perimeter Feature
Describes circumference of themask.

Object,
Threshold
30,50,70%

Thickness Max Feature
Describes the longest width of themask. Object

Thickness Min Feature
Describes the shortest width of themask. Object

Table 1: List of additional features (beyond default) that are created and explored in
the Feature Finder wizard
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Feature
category Feature name Mask used

Width Feature
Based on a bounding rectangle, theWidth is the smaller side and
the Height is the longer side of the rectangle.

Object

Texture
Texture features measure pixel or regional variation and indic-
ate the granularity or complexity of the image.
Contrast Feature
Enumerates changes of pixel values in the image tomeasure the
focus quality of an image.

Morphology,
Object

H Texture Features
Measures Haralick texture features. Granularity settings 1,5,15,19 Channel mask

Modulation Feature
Measures the intensity range of an image, normalized between 0
and 1.

Morphology,
Object

Spot Count Feature
Enumerates the number of spots.
See also Spot DistanceMin Feature, Spot AreaMin Feature, and
Spot Intensity Min and Spot Intensity Max Features.

Channel mask

Std Dev Feature
Describes the overall distribution of pixel intensities.

Morphology,
Object

Signal
Strength

Signal Strength Features are measured in pixel values.

Intensity Feature
The sum of the pixel intensities in themask, background sub-
tracted.

Morphology,
Object,
Threshold
30,50,70%

The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.
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ApoptosisWizard
The apoptosis wizard will guide you through the process of creating the features and
graphs tomeasure apoptosis using the images of the nuclear dye and brightfield.
Begin by opening a data file and then choosing the Apoptosis wizard.

To begin, double-click on Apoptosis

Follow the instructions to analyze your file.

Step 1. Select the nuclear image channel

From the drop downmenu pick the nuclear channel image.

Step 2. Gate cells in best focus

A Gradient RMS histogram of the All population has been added to the analysis area.
Click on the bins in the histogram to view the images in each bin. The cells with bet-
ter focus have higher Gradient RMS, values. Begin your region at the bin after the
Gradient RMS value you wish to exclude and continue the region to themaximum in
the plot. Youmay choose an already existing population.

Step 3. Gate single cells

A scatter plot of Area versus Aspect Ratio has been added to the analysis area.
Single cells will have an intermediate Area value and a high Aspect Ratio. Click on
the dots to view the image associated with that dot. Note that the image is sur-
rounded by a light green line and the image next to it in the image gallery is not it's
neighbor in the plot. The images are presented in the order defined by the drop-down
menu above the image gallery.

Step 4. Optional

Answer Yes if you want to define subpopulations in your experiment.

Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Intens-
ity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if
you do not wish to use this step.

Next Step. Gate subpopulations Note that step number sequence is dependent on
the number of times the subpopulationmarker step is taken.
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Draw regions in the scatter plot or histogram to identify as many populations as you
want. This step will be repeated until you choose Skip.

Next Step. Optional - Select additional subpopulation marker(s) OR. Gate nuc-
leated cells.

A histogram of the nuclear channel Intensity is added to the analysis area. Gate on
the positive events.

Next Step . Gate apoptotic cells

The nucleated cells scatter plot of the brightfield Contrast versus the Area of the
thresholded nucleus is added to the analysis area. Gate on the apoptotic cells with
low nuclear area and high brightfield contrast.

The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.
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Cell Cycle - MitosisWizard
The cell cycle - mitosis wizard will guide you through the process of creating the fea-
tures and graphs to analyze the cell cycle and identify mitotic events using the
images of a nuclear dye.

To begin, double-click on Cell Cycle - Mitosis

Follow the instructions to analyze your file.

Step 1. Select the nuclear image channel

From the drop downmenu pick the nuclear channel image.

Step 2. Gate cells in best focus

A Gradient RMS histogram of the All population has been added to the analysis area.
Click on the bins in the histogram to view the images in each bin. The cells with bet-
ter focus have higher Gradient RMS, values. Begin your region at the bin after the
Gradient RMS value you wish to exclude and continue the region to themaximum in
the plot. Youmay choose an already existing population.

Step 3. Gate single cells

A scatter plot of Area versus Aspect Ratio has been added to the analysis area.
Single cells will have an intermediate Area value and a high Aspect Ratio. Click on
the dots to view the image associated with that dot. Note that the image is sur-
rounded by a light green line and the image next to it in the image gallery is not it's
neighbor in the plot. The images are presented in the order defined by the drop-down
menu above the image gallery.

Step 4. Optional

Answer Yes if you want to define subpopulations in your experiment.

Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Intens-
ity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if
you do not wish to use this step.

Next Step. Gate subpopulations Note that step number sequence is dependent on
the number of times the subpopulationmarker step is taken.
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Draw regions in the scatter plot or histogram to identify as many populations as you
want. This step will be repeated until you choose Skip.

Next Step. Optional - Select additional subpopulation marker(s) OR. Gate
G2/M cells.

A histogram of the nuclear channel Intensity is added to the analysis area. Gate on
theG2/M population with 2n DNA.

Next Step . Gate cells with condensed DNA

TheG2/M cells scatter plot of the threshold Area versus Bright Detail Intensity of the
nuclear image is added to the analysis area. Gate on the cells with condensed nuc-
lear that have low nuclear area and high Bright Detail Intensity values These will
include apoptotic cells which you can remove in the next step.

Next Step . Gate mitotic cells

The condensed DNA cells scatter plot of the brightfield Contrast versus the Area of
the thresholded nucleus is added to the analysis area. Gate onmitotic events with
low brightfield Contrast.

The final 3 plots are shown below:

The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.
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Co-localizationWizard
The co-localization wizard will guide you through the process of creating the features
and graphs tomeasure the co-localization of two probes with punctate staining in
any population of cells you identify.

To begin, double-click on Co-localization

Follow the instructions to analyze your file.

Step 1. Select the co-localization image channels

From the drop downmenus pick the two image channels that contain the co-loc-
alizing probes.

Step 2. Gate cells in best focus

A Gradient RMS histogram of the All population has been added to the analysis area.
Click on the bins in the histogram to view the images in each bin. The cells with bet-
ter focus have higher Gradient RMS, values. Begin your region at the bin after the
Gradient RMS value you wish to exclude and continue the region to themaximum in
the plot. Youmay choose an already existing population.

Step 3. Gate single cells

A scatter plot of Area versus Aspect Ratio has been added to the analysis area.
Single cells will have an intermediate Area value and a high Aspect Ratio. Click on
the dots to view the image associated with that dot. Note that the image is sur-
rounded by a light green line and the image next to it in the image gallery is not it's
neighbor in the plot. The images are presented in the order defined by the drop-down
menu above the image gallery.

Step 4. Optional

Answer Yes if you want to define subpopulations in your experiment.

Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Intens-
ity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if
you do not wish to use this step.

Next Step. Gate subpopulations Note that step number sequence is dependent on
the number of times the subpopulationmarker step is taken.
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Draw regions in the scatter plot or histogram to identify as many populations as you
want. This step will be repeated until you choose Skip.

Next Step. Gate double positives

A scatter plot of the last gated (or selected) population of the Intensity values for the
co-localization channels is added to the analysis area. Draw a region around the
double positive cells for the co-localizing probes.

Next Step. Gate co-localized events

A histogram of Bright Detail Similarity R3 for the double positive population is added
to the analysis area. Draw a region to gate on co-localized events.

For amore thorough explanation of the Bright Detail Similarity feature see Bright
Detail Similarity R3 Feature

The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.
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InternalizationWizard
This wizard will create an analysis template for measuring the internalization of a
probe in any population of cells you identify.

To begin, double-click on Internalization

Follow the instructions to analyze your file.

Step 1. Select the internalization image channels

From the drop downmenus pick the cell image, the channel that defines the cell sur-
face, and the internalizing probe channel.

Step 2. Gate cells in best focus

A Gradient RMS histogram of the All population has been added to the analysis area.
Click on the bins in the histogram to view the images in each bin. The cells with bet-
ter focus have higher Gradient RMS, values. Begin your region at the bin after the
Gradient RMS value you wish to exclude and continue the region to themaximum in
the plot. Youmay choose an already existing population.

Step 3. Gate single cells

A scatter plot of Area versus Aspect Ratio has been added to the analysis area.
Single cells will have an intermediate Area value and a high Aspect Ratio. Click on
the dots to view the image associated with that dot. Note that the image is sur-
rounded by a light green line and the image next to it in the image gallery is not it's
neighbor in the plot. The images are presented in the order defined by the drop-down
menu above the image gallery.

Step 4. Optional

Answer Yes if you want to define subpopulations in your experiment.

Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Intens-
ity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if
you do not wish to use this step.

Next Step. Gate subpopulations Note that step number sequence is dependent on
the number of times the subpopulationmarker step is taken.
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Draw regions in the scatter plot or histogram to identify as many populations as you
want. This step will be repeated until you choose Skip.

Next Step. Optional - Select additional subpopulation marker(s) OR. Gate
internalization positives

A scatter plot of Max Pixel versus Intensity for the internalizing probe is added to the
analysis area. Draw a region to include the positive cells.

Next Step. Gate internalization events

A histogram of the Internalization feature for the positive cells is added to the ana-
lysis area. Draw a region to include the cells with high internalization. The example
below shows the internalization of labeled CpG (red).

For amore thorough explanation of the Internalization feature seeInternalization
FeatureInternalization Feature

The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.
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Nuclear LocalizationWizard
This wizard will create an analysis template for measuring the nuclear localization of
a probe in any population of cells you identify.

To begin, double-click on Nuclear Localization

Follow the instructions to analyze your file.

Step 1. Select the translocation image channels

From the drop downmenus pick the nuclear image channel and the translocating
probe image channel.

Step 2. Gate cells in best focus

A Gradient RMS histogram of the All population has been added to the analysis area.
Click on the bins in the histogram to view the images in each bin. The cells with bet-
ter focus have higher Gradient RMS, values. Begin your region at the bin after the
Gradient RMS value you wish to exclude and continue the region to themaximum in
the plot. Youmay choose an already existing population.

Step 3. Gate single cells

A scatter plot of Area versus Aspect Ratio has been added to the analysis area.
Single cells will have an intermediate Area value and a high Aspect Ratio. Click on
the dots to view the image associated with that dot. Note that the image is sur-
rounded by a light green line and the image next to it in the image gallery is not it's
neighbor in the plot. The images are presented in the order defined by the drop-down
menu above the image gallery.

Step 4. Optional

Answer Yes if you want to define subpopulations in your experiment.

Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Intens-
ity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if
you do not wish to use this step.

Next Step. Gate subpopulations Note that step number sequence is dependent on
the number of times the subpopulationmarker step is taken.
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Draw regions in the scatter plot or histogram to identify as many populations as you
want. This step will be repeated until you choose Skip.

Next Step. Gate double positives

A scatter plot of the last gated (or selected) population of the Intensity values for the
nuclear image and the translocating probe image is added to the analysis area. Draw
a region around the double positive cells.

Next Step. Gate translocated events

A histogram of Similarity of the double positive cells is added to the analysis area.
Draw a region to include the cells with translocation. Note that for a normally dis-
tributed population youmay want to report the RD of the double positive population
in a treated versus untreated sample instead of the percentage gated.

Nuclear localization of a probe is measured using the Similarity feature in the final
graph presented in the wizard. The example shown here is of THP1 cells stimulated
with 1 ug LPS for 90minutes and stained with DRAQ5 (red) and NFkB (green) to
measure the nuclear localization of the NFkB.

For amore thorough explanation of the Similarity feature see Similarity Feature .

The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.
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Shape ChangeWizard
This wizard will create an analysis template for measuring the shape (circularity) of
any population of cells you identify.

To begin, double-click on Shape Change

Follow the instructions to open and analyze your file.

Step 1. Select the cell morphology image channel

From the drop downmenu pick the channel for the cell image.

Step 2. Gate cells in best focus

A Gradient RMS histogram of the All population has been added to the analysis area.
Click on the bins in the histogram to view the images in each bin. The cells with bet-
ter focus have higher Gradient RMS, values. Begin your region at the bin after the
Gradient RMS value you wish to exclude and continue the region to themaximum in
the plot. Youmay choose an already existing population.

Step 3. Gate single cells

A scatter plot of Area versus Aspect Ratio has been added to the analysis area.
Single cells will have an intermediate Area value and a high Aspect Ratio. Click on
the dots to view the image associated with that dot. Note that the image is sur-
rounded by a light green line and the image next to it in the image gallery is not it's
neighbor in the plot. The images are presented in the order defined by the drop-down
menu above the image gallery.

Step 4. Optional

Answer Yes if you want to define subpopulations in your experiment.

Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Intens-
ity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if
you do not wish to use this step.
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Next Step. Gate subpopulations Note that step number sequence is dependent on
the number of times the subpopulationmarker step is taken.

Draw regions in the scatter plot or histogram to identify as many populations as you
want. This step will be repeated until you choose Skip.

Next Step. Gate fluorescence positives

A histogram of the last gated (or selected) population of the Intensity value for the
cell image is added to the analysis area. Draw a region around the double positive
cells. Note that this step is skipped if the cell image channel chosen is brightfield.

Next Step. Gate shape-changed events

A histogram of Circularity of the last gated population is added to the analysis area.
Draw a region to include the cells with low circularity scores.

Shape change is measured in the final graph presented in the wizard. Cells with low
circularity scores have a highly variable radius. In this examplemonocytes in whole
blood were stained with CD14 (green).

For amore thorough explanation of the Circularity feature see Circularity Feature .

The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.
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SpotWizard
This wizard will create an analysis template for measuring texture based on spot
counting. If the low and high spot count data are in separate data files merge the files
together before beginning.

To begin, double-click on Spot

Follow the instructions to open and analyze your file.

Step 1. Gate cells in best focus

A Gradient RMS histogram of the All population has been added to the analysis area.
Click on the bins in the histogram to view the images in each bin. The cells with bet-
ter focus have higher Gradient RMS, values. Begin your region at the bin after the
Gradient RMS value you wish to exclude and continue the region to themaximum in
the plot. Youmay choose an already existing population.

Step 2. Gate single cells

A scatter plot of Area versus Aspect Ratio has been added to the analysis area.
Single cells will have an intermediate Area value and a high Aspect Ratio. Click on
the dots to view the image associated with that dot. Note that the image is sur-
rounded by a light green line and the image next to it in the image gallery is not it's
neighbor in the plot. The images are presented in the order defined by the drop-down
menu above the image gallery.

Step 3. Optional

Answer Yes if you want to define subpopulations in your experiment.

Select subpopulation marker(s)

Choose one or two channels you wish to use to identify populations based on Intens-
ity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if
you do not wish to use this step.

Next Step. Gate subpopulations step number sequence is dependent on the num-
ber of times the subpopulationmarker step is taken.

Draw regions in the scatter plot or histogram to identify as many populations as you
want. This step will be repeated until you choose Skip.

Next Step. Select the spot image channel
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From the drop downmenu choose the image channel for the spot counting.

Next Step. Assign truth populations

From the drop downmenus select two truth populations, one with high and one with
low spot count. To create the truth populations, either use the tagging tools or gate
the cells of interest.

Next Step. Gate spot events

A histogram of the Spot Count feature for the last gated population is added to the
analysis area. Regions have been drawn that include the truth populations. Adjust
the regions as necessary. Note that youmay want to adjust your truth populations
and repeat the wizard after looking at the images and validating the spot counts.

The statistics Count and Percent Gated are added to the Population Statistics table
in the analysis area and a statistics definition is added to the template. To view the
definition choose Define Statistics Report from the Reports menu.
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Building Blocks
Building blocks may be used to create a graph for finding single cells, focused cells
or positive cells based on Intensity. The building blocks are shortcuts to creating a
graph that provide a limited list of relevant features with set X and Y axis scales set
for the graph. For more information on creating graphs see Creating Graphs.

Building Block X axisFeatures Y axis Features
Flourescence Positives -
one color

Intensity_MC_ChX
(for all channels)

Flourescence Positives -
two color

Intensity_MC_ChX
(for all channels)

Intensity_MC_ChX
(for all channels)

Focus

Gradient RMS_MX_ChX
(for all channels)
Note: Gradient RMS of brightfield
is default

Single Cell

Area_brightfield (default)
Area_scatter
Intensity_MC_ChX
(for all channels)

Aspect Ratio_brightfield (default)
Aspect Ratio Intensity_MX_ChX
(for all fluorescence channels)
Intensity_scatter

Single Cell Default Area_brightfield Aspect Ratio_brightfield
Size/SSC Area_brightfield Intensity scatter

Table 1: Building blocks

To begin, choose Building Blocks from theGuided Analysis Menu or click on the
Building Blocks icon in the analysis area toolbar.

The Building Blocks window opens. This window is used to define a graph with a spe-
cified set of features available depending on the purpose of the graph.

1 Choose the specific Building Block from the drop-downmenu.

2 Choose the population(s) to graph.
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3 Choose the X Axis Feature and the Y Axis feature, if applicable.

4 Click OK.
5 The graph is added to the analysis area.
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Advanced Analysis
Opening data files

Saving Data Files

Overview of Compensation

Creating a New CompensationMatrix File

Viewing Sample Information

Merging Data Files

Creating new data files from populations

Batch Processing
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Opening data files

Viewing File Name Extensions
When loading a file, the IDEAS application uses the file name extension to determ-
ine the file type. It will be easier for you to distinguish raw image files, compensated
image files, and data analysis files from each other if Windows Explorer does not
hide the extensions.

To view file name extensions

1 InWindows Explorer, go to Tools > Folder Options.
2 Click the View tab, andmake sure that the Hide extensions for known file types

check box is not selected.
3 Click OK.

Use the File menu, which is shown in the following figure, to open, save, and close
image and analysis files and to quit the IDEAS application. Alternatively, youmay
open a data file by drag and drop into an open IDEAS window. Muliple data files can
be open in one instance of the IDEAS application.

Opening a .rif file
A .rif file is opened when there is new data and the IDEAS application needs to apply
corrections. When opening a .rif file, the IDEAS application corrects each image for
the spatial alignment between channels, camera background normalization, flow
speed, and brightfield gain normalization. If you want fluorescence compensation to
correct for spectral overlap, youmust create or choose a compensationmatrix at
this time by using the control files that were collected for a particular experiment. If a
FlowSight data file was acquired with a compensationmatrix, that matrix will be
used by default. For more information on compensation see Creating a New Com-
pensationMatrix File. The application performs the corrections by using calibration
information that was saved to the .rif file during acquisition.

To open a .rif file

To use a wizard to do this seeOpen FileWizard:, otherwise:

1 From the File menu, chooseOpen or drag the file into the IDEAS window.
2 Select the .rif file that you want in the Select File To Load window.
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Tip: while browsing for the file to open you can limit the type of file shown in the win-
dow to .rif files.

In the next window you will:

• Choose or create a compensationmatrix
• Choose a template

3 If you have already created a compensationmatrix for this data then Click the
folder next to Select a compensation matrix. Note the file types that may
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contain a compensationmatrix. (.ctm, .rif, .cif, .daf) If you leave it blank, the
default compensationmatrix will be used which does not contain any fluor-
escence corrections. This is not recommended unless you do not want to com-
pensate your data.
• If a compensationmatrix for the experiment has not beenmade, click New

Matrix. For more information on creating a compensationmatrix see Creating
a New CompensationMatrix File.

4 In the Select a template or data analysis file (.ast, .daf) field, select a tem-
plate file to load by clicking the folder and browsing for the file. If left blank, the
Default template with the basic features, masks, and settings will be used. Note
that FlowSight basic files use the acquisition template as the default.

5 Optional: Check the box 'Use acquisition analysis' if you wish to use the acquis-
ition analysis performed on the instrument which includes feature defin-
itions/regions/populations and analysis area plots.

6 Optional: If you wish to load a subset of objects or change the .cif and .daf file
names to be created, Click the Output File Options button.

In this window youmay:
• change the name of the .cif and .daf files to be created. It is recommended to

keep the default names.
• choose to load a subset of objects. Tip: you can select a smaller number than

themaximum if you have a large number of objects to load. This helps save
time for creating a template file. The objects can be chosen randomly or
sequentially.

7 Click OK.
The application then creates the .cif and .daf files and the .daf file is loaded into
the Image Analysis area.

Note: Most often, the defaults will be adequate. For some older data files, youmay
need to provide control files for certain settings. For assistance call Amnis applic-
ation support.
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• To view the corrections that will be applied to the .rif file, click Advanced
within the Output File Options window.
TheOpening file window appears.

• Make any changes to the corrections that you need, and then click OK.

Opening a .cif file
A .cif file is generated when corrections are applied to a .rif file, as described in Over-
view of the Data File Types. When opening a .cif file, the IDEAS application cal-
culates feature values and creates a .daf file to display images and graphs.

When opening a .cif file, an analysis template is selected. The template provides the
initial characteristics of the analysis. Opening the .cif file causes the IDEAS applic-
ation to calculate feature values and to use populations, graphs, and image viewing
settings to display the cells as defined by the template.

To open a .cif file

To use a wizard to do this seeOpen FileWizard:, otherwise:

1 From the File menu, chooseOpen or drag the file into the IDEAS window.
2 Select the .cif file that you want in the Select File To Load window.
Tip: while browsing for the file to open you can limit the type of file shown in the win-
dow to .cif.
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In the next window you will:

• Choose a template
• Name the output file

3 Click the folder next to Select a template or data analysis file (.ast, .daf) and
choose the template to use for analysis. If left blank, the IDEAS application will
use a default template. However, it is useful to create and save your own tem-
plates for specific experimental procedures.

4 Change the Data analysis file name, if necessary. The default namematches
the name of the .cif.

5 Click OK.
During the opening of a .cif file, the IDEAS application calculates the values of
the features that are defined in the template you selected. The progress is shown
by a progress bar. After the application has successfully opened the .cif file, the
.daf file is saved.
See also: Saving Data Files.
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Opening a .daf file
A .daf file contains the calculated feature values so that they will not need to be recal-
culated, as described in Overview of the Data File Types. To open a .daf file, the
IDEAS application requires the .cif file to reside in the same directory. The .daf file
does not contain any image data, so you can think of the .cif file as the database that
contains the imagery. Because all of the feature values have been saved in it, the
.daf file should open quickly.

To open a .daf file

To use a wizard to do this seeOpen FileWizard:, otherwise:

1 From the File menu, chooseOpen or drag the file into the IDEAS window.
2 Select the .daf file that you want in the Select File To Load window.
Tip: while browsing for the file to open you can limit the type of file shown in the win-
dow to .daf.

The progress is shown by a progress bar. The state of the IDEAS application is
restored to what it was when the .daf file was saved.
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Saving Data Files
Data files are saved at several stages of analysis. Raw image files are saved during
data acquisition, by mergingmultiple .rif files or by creating new files from pop-
ulations. Compensated image files and Data analysis files are saved when opening
.rif files, mergingmultiple .cif files, or when running a batch analysis. The IDEAS
application also saves other types of files that are used for data correction and
presentation. Template files (.ast) save the structure of an analysis and com-
pensationmatrix files (.ctm) save the compensationmatrices.

Application Defaults are set that direct the files into specific folders and can be
viewed or changed by the user. See Viewing and Changing the Application Defaults
for more information.

Saving a Data Analysis File (.daf)
A .daf file contains a snapshot of an analysis as described in Overview of the Data
File Types. Saving the analysis as a .daf file allows you to recall that analysis simply
by opening the file. When you quit the IDEAS application, you are always prompted
to save changes to a .daf file. You can also save changes from the File menu.
Remember that the .daf file does not contain image information, so opening the .daf
file requires the related .cif file to reside in the same directory.

To save a .daf file

1 On the File menu, click Save as Data Analysis File (.daf).
2 Enter a file name. Note that the default directory is the one where the .cif file was

saved.
If you select an existing file name, a warning appears that asks you to verify the
overwriting of the existing file.

3 Click Save.
The data is now ready for analysis. You can create graphs, view imagery, and dis-
play feature values and statistics. After you have defined an analytical procedure
in the .daf file, you can save the file as a template, which allows you to use the
procedure for analyzing other files. Refer to Overview of the Data Analysis Tools
for more information.

option: Saving a data analysis file with only the feature values used.

When you want to reduce the size of a data analysis file youmay save the .daf with
only the features that are used for analysis of statitics or graphs.

On the File menu, click Save as Data Analysis File - Used Features Only. and follow
the instructions 2-3 above.

Saving a Compensated Image File (.cif)
The IDEAS application creates and saves a .cif file when a .rif file is opened. By
default, the application names the .cif file with the same name that the .rif file has,
replacing the .rif extension with .cif. The application also places the .cif file in the
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same directory as the .rif file. The .cif file will be larger than the .rif file because the
.cif file contains masking information as well as corrected and/or compensated
images.

Saving a Template (.ast)
Saving an analysis as a template allows you to apply the structure of the analysis to
other .cif files. Save a template file after saving a .daf file. A template includes all
graph definitions, ImageGallery settings, feature definitions, and statistics settings.
No data are saved in a template. Therefore, selected images and populations that
are dependent on specific objects, such as tagged populations, are not saved.

To save a template

1 On the File menu, click Save As Template File (.ast).
A Save File dialog box appears.

2 Enter the name of the file to save.
3 Click Save.

If you select an existing file name, a warning appears that asks you to verify the
overwriting of the existing file.
Tip: You can change the default template directory in themenu Analysis >
Application Defaults.
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Overview of Compensation
Spectral compensation corrects imagery for fluorescence that leaks into nearby
channels so that youmay accurately depict the correct amount of fluorescence in
each cell image.

For example, the light from one fluorochromemay appear primarily in channel 3, but
some of the light from this fluorochromemay appear in channel 4 as well, because
the emission spectrum of the probe extends beyond the channel 3 spectral band-
width. The light from a second fluorochromemay appear primarily in channel 4 but,
unless you subtract the light emitted by the first fluorochrome into channel 4, you
cannot generate images that accurately represent the distribution of the second
fluorochrome.

Emmission Spectra for two fluorochromes:

Below is an example of cells stained with four fluorochromes independently and run
together as one sample. Intensity scatter plots for two fluors and images for the four
fluors are shown uncompensated and compensated. Image compensation is per-
formed on a pixel by pixel basis.
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The IDEAS application builds amatrix of compensation values by using one or more
control files. A control file contains cells stained with one fluorochrome. Because it
is critical that matrix values be calculated from intensities derived from a sole source
of light, control files are collected without brightfield illumination, or scatter. The
brightfield compensation is performed automatically. The process of creating the
compensationmatrix is described in the next section.

Creating a NewCompensationMatrix File
The compensationmatrix is a table of coefficients. The IDEAS application uses this
table to place the detected light that is displayed in each image into the proper chan-
nels, on a pixel-by-pixel basis. The coefficients are normalized to 1. Each coefficient
represents the normalized amount of the leakage of the fluorochrome into the other
channels. Compensation is performed during the creation of a .cif file from a .rif file.

The default matrix, which is used if no compensationmatrix is chosen, is the identity
matrix, shown below.
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To generate a new compensationMatrix file

1 Start the CompensationWizard in one of two ways:
— Click the New Matrix button when opening a .rif file
— OR select Compensation>Create New Matrix .

The compensation wizard opens to Step 1:

2 Add compensation control files by clicking Add Files and browsing for the control
files for the experiment. The files will have the suffix no-BF. Hold down the con-
trol key to select multiple files at once.
A note about compensation files. It is important to collect only single color pos-
itive cells or beads to use for compensation files. Collect 500-1000 positive
events for each file. Collectingmore events or including negative and very dim
cells is not recommended since the compensation calculations expect only pos-
itive events.

3 When all of the control files for the experiment have been added to the list, click
Next. The control file(s) aremerged and loaded.
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4 Step 2: Verify the channels for each control in the experiment by checking the
channel boxes.

The following tables are provided as a guide for each instrument configuration.

Ch 1 Ch 2 Ch3 Ch 4 Ch 5 Ch6
470-500nm 400-470nm 500-560nm 560-595nm 595-660nm 660-735nm
Scatter DAPI FITC PE 7-AAD PE-Cy5

Table 1: First generation ImageStream (IS100)

Table 2: ImageStreamX - 1 camera

Ch 1 Ch 2 Ch3 Ch 4 Ch 5 Ch6
435-505nm 505-560nm 560-595nm 595-642nm 642-745nm 745-780nm

DAPI FITC PE
PE-
TexasRed

AF647 APC-Cy7

Table 3: ImageStreamX - 2 camera

Ch 1 Ch 2 Ch3 Ch 4 Ch 5 Ch6
435-480nm 480-560nm 560-595nm 595-642nm 642-745nm 745-780nm

BF FITC PE
PE-
TexasRed

PE-Cy5 PE-Cy7

Ch 7 Ch 8 Ch9 Ch 10 Ch 11 Ch 12
435-505nm 505-570nm 570-595nm 595-642nm 642-745nm 745-780nm

DAPI
Pacific
Orange

BF Texas Red AF647 APC-Cy7

5 Background and spatial offset corrections are performed, the imagery is dis-
played, bivariate plots of adjacent channels Intensity are added to the analysis
area and the compensationmatrix values are computed and displayed in a table.
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Example:

The Positive Control Populations are shown in the graphs below.

6 In Step 3, choose one of twomethods for calculating the coefficients.
• The Best Fit method is used for objects such as cells where intensities vary.
• TheMeans method is used for objects such as beads that have only slight

variations in intensity and therefore do not produce a linear .correlation.
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• The compensation files aremerged and each object is scrutinized for it's peak
channel emission. For each fluorochrome, the application automatically iden-
tifies a positive control population, excluding the brightest and dimmest
objects, and assigns it to the proper channel.

7 Inspect thematrix values in the table of coefficients.
Coefficients should always be less than 1, and decrease from the assigned chan-
nel. In other words, leakage should be greater in the channel nearest to the
assigned channel. Fluorescence always extends in the long-wavelength direction
from the exciting light.
• Verify that no coefficients are larger than 1.
• Verify that, in a column corresponding to a fluorochrome, the coefficients

decrease from the assigned channel.
• Verify that the coefficient is greater in the channel below the 1 in the table than

the value above the 1 in the table. Verify that these coefficients also decrease
in subsequent channels below the 1.

• Verify that there are no changes from the identity matrix in the columns where
there are no fluorochromes, including the scatter and brightfield channels. If
necessary, the column can be set to the identity values by double-clicking on
the heading.

• Check for coefficients in red text. These coefficients have errors of 1% or
more to the best fit line. This means you should inspect the graphs for these
coefficients and if possible reduce the error by eliminating outliers or choosing
the populationmanually. The purpose of making these coefficients red is to
point out the coefficients that may need attention but it may be that the error
will remain above 1% and remain red.

• Inspect the coefficients in thematrix by double-clicking on the coefficient.
A graph representing the coefficient appears. The population potted in the
graph is the positive control population of the column of the coefficient. The X
Axis represents the intensity in the assigned channel of the fluorochrome. The
Y Axis represents the intensity in the channel of leakage. The coefficent value
and error are also displayed.
Note: Coefficients in red have errors greater than 1% and should always be
inspected. Eliminating outliers may reduce the coefficient error but if the
objects have a wide distribution the error may not be able to be reduced below
1%.
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• You can use the automatically generated control populations as they are, or
you can refine them and create different populations by using the region tools.
See the option below to remove objects from the population. By default, the
populations are named 3_Positive, 5_Positive, and so on. You can view the
populations in the ImageGallery. Some populations may be empty.

• To choose a different population, use the arrow and select the population from
the list. The hierarchical relationship is shown in the population list. Assign
populations only to the channels that correspond to the fluorochromes used in
the experiment.

• If you want to clear a column, double click on the channel heading.
• If needed, you can create new scatter plots by using the Analysis Area tool-

bar. For example, a 4_Intensity versus 5_Intensity plot may be useful. See
Creating Graphs for more information.

• The slope of the line on the plot is the coefficient in thematrix.

8 If objects in the population exist that are outliers, they shouldmost likely be
removed from the positive population within the compensationmatrix by the fol-
lowing optional steps.

- 67 -



Chapter 3

• The slope of the line on the plot is the coefficient in thematrix..

Option: RemoveObjects from the Population

1 Within Step 2 of the compensation wizard, double-click the coefficient to display
the intensity plot.

2 If you notice outliers, click Add Graph to Analysis Area.
The plot populates in the Analysis Area.

3 Return to the Analysis Area and use the region tools to draw a new region on the
plot that defines a new positive control population, excluding the outliers. Refer to
Creating Regions onGraphs for more information.
• Create a new region to exclude outliers.

Click the Resize and Zoom buttons on the graph toolbar to more
clearly see the population of interest. Using one of the region buttons on the tool-
bar, draw a region that contains only the cells you want to use for determining
compensation. You can click a point on the graph and view the image to help you
decide where the region boundaries should be.
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In the example below, the Polygon Region tool was selected to draw a border
around a selection of cells. Clicking within the graph anchors the line and double-
clicking completes the region.

For more information, refer to Creating Regions onGraphs.
4 Assign the new population to the appropriate channel by using the Positive Con-

trol Populations list for that channel.

5 The coefficient value is automatically recalculated when a new population is
selelcted.
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6 Repeat these steps as required to redefine the coefficients.
7 Click Preview Images to view individual objects with corrections applied. Double

click on an image to add it to the preview window. Note: the corrections are only
applied to on-camera channels. For example, if the object is brightest in channel
3 on the first camera, only channels 1-6 are shown corrected for that object.

8 When thematrix appears satisfactory, click Finish.
9 Enter a name for the compensationmatrix file (.ctm) and click Save

Note: Thematrix is saved as a compensationmatrix file (.ctm file). This file con-
tains the compensation values and can be opened later for editing. To provide the
values for fluorescence compensation, you select a .ctm file when opening a .rif
file. SeeOpening a .rif file for more information.

Working with CompensationMatrix Files

Preview and edit a compensationmatrix
A compensationmatrix can be applied to a population or .rif file in a preview mode for
editing amatrix.

To open a compensationMatrix

1 Select View/Edit CompensationMatrix from the Compensationmenu to view,
edit or preview thematrix on image data.Select the data file by clicking on the
folder and then click Open. Thematrix values are displayed in a table andmay be
edited.
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2 To preview thematrix on image data, browse for a file or select a population from
the current file to preview and click Preview.
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Troubleshooting compensation
Sometimes an appliedmatrix produces poorly compensated data. This can happen
for a number of reasons: 1) miscalculation of the compensationmatrix by inclusion
of inappropriate events (such as doublets, saturated pixel events, or artifacts), 2)
controls used for matrix calculation differ significantly from the experimental
samples (different cell type, different probe), or 3) cells exhibit substantial auto-
fluorescence. This protocol describes amethod for manually adjusting and validating
a compensationmatrix for difficult samples.

To troubleshoot and repair a compensationmatrix:

1 Create a population of cells that aremiscompensated using the tagging tool. See
Creating Tagged Populations. Choose single cells that are exhibiting crosstalk.
Choose a range of intensities from negative to bright but not saturated, preferably
single color. If single color cells are not available, choose cells with a distinct
staining pattern in the peak channel.

2 Create Intensity scatter plots of adjacent channels in order to observe the over-
or under-compensation.

3 Identify thematrix values that need adjusting by inspecting the scatter plots and
images. Each column contains the coefficients for the peak channel into the cor-
responding crosstalk channels (rows). For example the crosstalk of channel 2
(green) into channel 3 is highlighted in thematrix below.

• Undercompensation (crosstalk coefficient is too low):
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Plots: Intensity mean for the single color positive population is higher than the
unlabeled population in the crosstalk channel or the intensity in the crosstalk
channel trends diagonally upwards.
Images: the crosstalk channel contains an apparent fluorescent mirror-image.

• Overcompensation (crosstalk coefficient is too high):
Plots: Intensity mean for the single color positive population is lower than the
unlabeled population in the crosstalk channel or the intensity in the crosstalk
channel trends diagonally downwards.
Images: the crosstalk channel contains dark spots corresponding to the bright
spots in the fluorescent channel of interest.

4 In the Compensationmenu choose View/Edit Matrix andmanually change the
incorrect crosstalk matrix values identified above. Start with changes of ~.1 or
~.05 and use smaller and smaller increments as you refine thematrix.

5 Click Preview and choose the tagged population to view the results of the
changed coefficient.

6 Repeat steps 4 and 5 until thematrix is corrected.
7 Click Save, appendmanual to thematrix name, then click OK.
8 Open the .cif file and use the new matrix to create a new .daf file.
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Merging Data Files

Merging Raw Image Files
You canmerge .rif files together for analysis.This option is not available for basic
FlowSight files without the Quantitative Imaging (QI) upgrade.

Tomerge .rif files

1 On the Tools menu, click Merge .rif Files.
TheMerge Raw Image Files window appears.

2 To select the .rif files to merge, click Add Files.
The .rif file names appear in the list.

3 If you want to remove a file from the list, select it and then click Remove File.
4 When themerge list is complete, click OK.

The Save Merged Raw Image (.rif) File dialog box appears.
5 Type a unique file name.
6 Click Save.

The Creatingmerged .rif file window appears.

When themerge is complete, theMerged .rif Created message appears.
7 Click OK.

Notes:
• The sample information will contain information for the first file in themerge

list.
• For ISX non-MKII files the classifier is turned off when amerged file is loaded.

To turn the classifier onmanually, go to the Advanced panel on the open .rif
window when opening an ISX non-MKII merged file. ISX-MKII and FlowSight
do not use classifiers.
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• When opening amerged .rif file an easy method for gating the separate files is
to create a scatter plot of the Object Number versus Time. Each population
will fall on a differnt line.

Merging Compensated Image Files
You canmerge .cif files together for analysis.This option is not available for basic
FlowSight files without the Quantitative Imaging (QI) upgrade.

Tomerge .cif files

1 On the Tools menu, click Merge .cif Files.
The Load Multiple .cif Files window appears.

2 To select the .cif files to merge, click Add Files.
The .cif file names appear in the list.

3 If you want to remove a file from the list, select it and then click Remove File.
4 Type a unique name for the output files.
5 Select a template..
6 Click OK.
7 Themerged files are created and the new .daf file is loaded with a population cre-

ated from each file.
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Creating New Data Files

Creating new data files from populations
To further analyze a population or merge it with other data when working in a .daf,
you can save it to a new data file. This is useful if your data file contains a large num-
ber of objects that are not pertinent to your experiment. Decreasing the data file size
results in better performance by the IDEAS application, as described in Creating
Regions onGraphs. Note that you cannot create a new .cif or .rif whenmultiple data
files are open. This option is not available for basic FlowSight files without the Quant-
itative Imaging (QI) upgrade.

To create data files from populations

1 On the Tools menu, click Create Data File from Populations.
The Create .cif and/or .rif From Populations window appears.

2 In the Select populations list, select the populations that you want to include in
the new data file(s). Ctrl click to select multiple populations.

3 To create a .rif file, select the New Raw Image File (.rif) check box, the pop-
ulation name is used as a default. Youmay enter a new name.

4 To create a .cif file, select the New Compensated Image File (.cif) check box,
the population name is used as a default. Youmay enter a new name.

5 Click OK.
If you created a new .cif file, you can choose to load it. When loading the .cif file,
the application will prompt you for the template.
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Viewing Sample Information
All of the information associated with an IDEAS file, such as the collection inform-
ation, camera settings and corrections, is saved and can be viewed in the Sample
Information window.

To open the Sample Information window

1 Go to Tools > Sample Information to open the window.
Information for the open data file will be loaded. You can browse for a different
data file by clicking on the folder. You can open the Sample InformationWindow
for any of three file types: .rif, .cif, or .daf.

2 Select a Tab to see the information for each heading.
3 Click Print to print a report of all of the sample information.

Tip: Youmay click on the folder and browse for a file to view the sample information
for any file without loading the file.

Acquisition tab: File names, software version numbers, date acquired, number of
objects, sample name.

Corrections tab: Camera background, alignment offsets (from ASSIST).

Focus/Fluidics tab: Core information and sample volume.
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Detection tab:IS100 and ImageStreamX only. Cell classifier settings during
acquisition.

Population tab: FlowSight and ImageStreamX MKII only. Lists the populations
and number acquired.

Camera Settings tab: Binmode, magnification and sensitivity settings.

Illumination tab: Brightfield and laser information.

EDF tab: View kernels used for deconvolution of EDF imagery.

Compensation tab: View the compensationmatrix.

Channels tab: Lists channels collected.
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Batch Processing
Batch processing allows you to automatically analyze a group of files with one tem-
plate when a compensationmatrix has already been generated for the experiment.

To perform batch processing

1 On the Tools menu, select Batch Data Files.
The Batches window appears. It lists a record of all batches you have pro-
cessed.

2 Click Add Batch.
The Define a Batch window appears.

3 To select the files for the batch, click Add Files. Navigate to the files and select
by clicking on the file. Select multiple files to add by holding down the Ctrl key
while selecting the files.
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• To remove files from the Files to Process list, click Remove Files.
4 Select a compensationmatrix from a file (.ctm, .cif, or .daf). Compensation is

applied to .rif files only.
5 Select a template file (.ast or .daf). Leave blank to use the Default template or

check 'Use acquisition analysis for .rif files' if this is desired.
Note that if a template is entered it will over-write the acquisition analysis.

6 Set the output files options.
7 If the template contains a statistics report definition, the Preview Statistics

Report button will appear. Click on Preview Statistics Report to review the
report or re-order the files as you wish them to be reported. To reorder the files
select a file with a left-click, then right-click in the desired position and select
‘move here’. See Reporting Statistics for more information.

8 Optional: If you have a large rif file youmay want to segment the file into multiple
smaller files.
• Click on the Segment .rif Files button.
• Choose the segment size. The number of files that will be created is updated

depending on the segment size chosen and the number of objects in the file
as shown in this example. The segmented files will include the segment num-
ber and size in their names.

• Click OK when done.

9 Click OK in the batch definition window.
The Define a Batch window closes. The batch appears in the Batches window.
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10 The Batches window offers the following options:
• Add Batch: If you want to create another batch to add to the list.
• Remove Batch: If you want to remove a batch from the Batches to Run list.
• Edit Batch: If you want to edit a batch in the Batches to Run list.

11 When you are satisfied with the Batches to Run list, click Submit Batches.
The files to process are listed and the progress is displayed in the Processing
Batch window. Once you have started processing batches, it may use up a fair
amount of your computer’s processing power.

Tip: To cancel the batch processing at any time, click Cancel Batch. The
IDEAS application will confirm cancellation and complete the file it is working on.
When the batch processing is complete, the IDEAS application saves the .rif,
.cif, and .daf files in the batch results directory. In the Batches window, a list of
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processed batches appears in the Processed Batches list. If a batch did not suc-
cessfully complete, it will appear in red.
Tip: To display the error that occurred during processing, double-click the batch.

12 After a batch is run it will appear in the processed batches list. Youmay get a
report or rerun a batch from the list.
If you wish to rerun a batch, highlight the batch name and Click Add at the bottom
of the window. This will move the batch into the run list where it may be edited.
If you want a batch report, double-click the batch name or highlight and click
Details.
The Batch Results window appears.
• In the Batch Results window, click Print.
• In the Batch Results window, click Close.
• In the Batches window, click Close.
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Overview of the Data Analysis Tools
The IDEAS application provides a powerful tool set that allows you to explore and
analyze data. The rich feature set lets you create hundreds of your own features to
differentiate objects and statistically quantify your results.

As shown in the following figure, the application window is divided into two panels—
the ImageGallery and Analysis Area—which each provide the corresponding tools
that you can use for data analysis. The layout can be changed to side by side or top
and bottom with re-sizable panels.

You can create populations of objects by tagging hand-selected images, drawing
regions on graphs, and using Boolean logic to combine existing populations. After
you have created a population, you can view it in the ImageGallery or plot it on a
graph. You can view the statistics for populations or objects in tables placed in the
analysis area.
Graphs show data plotted with one or two feature values, and tools are provided that
allow you to draw regions for the purpose of generating new populations. You can
show any population on a plot.
Every image is linked to the feature data. Selecting an individual data point in a graph
allows you to view it in the ImageGallery or look at its feature values in the Statistics
Area. Any object that is selected in the ImageGallery is also shown on the plots in
the Analysis Area. Images may be ordered in the ImageGallery by feature value.
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Overview of the Image Gallery
This section contains the following subsections, which describe how to view pop-
ulations of objects in various ways, view masks, customize the ImageGallery dis-
play, and hand-select objects for a population:

Overview of the ImageGallery

Setting the ImageGallery Properties

Working with Individual Channel Images

Creating Tagged Populations

Overview of the ImageGallery
The ImageGallery displays the imagery andmasks of any population of objects.

A toolbar is provided in the upper-left corner of the panel, as shown in the following
figure. The ImageGallery alsomakes different viewingmodes available for the
imagery. The default template contains the viewingmodes which allows you to view
all channel images in grayscale or color, or each channel image individually.

Tip: You can build custom viewingmodes as shown in this example. For more
information, see Setting the ImageGallery Properties.

Image Gallery Tools

Tool Description

TaggingMode Tool

Allows you to create a population of hand-
picked objects. See: Creating Tagged Pop-
ulations.

ImageGallery Properties Tool
Provides custom display features. See: Set-
ting the ImageGallery Properties.

Show/HideMask Tool
Displays masks on the imagery. See: Over-
view of the ImageGallery.

Table 1: ImageGallery Tools
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Tool Description

Show/Hide Color Tool
Sets the ImageGallery color. See: Over-
view of the ImageGallery.

Show/Hide Saturated Pixels
Tool

Click on the tool and it will show any sat-
urated pixels will turn red. See: Overview of
the ImageGallery.

Zoom Tools
Zoom in or out and reset zoom on the image
gallery. See: Overview of the ImageGallery

To view the imagery for a population

1 In the Population drop downmenu of the ImageGallery, click the population that
you want. (The list includes all the populations as well as the currently selected
bin from a histogram.) To create a population, refer to Creating Tagged Pop-
ulations.

2 To select an individual image, click on it. A thin, green frame indicates the selec-
ted object.
• The object’s feature values are displayed in a table if an object is selected and

a table is added to the Analysis Area.
• The selected object is identified in each scatter plot graph with a green cross.
• The objects are presented in the Image Gallery in object number order by

default. To order the objects by another feature choose the feature in the drop-
downmenu.

• The image can be placed in the Analysis area by right click>Add Image to
Analysis Area.
Tip: Conversely in any scatter plot in the analysis area, clicking a graphical
point causes the ImageGallery to highlight and display the corresponding
object.

To change the order of the images in the view

• In the Order by drop downmenu of the ImageGallery, select a feature you
wish to order the cells by and choose ascending or descending values.
Tip: You can show the feature values on the images when creating the view in
the ImageGallery Properties tool.

To change the viewingmode

• In the View drop downmenu of the ImageGallery, select a specific view. The
imagery display changes according to the new view. Tomake a new view use
the Image Properties tool.

To show or hidemasks

• Click the Show/Hide Masks toolbar button to toggle between showing and

hiding the selectedmasks for all images in the ImageGallery .
Themask is shown as a transparent layer over each image. Themask dis-
played is selected in the ImageGallery Properties View tab. The color of the
overlayedmask can be changed in the Applications Defaults under the
Options menu.
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Tip: To hide themask for a specific channel only, set the individual channel
mask to None in the view tab of the Image Properties dialog.

To show or hide color

• Click the Show/Hide Color toolbar button to toggle between showing and hid-
ing the colors for all images in the ImageGallery. See Setting the Image
Gallery Properties for more information.

To zoom on the image gallery

• Click the Zoom In toolbar button to view the images in the gallery closer and
the ZoomOut or Reset Zoom to reverse the zoom.

•

To show saturation

• Click the Show/Hide Saturated Pixels toolbar button.

Saturated pixels in images, if any, appear in red.

To show themask or feature being used for the view

• Hover over the channel name and themask or feature being used for this view
will be displayed.

Setting the Image Gallery Properties
When a new data file opens in the default template, youmight find it difficult to
clearly see cell morphology because the ImageGallery display properties have not
yet been properly adjusted for the data set.
To optimize the display youmay use the wizard Display Properties Wizard to set the
pixel intensity mapping to the display range. Manual adjustment and other settings
are described below.
Clicking the Image Gallery Properties toolbar button opens the ImageGallery
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Properties window, which contains the following tabs:

• Display Properties—Allows you to define the name, color, and display intens-
ity mapping for each image. Allows adjustment of the image size for the
image gallery.

• Views—Allows you to customize the views for the ImageGallery.
• Composites—Allows you to create composites and adjust the amount of color

from a channel that is included in a composite image.

To customize the ImageGallery display properties

1 Click the Image Gallery Properties toolbar button to begin.

The Image Gallery Properties window appears with the Display Properties
tab displayed.

To change the size of the panels in the image gallery

1 Display Width and Display Height can be specified or changed to Auto Fit in the
lower left section of this window.

To change the name or color for each image

1 Select an image in the list of images on the Display Properties tab of the Image
Gallery Properties window.
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2 On the right side of the window you can type a new, unique name for the selected
image. Note that each image is provided with a default name and the image
names appear near the top of the ImageGallery.

3 Click the colored square for the selected image.
4 Click the color that you want in the color palette.
5 Click OK to close the palette.

Tip: The grayscale image in each channel is assigned a default color for image
display in the gallery. Setting the color to white is equivalent to using the original
grayscale image. The colors are also used to build composite images.

To fine-tune the image display intensity for an image

1 On the Display Properties tab of the Image Gallery Properties window, select
an image by clicking the image name in the list. The graph for the currently selec-
ted image is shown in the window and updates as the changes aremade. Select
and image in the image gallery that has intensities for the image channel you are
adjusting.
Note: You will adjust the Display Intensity settings on the graph (the Y Axis),
the value of the display to (the X axis), the range of pixel intensities. The range of
pixel intensities will depend on the instrument and the collectionmode set during
acquisition. The display range is 0–255; the range of intensities from the camera
is 0-4095 for the ImageStreamX or 0-32,767 for EDFmode collection. The IS100
first generation instrument has a 10 bit camera and therefore the range of pixel
intensities is 0–1023. The limits of the graph enable you to use the full dynamic
range of the display tomap the pixel intensities of the image.

At each intensity on the X Axis of the graph, the gray histogram shows the num-
ber of pixels in the image. This histogram provides you with a general sense of
the range of pixel intensities in the image. The dotted green linemaps the pixel
intensities to the display intensities, which are in the 0–255 range.
Manual setting is done by Click-dragging the vertical green line on the left side
(crossing the X Axis at 0) allows you to set the display pixel intensity to 0 for all
intensities that appear to the left of that line. Doing so removes background noise
from the image.
Click-dragging the vertical green line on the right side allows you to set the dis-
play pixel intensity to 255 for all intensities that appear to the right of that line.

2 From the ImageGallery window, select the object to use for setting themapping.
It appears in the ImageGallery Properties window.
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Tip: Youmight need to select different objects for different channels because an
object might not fluoresce in all channels.

3 To adjust the pixel mapping for display, click-drag the vertical green line by click-
ing near it (but not near the yellow cross).
Tip: For fluorescence channels, set the vertical green line that appears on the left
side to the right of the large peak of background pixel intensities as shown above
and set the right vertical green line to the right of the brightest pixel intensities.
Click 'Set Linear Curve' to make the transformation linear. For the brightfield
channel, set the vertical lines to about 50 counts to the right and left of the his-
togram to produce an image with crisp brightfield contrast.
• To change themapping curve to be logarithmic or exponential, click-drag the

yellow cross.
• To restore themapping to a linear curve, Click Set Linear Curve.
• To see the full scale for the X Axis Click Full Scale.
• To set the display mapping of the X Axis to the lowest and highest values for

a selected object, Click Set Range to Pixel Data.
• To set the scale of the X Axis to the range of the vertical green lines or of all

the pixel intensities for the selected object—whichever is larger—Click Auto-
scale.

• Youmay enter values manually by selecting theManual tab.

4 If you want to preview the changes in the ImageGallery, click Preview
Changes in Gallery.

5 Continue customizing the ImageGallery display properties with another pro-
cedure in this section, or click OK to finish and save changes or Cancel to finish
and discard changes.

To customize the ImageGallery views images andmasks

1 Within the Image Gallery Properties window, click the Views tab.
Note: The ImageGallery view can be customized to view any combination of
channel images or composites. The default view All Channels is a view that
displays all image channels that were included during acquisition of the file
with their associated default masks. This mask may be changed for the
default view however, the images in this view cannot be changed.

The list of existing views is shown on the left.
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2 To create a new view, Click New. The new view is automatically added to the list
on the left.

3 In the right section of the window, type in a name for the view.
4 Click Add Column.
5 Define the column by selecting an image and amask or a composite from the

dropdownmenu.
6 To show a feature value on an image check the box and choose the feature.
7 Repeat the previous 2 steps until finished adding columns to the view. A column

will be added under the column currently selected. To insert a column click on the
image above insertion point.

8 Columns may be removed by clicking on Remove Column.
9 A view may be edited at any time by selecting the view and following the same

procedures.
10 If you want to delete a view, click the view to select it, and then click Delete.

A confirmation window appears.
11 If you want to preview any new changes in the ImageGallery, return to the Image

Gallery and choose your new view in the View drop downmenu. Then return to
the Image Gallery Properties window and click Preview Changes in Gallery.

12 Continue customizing the ImageGallery display properties with another pro-
cedure in this section, or click OK to finish and save changes or Cancel to finish
and discard changes.

To create a composite

1 Within the Image Gallery Properties window, click the Composites tab.

The list of existing composites is shown on the left.
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2 In the right section of the window, type a name for the composite or leave blank
to allow the name to be built automatically from the image names added to the
composite.

3 Click Add Image. The selected image appears in the Object box. Change the
Percent if desired. The percent specifies the percentage of of the image to
include in the composite.
Tip: As youmake the changes, the image in the Object box updates accordingly.
If you want to preview any new changes in the ImageGallery, return to the Image
Gallery and select the View drop downmenu to your new view. Then return to the
Image Gallery Properties window and click Preview Changes in Gallery.

4 Continue to add images as desired.
5 To remove and image from the composite, Click Remove Image.
6 The composite is automatically added to the list on the left.
7 A composite can be removed from the list by clicking Delete.
8 Continue customizing the ImageGallery display properties with another pro-

cedure in this section, or click OK to finish and save changes or Cancel to finish
and discard changes.

Working with Individual Channel Images
You can work with individual images in the ImageGallery. You can zoom in or out on
the images. You can add a larger version of an image to the Analysis Area for further
analysis, show or hidemasks for a single image in the ImageGallery, and copy one
or more images to the Clipboard.

Tomanipulate individual images

1 In the ImageGallery, right-click an image that you are interested in.
A menu appears.

- 91 -



Chapter 3

• To place the image in the Analysis Area, click Add Image to Analysis Area.
(For more information, see Analyzing Individual Images.)

• To show or hide themasks for the object image, click Show Masks or Hide
Masks, respectively. (One or the other will appear depending on the current
state.)

• To turn the colors on or off for the object image, click Color On or Color Off,
respectively.(One or the other will appear depending on the current state.)

• To show or hide the saturation color for the object image, click Show or Hide
Saturation Color respectively.(One or the other will appear depending on the
current state.)

To copy or save images for use in reports

1 In the ImageGallery, right-click an image that you are interested in.
A menu appears.

• To copy or save the single channel image to the Clipboard, choose
Copy/Save Image

• To copy or save all of the channel images of one object, choose Copy/Save
Object Images.

• To copy or save the single channel image for all of the displayed images to the
Clipboard, choose Copy/Save Gallery Column.

• To copy or save all the visible images in the ImageGallery choose
Copy/Save Gallery.
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Overview of the Mask Manager
This section contains the following subsections, which describe how to create, edit,
and delete amask:

For details onmask definitions and uses see the section 'About Masks' in chapter 4.

Creating New Masks with theMask Manager

Overview of the Mask Manager
A mask defines a specific area of an image to use for feature-value calculations. The
IDEAS application contains aMask Manager for viewing existingmasks and cre-
ating new ones.This option is not available for basic FlowSight files without the
Quantitative Imaging (QI) upgrade.

When the IDEAS application loads a .rif file, the application creates a segmentation
mask for each channel image and stores themask along with the image in the .cif
file. Themasks, labeledM01 throughM12, contain pixels that are detected as
brighter than the background. In addition, the application generates a Combined
Mask, namedMC and a Not CombinedMask, Not MC for each object. A combined
mask consists of the union of themasks of all the channels of the object. A Not Com-
binedMask is all of the pixels with no intensities above background.

Youmight need to adjust themasks or create new ones that include only a specific
area of a cell, such as the nucleus. You can combinemasks by using Boolean logic,
or you can adjust them by applying functions.

Creating New Masks with the Mask Manager
There are two ways to work with new masks in theMask Manager. First, masks can
be created by using functions, which allows you to choose an input mask and, if
needed, adjust the channel and scalar input. Alternatively, masks can be created by
combiningmasks through Boolean logic. This option is not available for basic
FlowSight files without the Quantitative Imaging (QI) upgrade.

To create a new mask using Functions

1 Select Analysis > Masks.
TheMask Manager opens with a list of existingmasks on the left.

2 Click New.
The right side of the window is enabled to define a new mask.
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3 Click Function.
The DefineMask Function window appears with 19 available masks to use.
SeeAbout Masks for mask definitions.
• AdaptiveErode
• Component
• Dilate
• Erode
• Fill
• Inspire
• Intensity
• Interface
• LevelSet
• Morphology
• Object
• Peak
• Range
• Skeleton
• Spot
• System
• Threshold
• Valley
• Watershed

- 94 -



Overview of the Mask Manager

4 Select a function and choose the input mask(s), channel and scalar parameters
as needed. The right side of the window adjusts the display and view of the chan-
nel image.
• To view a different object in the file, select it in the Object list or type it's num-

ber.
• To view a different image for the object, select it from the list.

5 The Link inputs checkbox is checked by default. Tomodify amask with different
inputs uncheck this box.

6 Click OK.
7 The new function is added to themask definition.
8 Click OK.

The new mask namewill appear in the list of Masks on the left side.

To create a new combinedmask

1 Select Analysis > Masks.
2 Click New.
3 Use theMasks list on the left and the Definition toolbar to build a new mask

using the definitions of existingmasks with Boolean logic explained in the table
below.
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Task Toolbar

Add amask to the
definition.

Double-click the feature in theMasks list.
Or, single click the feature in theMasks list and click the
leftmost down-arrow button on the toolbar.

Combine two
masks.

Use the Boolean AND or OR operator.
Use the AND operator to include only the pixels that
are in both of the original masks.
Use theOR operator to include the pixels that are in
either one of the original masks.

Select all pixels that
are not in the original
mask.

Use the Boolean NOT operator.
The NOT operator specifies whichmask will not be
used.

Affect the order of
operations.

Use the parentheses toolbar buttons.

Remove an item
from the end of the
definition.

Click the left-arrow button on the toolbar.

Table 1: Mask Tasks and Toolbar

4 Addmasks and Boolean logic to the definition as needed.
5 Click OK to add the definition to theMasks list.
6 Click Close.

Viewing and Editing aMask
To view amask definition

1 Select Analysis > Masks.
TheMask Manager window appears.

2 Click amask in theMasks list to view the definition in the Definition area.
3 Click Close.

To edit a mask function

1 In theMask Manager window, select themask that contains the function you
want to edit.
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2 Click Edit.
3 Remove the definition for the combinedmask using the back arrow tool as

needed.

4 Or click the Function button on the toolbar for a functionmask. The Define Mask
Function window appears.

5 Click OK when finished.

To view masks in the image gallery

After creatingmasks in theMask Manager youmay wish to view them in the
image gallery for evaluation.

1 Click the Image Gallery Properties toolbar button to begin.

The Image Gallery Properties window appears with the Display Properties
tab displayed. Click on the Views tab.

2 Click New
3 Type a name for the view
4 Click Add Column
5 Choose the Image andMask from the dropdownmenus
6 Continue to add columns until done. In this example the view will contain a Ch02

image with theMorphology mask, default mask and nomask followed by a Ch11
image with theMorpholog, default, nomask.
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7 To view themasks in the image gallery choose the view in the ImageGallery
dropdownmenu and turn themasks on by selecting the icon.

Example of Creating a Function Mask and a Combined
Mask

Here is an example of creating amask of the cytoplasm. Similar operations could be
done for the cell surface.

In this example, cells were stained with a green intracellular marker (in Channel 2)
and a red nuclear dye (in Channel 11). You can generate a cytoplasm-specific mask
by first refining the intracellular and nuclear masks and then removing the nuclear
mask pixels from the intracellular mask.
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1 Observe the default masks in the ImageGallery. Since the default masks are
designed to capture all the light in an image, they tend to include light that exists
beyond the perceived boundaries of the images. In this case, both the intra-
cellular and nuclear masks need to be refined. Start by creatingmorphology
masks for both channel images because theMorphology mask is designed to
conform to the shape of the image. Note that the Object mask functionmay also
be used in place of theMorphology mask function.

2 Select Analysis > Masks.

3 Click New.
4 Click on the Function toolbar button to adjust themask that will define the whole

cell. The Define Mask Function window appears.

5 Select Morphology in the Function list. It will be important to have an appropriate
cell selected. You can change the object number by typing in the box. Some func-
tions are iterative, in which case you can change themask selection. For
example, dilate amorphology mask.
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6 Select a startingMask.
7 Select Channel 2 (intracellular marker) on the left side of the window.
8 Click OK.
9 Click OK to add this mask to the list.

The default names are ideal for recall. The new mask will be defined in the list of
masks on the left panel. Themask definition can be recalled in the definition box
by selecting themask in the left panel.

10 Tomake theMorphology(Nuclear) mask, repeat steps 3–9 using Channel 11.
11 Click Close.
12 To view the resultingmorphology masks, open the Image Display Properties win-

dow and, if necessary, select the new mask(s) for the channel.

(Icon for Image Display Properties)
13 Next, you will subtract the nuclear morphology mask from the intracellular mask

using boolean logic. In theMask Manager window, click New.
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14 Double-click theMorphology(M02,Ch02) mask in the list.
15 Click the AND button on the toolbar.

16 Click the NOT button on the toolbar.

17 Double-click Morphology(M11,Ch11) mask in the list.

18 The default namemay be very long, edit as desired.
19 Click OK to add this mask to the list.
20 Click Close.
21 To view the resultingmasks, open the Image Display Properties window and cre-

ate a new view with themasks showing. See section "To customize the Image
Gallery views images andmasks" on page 151
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Overview of the Analysis Area
The Analysis Area provides display space for individual images, plots of cellular fea-
ture values, tables of population statistics, tables of object feature values, and text
annotations. You can select different layouts for the IDEAS window and placement
of the analysis area and expand the Analysis Area by dragging it’s boundaries.

The graphs are created into panels of a default size and can be re-sized by dragging
a corner or using the size tool. The position of the panels is automatically adjusted to
fit in the available display space. A vertical scroll bar appears when the number of
panels exceeds the space available on the window. The panels can be re-tiled using
the arrange analysis area tool.

As illustrated by the following figure, the Analysis Area can contain several types of
panels: histogram, histogram overlay, scatter plot, tables of population statistics or
object feature values, channel image, composite image, and text. Each panel will
contain its own toolbar and context menu. Tomove a panel click on the name at the
top of the graph and drag it to a new location. A graphmay be selected and then a
right click in a blank space in the work area allows you to choose paste in the new
location.

A toolbar is visible at the top of the Analysis Area. The following table describes the
function for each tool.

Analysis Area Tools

- 102 -



Overview of the Analysis Area

Tool Description

Pointer Tool

Provides the normal mode of interaction with the graphs. Clicking a
point on a scatter-plot graph causes the IDEAS application to display
the corresponding image in the ImageGallery (if the population that is
currently displayed in the ImageGallery contains that point).
Click the bin in a histogram to select the bin. In the ImageGallery, you
can view images of cells in the bin by choosing the Selected Bin pop-
ulation.
Click Pointer Tool while drawing a region on a graph to cancel the cre-
ation of a region.

Tagging Tool
Allows you to create a population of hand-picked objects. For more
information, see Creating Tagged Populations.

New Histogram Tool Creates a new histogram.

New Scatter Plot Tool Creates a new scatter plot. Refer to

Populations Statistics
table

Creates a table to display population statistics.

Object Feature Values
table

Creates a table to display selected object feature values.

Text Tool
Allows user to add text notes to the Analysis Area. Refer to Adding
Text to the Analysis Area.

Line Region Tool

Draws a horizontal line on a histogram to define a region.

Rectangle Region Tool Draws a rectangular region on a scatter plot.

Oval Region Tool Draws an oval region on a scatter plot.

Polygon Region Tool

Draws a polygon region on a scatter plot graph. Each click starts a
new segment in the polygon until the entire image is double-clicked to
complete the region.

Wizards Tool
Short-cut to usingWizards for guided analysis.

Building Blocks Tool
Short-cut to using Building Blocks for guided analysis.

Select All Tool Selects all panels in the analysis area.

Tile Graphs Tool
Tiles graphs in the analysis area after changing the size of the ana-
lysis area to fit all graphs to the new space.

Layout Tools Switches the layout of the image gallery and analysis area.

Graph Bkgd Tool
Changes the background of the graphs to black or white.

Graph sizing
Tools

Changes the size of selected graphs to small, medium or large.

Table 1: Analysis Area Tools
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Creating Graphs
You can add two types of graphs to the Analysis Area:

• Histogram—Graphs a single feature.
• Scatter Plot—Graphs two features.

Note that building blocks are available that will help you to create graphs for finding
single, focused, fluorescent positive events or a size versus scatter plot. See Build-
ing Blocks.

To create a graph without using a building block

1 Click the New Histogram or New Scatter Plot toolbar button.

The New Histogram or New Scatterplot window appears, respectively.

2 Select the one or more populations to graph by clicking them. To select more
than one population, use the Ctrl key.
The title defaults to the selected population. You can edit the title.

3 In the X Axis Feature drop downmenu, select the feature that you want to graph
on the X Axis.

4 If you want to change the label for the X axis, edit the text in the X Axis Label
field.
The label defaults to the name of the selected feature.

5 If you are creating a scatter plot, select a feature and a label for the Y Axis. If you
are creating a histogram you can choose to normalize the Y axis frequency and
change the bin count.

6 The default font sizes are used, youmay change them by clicking Font Sizes.
7 Assign colors by Population (default) for dot plots or by Density for density plots.
8 Set the scaling for each axis of the graph. (The default is Auto, which allows the

application to automatically scale the graph.)
9 To set minimum andmaximum values for an axis, select Manual.
10 Select Linear or Log and enter Maximum andMinimum limits.
11 If you selected Log, enter the X > value.
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Note: You can scale the X Axis of a graph or the Y Axis of a scatter plot in one of
twomodes: Linear or Log. The Linear mode is the default.
The Log mode allows you to logarithmically scale a section of the graph or scat-
ter plot. Selecting this mode causes the IDEAS application to perform bi-expo-
nential plotting. The > X value defines the linear portion of the graph as -X through
X. The application plots the values outside of these limits on a logarithmic scale.
You can plot negative values as well as positive ones on a logarithmic scale by
adjusting the limits.
Take care not to split a population such that it appears to be two separate pop-
ulations. This splitting is especially likely when negative values exist due to com-
pensation or corrections on the imagery. The graph on the left side was plotted on
a linear scale; the ones in the center and on the right side were plotted on log-
arithmic scales. The graph on the right side split the population because the
change from a linear to a logarithmic scale occurred in themiddle of the pop-
ulation. In general the >X value should be 1000 for 40 and 60X data and 100 for
20X data.

12 The font sizes can be changed for an individual graph.
13 Click OK.

Tip: Right-click in the graph to bring up the context menu.
Graph Properties will open the samewindow that you used to create the graph
will reappear, and you can thenmake any changes that you want.
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To show selected statistics for a graph

1 You can show and hide statistics by clicking the Statistics toolbar button in the
panel that contains the graph.

2 Or, right-click anywhere on the graph and click Statistics on the graph context
menu that appears.
The Statistics window appears.

3 Select the statistics that you want to display. Check the View statistics box and
the box next to the statistic to be displayed for each population on the graph. The
statistics that are supported are the Count, Percent Total, Percent Gated, Per-
cent, Concentration (count/sample volume), Mean, Median, Standard Deviation,
MAD (Median Average Deviation) RD -Mean, RD -Median, CV, Minimum, Max-
imum, Geometiric Mean, Mode, variance, and NaN (not a number).

4 When finished, click Close.

To show the legend for a graph
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1 Right-click anywhere on the graph, and click Show/Hide Legend on the graph
context menu that appears.
If the legend was hidden, it appears on the graph. If the legend was shown, it dis-
appears from the display.
Note: The legend contains an entry for each population on the graph. If the graph
is a scatter plot, the legend shows the population and its associated point style
and color. If the graph is a histogram or overlay histogram, the legend shows the
population name, associated color, and line type.
• Tomove the legend, click and drag it. (You cannot drag the legend past the

boundary of the graph panel.)

To order the plots on a graph or change the fill and lines for a histogram

1 Right-click anywhere on the graph and choose Plot Order and Properties on
the graph context menu that appears. The Display Properties dialog appears.

Moving aGraph

• With any graph in the Analysis Area, you canmove it to another location by
clicking in the center of the graph and dragging it. Alternatively, select the
graph, right-click in the a blank space in the analysis area choose cut and then
right-click where you would like tomove the graph and choose past.

Creating Regions on Graphs
Regions may be drawn on graphs to create new populations, based on the physical
location of objects on a graph, and to compute statistics. Tools for drawing regions
are found on the Analysis Area toolbar. A line regionmay be drawn only on a his-
togram. All other types of regions may be drawn only on a scatter plot.

A region can be copied to another graph in the same file or other open files. Regions
may also be copied from one instance of the IDEAS application to another.

When you draw a region on a histogram or scatter plot, you create a population of
objects defined by the region that may be viewed in the ImageGallery or on other
graphs.

To change the attributes of a region or delete a region and the populations dependent
on that region see Using the RegionManager .

To draw a region on a Scatter Plot

On the Analysis Area toolbar, click either the:

• Rectangle Region, or

• Oval Region, or
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• Polygon Region button on the Analysis Area toolbar.

1 The Rectangle andOval tools work by clicking on the graph at the point where
you would like to start the region, and drag to the region endpoint.
The region grows as you drag.

2 Click again to complete the region.
If you are drawing a region on a histogram or scatter plot, the Create a Region
window appears.

3 Name the region.
4 Click the colored box to select an alternate color.
5 Select Use for statistics only if you do not want to create a population from this

region.
6 Click OK.

The region appears on the graph with the name and color that you selected.

Polygon Tool Option

1 The Polygon tool works by clicking the scatter plot at the point where you would
like to start the polygon.

2 Click once for each vertex of the polygon.
3 Double-click to complete the drawing of the region.

A window appears that allows you to name the population created by the polygon
region and to assign the region’s display properties.

4 Click OK.
The region appears on the graph with the name and color that you selected.
Tip: Before you click OK, you can click Cancel or you can click the Pointer but-
ton on the Analysis Area toolbar if you decide not to create the region.

To Draw a region on a Histogram

1 On the Analysis Area toolbar, click the Line Region tool.

2 Drag the line across the histogram.
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Tomove or resize a region on a graph

1 Click theMove/Resize Region toolbar button on the graph panel toolbar.

2 Click the region that you would like tomove or resize.
When the region is selected, squares that can bemoved appear at the vertices
and the label.

3 The first time that you drag the region, the entire region and label move.
4 Dragging a specific vertex or label moves only that vertex or label.
5 To finishmoving or resizing the regions on the graph, click theMove/Resize

Region toolbar button again to deactivate the tool.

The populations and statistics are updated, and theMove/Resize Region toolbar
button is deactivated.
Note: The recalculation of statistics and populations may take amoment if the
data file is large or if many populations are dependent on the regions that are
beingmoved or resized.

To zoom in on the scale of a graph

1 Click the Scaling toolbar button on the graph panel toolbar.

2 Click and drag to define a rectangular region for rescaling.
The ZoomOut Scaling toolbar button appears in the graph panel toolbar, next to
the Scaling toolbar button.

3 Click the ZoomOut Scaling toolbar button to automatically scale the graph.
The ZoomOut Scaling toolbar button is removed from the graph panel toolbar.
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To resize a graph

• Select the graph(s) to be resized and then click the sizing button tool small,

medium or large.
• A graphmay be resized by dragging the right, bottom or lower,right corner.

Tip: Select multiple graphs tomake them all the same size.

To copy and paste a region to another graph

1 Right-click anywhere on a graph, and click Copy Region to Clipboard on the
graph context menu that appears.
The Copy a Region to the Clipboard window appears.

2 Click the region to copy in the list, and click OK.
3 Right-click on the graph where you want to paste the region, and click Paste

Region from Clipboard on the graph context menu that appears.
4 If the region already exists (in other words, you are copying it within the same

instance of the application), the Create a Region window appears.
5 Rename the region and set the display properties for the resulting new pop-

ulation, and click OK.
Note: When you copy a region, the scale is copied and is no longer associated
with the feature from which it was originally drawn. Therefore, the regionmight
not fit on the new graph.

To Apply or Remove a region on a graph

1 Right-click anywhere on the graph, and click Apply/Remove Region on the
graph context menu that appears. The Apply Graph Regions window appears.

2 Select the regions that you want to appear on the graph.
3 Clear the regions that you want to remove from the graph.
4 Click OK.

To show or hide a population on a scatter plot
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1 Click Show/Hide Populations on the graph context menu.
The Show/Hide Populations window appears.

2 Select the populations that you want to appear on the graph.
3 Clear the populations that you want to remove from the graph.

4 Click OK.
Tip: On a scatter plot, youmay show or hide any population on the graph—regard-
less of the features on the axes. Each scatter plot has an original, or base, pop-
ulation. When you show a population on a scatter plot, only those objects that are
also in the base population will be shown. To aid in the identification of the pop-
ulations shown, change the characteristics of the population(s) in the population
manager.

Analyzing Individual Images
To analyze an image inmore detail, place the image in the Analysis Area to view
pixel positions and intensities as well as generate statistics for an area of the image.
You can also show theMeasurement tool for the image.

Image panels, which are shown in the following figure, each contain a toolbar in the
upper-right corner and a context menu that appears when you right-click an image.
An image in the Analysis Area is three times the size of an image in the Image
Gallery.

To add an image panel to the Analysis Area

• Right-click an image in the ImageGallery or Analysis Area, and click Add
Image to Analysis Areaon the context menu that appears.
The image panel appears in the Analysis Area.
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To view the individual pixel intensities of a single channel image

• Move themouse pointer across the image.
The pixel positions and intensities appear under the image. (The pixel (0, 0) is
positioned at the upper left of the image.)

To display theMeasurement tool in an image panel

• Right-click the image panel, and click Show Measurement Tool on the con-
text menu that appears.
The 10-micron bar appears.
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To examine a line profile or the statistics for an area of an image

• Click on the red line tool in the image tools to open , click and drag to create a

boxed area on the image.
The Image Statistics are shown in the image panel. The statistics are cal-
culated for the area that is defined by the box. The line profile (the wavy line in
the image panel) represents the pixel intensity at each position along the red
line of the box.
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To change the display properties of an image

1 Click the Channel Display Properties button on the image panel toolbar.
The Display Properties window appears.
• For single channel image, you can change the displayedmask and adjust the

display intensity mapping. For more information, see Setting the Image
Gallery Properties.
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• For a composite image, you can change the images in the composite and
adjust the percent contribution of each image, see Setting the ImageGallery
Properties.
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2 Click OK.

To show or hide themask for a single channel image

• Click theMask button on the image panel toolbar, or right-click the image and
then click Show/Hide Mask on the image context menu.

Themask appears as a transparent overlay on the image.

To turn the color on or off

• Click the Color button on the image panel toolbar, or right-click the image and
then click Color Off or Color On.

Viewing the Object Feature Values
TheObject Feature Values table, which is shown in the following figure, displays a
selected set of feature values for selected objects. For each feature, the name,
value, and description are shown.

- 116 -



Overview of the Analysis Area

To view and customize the features shown in the Object Data table

1 Click the Object Feature Values tool.
2 Right-click anywhere in the table area to open themenu.

3 Choose Select Features.
The Select Object Features window appears.
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4 Select the features to view. Multiple features may be chosen by holding down the
Ctrl key.

5 Click OK.
The features appear in the Object Data table.

6 To add selected objects to the table right-click and choose Add Current Object.

To export or copy feature values

• Right-click in the table and choose Copy feature values to clipboard.

Adding Text to the Analysis Area
To add text to the Analysis Area

1 Click the Text button on the Analysis Area toolbar.

A text panel is added to the analysis area.
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2 Type a title and text.

Population Statistics
The Population Statistics table displays selected statistics for chosen populations.
The statistics that are supported are the Count, Percent Total, Percent Gated, Per-
cent, Concentration (count/sample volume), Mean, Median, Standard Deviation,
MAD (Median Average Deviation) RD -Mean, RD -Median, CV, Minimum, Max-
imum, Geometric Mean, Mode, variance, and NaN (not a number).

To view and customize the population statistics

1 Click the Populations Statistics tool.
2 Click the + next to the population to expand the list of populations.
3 Columns can bemoved by click-dragging.
4 Right-click in the grey area in the table or on a column heading and themenu

opens.

5 Edit Statistic Table opens a Statistics Properties window to enable changes to
multiple column statistics.

6 To add a single statistic column select Insert Column.
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7 Select Edit Column tomake a change.
8 To delete a single column right-click on that column and select Delete Column.
9 Select Delete All Columns to clear all statistics.
10 Order Columns places the columns in default order.
11 Copy Statistics copies the selected rows of the table in a text format that can be

pasted into other programs such as Excel.
12 Copy Statistics - Transposed copies the selected rows of the table and trans-

poses the data so that when pasted into other programs such as Excel the rows
become columns.

- 120 -



Using the Feature Manager

Using the Feature Manager
This section describes how to create and delete features and to createmultiple fea-
tures by selecting categories. The only new feature options for FlowSight basic files
without QI are combined features. The following subsections cover this information:

Viewing feature definitions

Creating New Features with the FeatureManager

Creatingmultiple features and ranking features by discriminating power

Overview of the Feature Manager
The IDEAS application defines a set of base features that you can use to create fea-
tures for each object. To do so, you use the object’s mask and/or its channel
images. After a feature has been created and its value calculated for all cells, you
can plot the feature values or view them as statistics for any population. For descrip-
tions of all the base features, see Chapter 4: Features andMasks.

When the IDEAS application opens a .cif or .rif file, the application calculates the val-
ues of features as defined by the selected template. You can refine your template so
that it includes only those features of interest for your experiment.

You use the FeatureManager to examine existing features and to define new ones.
To gain access to the FeatureManager, select Analysis > Features or select it from
one of the context menus that are available in the histogram and scatter plot panels
with a right-click. While the FeatureManager is open, all calculations for creating
graphs and statistics are disabled. However, youmay view images and change the
population and channel views. When you close the FeatureManager, any changes
to feature names, definitions, and values are reflected in any currently displayed
graphs and statistics. The values of newly created features are also calculated at
this time.

You can create single features and combined features. You create a single feature
by selecting a base feature, such as Area or Intensity, along with amask and/or an
image. This option is not available for basic FlowSight files without the Quantitative
Imaging (QI) upgrade.You can create a combined feature by defining amathematical
expression that includes one or more single features that exist in the feature list.
FlowSight files without the QI upgrade can utilize the combined feature option.

Some features, such as Area, depend on the boundary of a cell. These features
require you to select amask that defines the portion of the image to use for the cal-
culation. Other features, such as Max Pixel, depend on pixel intensity meas-
urements and require you to select an image. Other features require you to select a
mask and one or more images.

You can add and remove features from the feature list. The feature definitions are
stored in templates, so the definitions are available when you analyzemultiple data
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files. The default template used for ImageStream data or QI FlowSight data includes
most of the base features for each channel image and channel mask that the feature
list contains. Certain features, such as Similarity and Spot, require extensive cal-
culations so the default template does not include them. The reason is to save time
when you load files. However, you can add these features to the feature list.

Viewing feature definitions
To view existing features

1 Click Analysis > Features or select Features from a graph panel context menu.
The Feature Manager window appears.

2 Choose an icon to sort the features:

Feature Icon Definition

Sorts features alphabetically.

Sorts features based on the images used.

Sorts features based on themasks used.

Sorts features by category, such as size, loc-
ation, shape, texture, signal strength, and sys-
tem.
Sorts by base features, such as area, aspect
ratio, intensity, and object number.

Table 1: Sorting Features

3 Click a feature in the Features list to view its definition in the right side of the win-
dow.

Creating New Features with the Feature Manager
To create a new single feature
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A single feature uses the definitions of a base feature along with amask and/or
an image.

1 Click New in the FeatureManager.
The right-hand area of the FeatureManager is enabled.

2 Select Single as the Feature Typeand choose the base feature in the drop down
menu.

3 TheMask and Image lists become visible depending on the single feature selec-
ted.

4 Select themask and/or image that you want.
5 Click Set Default Name.

The default name is the name of the base feature followed by the name of the
mask and name(s) of the image(s).

6 Click OK to add the new feature.
It appears in the Features list on the left side of the FeatureManager.

7 Click Close.
Note: When you close the FeatureManager, the IDEAS application calculates
values for the new features. These calculations may take several minutes,
depending on the number and complexity of the new features and the size of the
image file.

To createmultiple features

1 Click Add Multiple Features in the FeatureManager.
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2 Sort the feature list alphabetically or categorically.
3 Select multiple base features andmasks
4 Select image(s) or check the box to create for all channels using default masks

and images.

5 Any list can be cleared by clicking the Clear Selected button.
6 When finished click Add Features to add the new features to the list.
7 Confirm the features in the next window.
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8 Delete any features you do not want to calculate.
9 Click OK when finished. The new features are added to the list in the featureman-

ager.
10 Close the Add Features window.
11 Close the FeatureManager. The new features are calculated when the feature

manager closes.

To create a new combined feature

A combined feature uses one or more single features created by amathematical
expression.

1 Click New in the FeatureManager.
The right hand area of the FeatureManager is enabled.

2 Select Combined as the Feature Type:
The editing interface appears.
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3 Enter the feature name in the Name box or use Set Default Name after you
have created your expression. The default name is the name of the definition cre-
ated.

4 Use the toolbar to build a definition (mathematical expression) of features and
operators:

Task Toolbar

Add a feature to
the definition.

Double-click the feature in the Features list.
Or, single click the feature in the Features list and select
click the leftmost down-arrow button on the toolbar.

Add an operator or
a parenthesis to
the definition.

Click the corresponding button on the toolbar.

Add a number to
the definition.

Enter the number in the box and then click the cor-
responding down-arrow button.

If the area is greyed-out, an operator must be selected first.

Add a function to
the definition.

Select the function in the list and then click the cor-
responding down-arrow button.

The available functions are ABS (absolute),
COS (cosine), SIN (sine), SQR (square), and
SQRT (square root).
If the area is greyed-out, an operator must be
selected first.

Remove an item
from the end of the
definition.

Click the left-arrow button on the toolbar.

Table 1: Combined Feature Tasks and Toolbar

5 Click OK.
6 Click Close.

Note: When you close the FeatureManager, the IDEAS application calculates
values for the new features. These calculations may take several minutes,
depending on the number and complexity of the new features and the size of the
image file.

To delete a feature

1 Select one or more features in the Features list by clicking them. To select more
than one feature, use the Ctrl key.

2 Click Delete.
A warningmessage will confirm or cancel deletion.
Note: Deleting a feature also deletes any populations that are dependent on that
feature. Your feature list may become large and unwieldy. You can narrow down
the list without deletions by sorting the list. See Using the FeatureManager for
more information.
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Creating multiple features and ranking features by dis-
criminating power

With the IDEAS application you are able to create an unlimited set of features by
using theMask manager to define location and the Featuremanager to choose a
mathematical expression that uses the image pixel data and/or themask. This can
make it challenging to choose a feature that provides good statistical separation of
populations of cells that have different appearances from each other.

IDEAS 6 includes the 'Feature Finder' wizard which creates a set of masks and fea-
tures automatically and determines the features with themost discriminating power
for the chosen truth populations. It may be useful for certain applications to create
new masks and features that are not created by the wizard. Once features are cre-
ated using this manual method the Feature Finder wizard will test all features in the
data file. See theFeature FinderWizard for more details.

A general description of the steps is followed by a specific example.

General:
1 Set image display and draw preliminary regions to include cells of interest (i.e.

single, focused, positive cells).
2 Visually inspect overall quality of images and experiment to determine whether to

proceed or redo the experiment.
3 Create two tagged ‘truth’ populations of cells that represent the phenotypes you

wish to discriminate. Perform the discrimination on one characteristic difference
at a time.

4 Create any additional masks and features you think may help differentiate the
truth populations.

5 Calculate the statistical discrimination (RD) between the two populations
afforded by features in 1 category at a time. Pick the top feature for each cat-
egory. Alternatively, use the Feature Finder wizard whichmeasures the RD but
only keeps the 3 features per category with the highest RD.

6 Plot the features with the highest RD for the truth populations for each category
7 Validate by applying the feature to the base population, independent controls if

available and onmultiple files and experiments.

Example:
Treatment-induced actin polarization. The data file is available for practice. Log in to
your account on the Amnis website and look in the folder ‘Training data files’.

• Cells were incubated with inducing compound for 1 hour.
• The nucleus was probed with DAPI and actin stained with FITC.
• Large event image files were collected on the ImageStream.
• Compensation and analysis was done in IDEAS.
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The following steps find the best features that distinguish changes in actin dis-
tribution.

1 Gate single, focused, actin-positive cells. View cells of interest.
2 Create the truth populations from within the cells of interest using the tagging

tool.
Note: If truth populations are in different files, merge them together before begin-
ning. When selecting truth populations, choose images that represent the full
phenotypic range of each truth. In this example case, note that the ‘uniform actin’
truth population contains cells of varying shape and intensity that all have uniform
actin distribution. Bias introduced during the selection of truth populations will
likely also bias the outcome during statistical ranking.
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The following figure shows the truth populations chosen to find a feature to dis-
criminate uniform versus polarized actin:

3 Create theMorphology and one or moreThreshold masks for the actin image.
4 Create features from the Size, Shape, and Texture categories using theMor-

phology, Threshold and Default actin channel masks.

a. Choose Features from the Analysis menu and click
AddMultiple Features.

b. In the Add Features window select Category as the

‘Sort Order’.
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c. Check Size, Shape and Texture base feature boxes.
d. Select the actin masks (Morphology, Object,
Threshold, M02)
e. Select the actin image (FITC).
f. Click Add Features to display the list of features to
add.
g.In the next window Click OK to add the fea-
tures.Features that already exist will not be recal-
culated.
h. Click OK and Click Close.
i. Close the FeatureManager by clicking Close and the
features will be calculated.

5 Add the feature statistics to the population statistics table. Do this one category
at a time. Multiple statistics tables can be added to the analysis area, one for
each category of features.
Alternative: Go to the Feature Finder wizard to continue with the RD calculation
and ranking.

Once the features are calculated you can use the RD,( 
Fischer's Discriminant Ratio) to a statistics table. The
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RD measures the separation between 2 populations. In
this case, the 2 truth populations picked in step 2. In
order to get the statistic for 1 category at a time, select
all of the features for the image and then deselect cat-
egories, to leave 1 category for the channel selected.

a. Click on to add a statistics table to the analysis
area.
b. Right-click in the table and choose Edit Statistics
Table.
c. Delete any statistics from the list.
d. Select the statistic ‘RD –Mean’.
e. Select one of the truth populations in the Reference
population box.

f. Sort by Images Used by clicking on the icon .
g. Check the box for the Ch02/Actin image.

h. Sort the features by Category .

i. De-select all but 1 category by checking and uncheck-
ing the box for the categories you want to de-select.
Note that the box next to the category will be checked
only if all of the features (all channels) in the category
are selected.
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j. Click ‘Add Statistics’.
k. Click Close.
l. Repeat until each statistics table contains 1 category
of features for Ch02(Actin).

6 Launch Excel and then Copy and Paste the statistics into the excel spreadsheet.

a. Select the row of statistics for the 2nd truth population
(the one not chosen above).
b. Right-click in the statistics table and choose Copy
Statistics - Transposed.
c. Paste into an Excel spreadsheet.
d. Keep all of the features and values selected and sort
the data set on the values column (headingmay be the
population name) largest to smallest. The feature with
the largest RD will be at the top.
Note: youmay have NaN values for some of the fea-
tures. This means Not a Number and occurs in some
cases when there is a division by 0. These can be
ignored.

7 Validate the features in IDEAS. Plot the features with the highest RD for the truth
populations and draw regions to discriminate.

8 Apply regions to the base population, independent controls if available and onmul-
tiple files and experiments.

9 Look for false negative and positive cells.
10 Repeat process if necessary by refining/creating new truth populations.

NOTES ON EVALUATING THE FEATURES:

Consider the features that produce the highest Rd. If there are any intensity based
features make sure that the staining was not uneven due to technical issues. If it is a
size feature, does it make sense with what you know about the cells and biology of
your experimental system? Since the feature value ranges vary between features
this is an approximate comparison and the result should be validated by viewing
images across the feature range from the whole population.
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Using the Population Manager
A population is a group of objects. You create populations by drawing regions on
graphs, by hand-selecting (tagging) objects in the ImageGallery or on plots, or by
combining existing populations. After a population has been defined, you can view it
in the ImageGallery or on a plot and you can use it to calculate statistics.

The PopulationManager provides a central place for maintaining the display prop-
erties of existing populations and for creating new combined populations.

To open the PopulationManager and view the population definitions

1 Select Analysis > Populations or right click a graph and select Populations.
The PopulationManager window appears.

Note: The list of populations is presented as a hierarchy that shows the depend-
encies of the populations on each other. The icon associated with a population
indicates how the population is defined.

icon Defined by

Tagging

Region

Combined
The definition of a selected population is shown in the Definition area.

To edit the display properties of a population

1 Within the Population Manager, click a population in the Populations list.
2 Change the name in the Name box.
3 Click a Color square to select a new color on the color palette and click OK.
4 Click a display symbol in the Symbol drop downmenu.
5 Click Close to save the population changes.
6 Click Revert to reject the changes.

To delete a population
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1 Within the Population Manager, click a population in the Populations list.
2 Click Delete.

A confirmation warningmessage appears indicating all the dependent pop-
ulations that will also be deleted.

3 Click Yes to confirm.

To create a new combined population

1 Within the Population Manager (Analysis > Populations), click New.
The right side of the PopulationManager window changes to allow you to define a
new population.

2 Enter a unique population name in the Name box.
3 Click a Color square to select a new color on the color palette and click OK.
4 Click a display symbol in the Symbol drop downmenu.
5 Use the toolbar to build the population definition as described in the table and

click OK when done:

Task Toolbar
Add a population to the defin- Select the population from the drop-downmenu.

Table 1: Population Tasks and Toolbar
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Task Toolbar
ition.

Combine two populations.

Use the Boolean AND or OR operator.
Use the AND operator to include only the objects that
are in both of the original populations.
Use theOR operator to include the objects that are in
either one of the original populations.

Select objects that are not in
the original population.

Use the Boolean NOT operator.
The NOT operator specifies which population will not
be used. Note: youmust use AND before NOT.

Affect the order of operations. Use the parentheses toolbar buttons.

Remove an item from the end
of the definition.

Click the left-arrow button on the toolbar.

See Creating Tagged Populations for information about tagged populations.
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Creating Tagged Populations
You can hand-select objects from either the ImageGallery or a graph and group them
into a population.

To create a hand-selected population

1 Click the TaggingMode toolbar button to begin.

The Tagged Population window appears.

2 Select either Update existing or Create New.
• To Create New, double-click images within the ImageGallery and select

Save. Enter a new population name. Each population is given a new color and
the symbol solid diamond for ease of viewing in plots.

3 If you selected Update existing, choose a population to update in the drop down
menu.

4 In the Image viewing mode list, choose themode that you want from the drop
downmenu. See Setting the ImageGallery Properties for more information.

5 To add or remove an image from the tagged population, double-click either the
image in the ImageGallery or a dot in a bivariate plot.
The selected channel image for each tagged cell is displayed in the viewing area
of the Tagged Populations window. In the ImageGallery, a small smiley-face
icon appears on the left side of each tagged image. Each tagged object is also dis-
played as a yellow star in a graph in the Analysis Area. The number of objects in
the tagged population is updated in the bottom, left corner.

6 If you are updating an existing population, click the Update button in the Tagged
Populations window.

7 When you are finished updating, click Close in the Tagged Populations window.
Note: The taggingmode remains open until you click Close, and as long as the
ImageGallery is in taggingmode, you cannot create, resize, or move any regions
on the graphs.
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Creating a tagged population from a file of object numbers
You can use a comma-separated text file of object numbers to create a tagged pop-
ulation.

Select Create Tagged Population from File under the Tools menu.

Browse for the file.

Name the population, select the color, symbol and click OK.

- 137 -



Chapter 3

Using the Region Manager
The RegionManager provides a central place for defining the display properties,
names, and positions of existing regions. Regions can be deleted in the RegionMan-
ager tool.

If a file is going to be used as a template and you do not wish to change certain
regions in the new daf files youmay check the box 'When used as a template, do not
overwrite this region' and the specific regions will be preserved in the new daf files.

Regions are drawn on graphs to create new populations, based on the physical loc-
ation of objects on a graph, and to compute statistics. Tools for drawing regions are
found on the Analysis Area toolbar. See Creating Regions onGraphs for more inform-
ation.

To open the RegionManager and view the region definitions

1 Select Analysis > Regions or right click a graph and select Regions.
The RegionManager window appears. Click on the region in the list you want to
view.

To edit a region

1 Within the Region Manager, click a region in the Regions list.
2 Change the name in the Name box.
3 Click a Color square to select a new color on the color palette and click OK.
4 Change the X or Y position of the vertices in the Vertices box.
5 Select or de-select the Use for statistics only box.
6 Click Delete to delete a region.
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7 Click Revert to reject the changes.
8 Click Close when finished.

Note: When a region is deleted, all populations that are defined by that region will be
deleted. A warning dialog box appears listing the populations that will be deleted.
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Creating Reports and Exporting Data
The following six-page sample report was created by copying data
from IDEAS, the ImageStream Data Acquistion forms and excel into
a MS word document. This template can be found in the customer
documents in your training materials or in the knowledge-base of
your account on the Amnis website.

Once you have finished analysing an experiment you will want to
report the results into third party applications. To streamline the pro-
cess the first step is to define your application defaults, image gal-
lery settings and statistics report definitions. This section covers the
following topics that will help you to create reports.

Viewing and Changing the Application Defaults

Setting the ImageGallery Properties

Prepare the image gallery and analysis area for reporting.

Copy full or partial screens

Copy images to the clipboard or save images to files

Copy graphs to the clipboard or save graphs to a file

Reporting Statistics
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Exporting Data into other analysis applications

Printing Data
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Viewing and Changing the Application Defaults
To view or change these defaults, chooseApplication Defaults from
the Options menu, Each tab allows you to view or change the
default settings.
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The Directories tab contains the default Data, Template, Batch or Compensation
Matrix file directories.
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The Populations tab contains the default color or symbol for populations. To change
the default settings, click on the color to or choose a default symbol from the list.

TheMasks tab contains the default mask color. To change the color of themask
click on the color button.
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TheGraph Displaytab contains the default settings for graphs in the analysis area
including graph size, font sizes and the default list of statistics shown for a graph.
Check the box next to the statistic to have it show below the graphs when statistics
are shown for a graph. The settings may be updated on all or selected graphs in the
analysis area.

TheGraph Export tab contains the default settings for exporting graphs including
the graph size, font size, options to include legend, cursor sample name and
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statistics. Select the Defaults button to use the graph export settings when export-
ing graphs or select the Graph button to use the settings as they appear in the ana-
lysis area for the graph.
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TheImage Export tab contains the default settings for image export when copying
and pasting from IDEAS for reporting into other programs.
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The Colors tab contains themapping of dark and light mode colors.

Setting the Image Gallery Properties
When a new data file opens in the default template, youmight find it difficult to
clearly see cell morphology because the ImageGallery display properties have not
yet been properly adjusted for the data set.
To optimize the display youmay use the wizard Display Properties Wizard to set the
pixel intensity mapping to the display range. Manual adjustment and other settings
are described below.
Clicking the Image Gallery Properties toolbar button opens the ImageGallery Prop-
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erties window, which contains the following tabs:

• Display Properties—Allows you to define the name, color, and display intens-
ity mapping for each image. Allows adjustment of the image size for the
image gallery.

• Views—Allows you to customize the views for the ImageGallery.
• Composites—Allows you to create composites and adjust the amount of color

from a channel that is included in a composite image.

To customize the ImageGallery display properties

1 Click the Image Gallery Properties toolbar button to begin.

The Image Gallery Properties window appears with the Display Properties
tab displayed.

To change the size of the panels in the image gallery

1 Display Width and Display Height can be specified or changed to Auto Fit in the
lower left section of this window.

To change the name or color for each image

1 Select an image in the list of images on the Display Properties tab of the Image
Gallery Properties window.
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2 On the right side of the window you can type a new, unique name for the selected
image. Note that each image is provided with a default name and the image
names appear near the top of the ImageGallery.

3 Click the colored square for the selected image.
4 Click the color that you want in the color palette.
5 Click OK to close the palette.

Tip: The grayscale image in each channel is assigned a default color for image
display in the gallery. Setting the color to white is equivalent to using the original
grayscale image. The colors are also used to build composite images.

To fine-tune the image display intensity for an image

1 On the Display Properties tab of the Image Gallery Properties window, select
an image by clicking the image name in the list. The graph for the currently selec-
ted image is shown in the window and updates as the changes aremade. Select
and image in the image gallery that has intensities for the image channel you are
adjusting.
Note: You will adjust the Display Intensity settings on the graph (the Y Axis),
the value of the display to (the X axis), the range of pixel intensities. The range of
pixel intensities will depend on the instrument and the collectionmode set during
acquisition. The display range is 0–255; the range of intensities from the camera
is 0-4095 for the ImageStreamX or 0-32,767 for EDFmode collection. The IS100
first generation instrument has a 10 bit camera and therefore the range of pixel
intensities is 0–1023. The limits of the graph enable you to use the full dynamic
range of the display tomap the pixel intensities of the image.

At each intensity on the X Axis of the graph, the gray histogram shows the num-
ber of pixels in the image. This histogram provides you with a general sense of
the range of pixel intensities in the image. The dotted green linemaps the pixel
intensities to the display intensities, which are in the 0–255 range.
Manual setting is done by Click-dragging the vertical green line on the left side
(crossing the X Axis at 0) allows you to set the display pixel intensity to 0 for all
intensities that appear to the left of that line. Doing so removes background noise
from the image.
Click-dragging the vertical green line on the right side allows you to set the dis-
play pixel intensity to 255 for all intensities that appear to the right of that line.

2 From the ImageGallery window, select the object to use for setting themapping.
It appears in the ImageGallery Properties window.
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Tip: Youmight need to select different objects for different channels because an
object might not fluoresce in all channels.

3 To adjust the pixel mapping for display, click-drag the vertical green line by click-
ing near it (but not near the yellow cross).
Tip: For fluorescence channels, set the vertical green line that appears on the left
side to the right of the large peak of background pixel intensities as shown above
and set the right vertical green line to the right of the brightest pixel intensities.
Click 'Set Linear Curve' to make the transformation linear. For the brightfield
channel, set the vertical lines to about 50 counts to the right and left of the his-
togram to produce an image with crisp brightfield contrast.
• To change themapping curve to be logarithmic or exponential, click-drag the

yellow cross.
• To restore themapping to a linear curve, Click Set Linear Curve.
• To see the full scale for the X Axis Click Full Scale.
• To set the display mapping of the X Axis to the lowest and highest values for

a selected object, Click Set Range to Pixel Data.
• To set the scale of the X Axis to the range of the vertical green lines or of all

the pixel intensities for the selected object—whichever is larger—Click Auto-
scale.

• Youmay enter values manually by selecting theManual tab.

4 If you want to preview the changes in the ImageGallery, click Preview
Changes in Gallery.

5 Continue customizing the ImageGallery display properties with another pro-
cedure in this section, or click OK to finish and save changes or Cancel to finish
and discard changes.

To customize the ImageGallery views images andmasks

1 Within the Image Gallery Properties window, click the Views tab.
Note: The ImageGallery view can be customized to view any combination of
channel images or composites. The default view All Channels is a view that
displays all image channels that were included during acquisition of the file
with their associated default masks. This mask may be changed for the
default view however, the images in this view cannot be changed.

The list of existing views is shown on the left.
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2 To create a new view, Click New. The new view is automatically added to the list
on the left.

3 In the right section of the window, type in a name for the view.
4 Click Add Column.
5 Define the column by selecting an image and amask or a composite from the

dropdownmenu.
6 To show a feature value on an image check the box and choose the feature.
7 Repeat the previous 2 steps until finished adding columns to the view. A column

will be added under the column currently selected. To insert a column click on the
image above insertion point.

8 Columns may be removed by clicking on Remove Column.
9 A view may be edited at any time by selecting the view and following the same

procedures.
10 If you want to delete a view, click the view to select it, and then click Delete.

A confirmation window appears.
11 If you want to preview any new changes in the ImageGallery, return to the Image

Gallery and choose your new view in the View drop downmenu. Then return to
the Image Gallery Properties window and click Preview Changes in Gallery.

12 Continue customizing the ImageGallery display properties with another pro-
cedure in this section, or click OK to finish and save changes or Cancel to finish
and discard changes.

To create a composite

1 Within the Image Gallery Properties window, click the Composites tab.

The list of existing composites is shown on the left.
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2 In the right section of the window, type a name for the composite or leave blank
to allow the name to be built automatically from the image names added to the
composite.

3 Click Add Image. The selected image appears in the Object box. Change the
Percent if desired. The percent specifies the percentage of of the image to
include in the composite.
Tip: As youmake the changes, the image in the Object box updates accordingly.
If you want to preview any new changes in the ImageGallery, return to the Image
Gallery and select the View drop downmenu to your new view. Then return to the
Image Gallery Properties window and click Preview Changes in Gallery.

4 Continue to add images as desired.
5 To remove and image from the composite, Click Remove Image.
6 The composite is automatically added to the list on the left.
7 A composite can be removed from the list by clicking Delete.
8 Continue customizing the ImageGallery display properties with another pro-

cedure in this section, or click OK to finish and save changes or Cancel to finish
and discard changes.
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Reporting Images and Graphs
The IDEAS application allows users to copy and print images and graphs, export
statistics, feature data, pixel data, or TIF files for separate analyses.

Prepare the image gallery and analysis area for reporting.
1 Before you print or copy images, see Setting the ImageGallery Properties to

optimize the image display.
2 In addition to formatting the graphs and statistics in the Analysis area (seeOver-

view of the Analysis Area), the IDEAS application provides color mapping from
the dark mode that you see in the Analysis Area to a light mode that has a white
background for the printing and exporting of data. Because the population colors
might not show on a white background, you can change the colors when using
the light mode.

To use light background graphs in the Analysis Area

Click the graph background tool to switch between light or dark mode.

Tomap the dark mode colors to light mode colors

1 See the Application Defaults-Colors tab .

2 Click Update Populations in Open Files when done..
3 Click OK to save the changes or Cancel to exit.
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Copy full or partial screens
To copy the entire screen to the Clipboard

• Press CTRL+PRINT SCREEN. It is then available for pasting into a third
party application.

To copy a window to the Clipboard

• Select the window and then press ALT+PRINT SCREEN. It is then available
for pasting into a third party application.

Print the analysis area or image gallery directly
To print the Analysis Area data

• Select Reports > Print Analysis Area.
The IDEAS application prints all the graphs, statistics, text panels, and
images that are displayed in the Analysis Area.

To print the ImageGallery data

• Select Reports > Print Image Gallery.
The IDEAS application prints all the images that are visible in the Image
Gallery.

Copy images to the clipboard or save images to files
To copy or save Images

1 Right-click anywhere in the ImageGallery and then choose one of the following
options:

• Copy/Save Image for a single image

• Copy/SaveObject Images for the row of images for one object

• Copy/SaveGallery Column for the images of one channel in the
current gallery

• Copy/SaveGallery for all images in the current gallery

2 A preview of the image(s) is shown. Changes from the default settings may be
made to the following:

• Show Channel names
• Show Object number
• Show Scale bar
• Text color for channel names
• Background
• Number of rows and columns
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• Size and DPI settings
• Font sizes and clipboard format

3 The settings may be Saved to the Default settings or Default set-
tings may be loaded.

4 Click Save to File or Copy to Clipboard when done. Files may be
saved as .png, .bmp or .tif formats.

5 If Copy to Clipboard was chosen, paste into third party application.

Copy graphs to the clipboard or save graphs to a file
To copy or save graphs

1 Right click anywhere in the graph and choose Copy/SaveGraph and/or Statistic.
2 A preview of the graph is shown. Changes from the default settings may bemade

to the following:

• IncludeGraph
• Include Legend
• Include Statistics
• Include Cursor
• Show sample name in title
• White background on/off
• Graph size
• Font sizes

3 If changes aremade they can be previewed by clicking Generate Preview.
Otherwise they will be applied when Save to File or Copy to Clipboard is chosen.

4 Option: settings may be saved to default settings or loaded from default settings.
5 Click Save to File or Copy to Clipboard when done. Files may be saved as

.png, .bmp or .tif formats.
6 If Copy to Clipboard was chosen, paste into third party application.
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To export graph statistics to the Clipboard

• Right-click a graph and then click Export Statistics To Clipboard. They are
then available for pasting into a third party application.

To copy population statistics from a Statistics Table

• Right-click the table and then click Copy Statistics or Copy Statistics -
transposed. They are then available for pasting into a third party application.
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Reporting Statistics

Define a Statistics Report
A statistics report definition can be saved in a .daf file or an .ast template file. It
allows users to select specific statistics within a .daf file and open the data in Excel.

A statistics report can be generated during batching if it is part of the template used.
It may also be applied to pre-existing .daf files from the Reportingmenu. In this
case, the rest of the template is not processed—only the report. The statistics report
definition allows you to specify population percentages and feature statistics and the
layout of the report is accessed from the reportingmenu.

To create a Statistics Report Definition

1 Select Reports > Define Statistics Report.
The Statistics Report Definition appears.

2 Enter a Report title.
3 Under the Statistic Columns clickAdd Columns. The Add Statistic Report

Columnwindow opens.
4 Select the statistic(s) in the Statistics list.

• Count - the absolute count of the populations
• %Total - percentage of a population as a percentage of All
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• %Gated - the percent of one population as a percentage of another, but not
used for tagged populations

• % - the percentage of one population as a percentage of another, also is used
for tagged populations

• Objects/mL - the concentration of the population in the sample run.
• CV - the coefficient variable
• Geometric Mean - standard statistical definition
• Maximum - standard statistical definition
• Mean - standard statistical definition
• Median - standard statistical definition
• MAD - standard statistical definition
• Minimum - standard statistical definition
• Mode - standard statistical definition
• RD - Median - the ratio discriminant (Fisher's discriminant) using theMedian

andMAD
• RD - Mean - the ratio discriminant (Fisher's discriminant) using theMean and

StdDev
• Standard Deviation - standard statistical definition
• Variance - standard statistical definition
• NaN - stands for not a number; the number of objects whose values are not

valid numbers.

5 Select a population to base on the selected statistic(s).
6 Select a reference population if necessary. This is required for% and RD.
7 Select a Feature. This is not necessary for the%-related statistics, Count or

Objects/ml.
8 Click Add Statistics.The statistic is added to the list.
9 Click Close when finished.
10 Select a statistic in the list to view the definition or edit any input.
11 Change the name of the statistic by unchecking Use default title and typing a

new name if desired..
12 Delete Columns removes a selected statistic.
13 To reorder the list click-drag a statistic to it's new location.
14 Click Generate Report when complete to generate a report for a

current (opened) .daf file.
A prompt appears to save the text file. This text file can be opened from Excel.

15 If you do not want to generate a report, click OK to save your changes and exit
the window.

16 The saved template can generate a statistics report for multiple data files by
selecting Generate Statistics Report from the Reports menu or during batch pro-
cessing.
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Generating a Statistics Report using .daf Files
Once a Statistics Definition has been created, the user can generate a statistics
report frommultiple .daf files. However, these files must use the same template.
Batch Processing can also generate a statistics report where statistics for each data
file will be generated either for .rif, .cif, or .daf files. Generating a statistics report
under the Reports menu simply adds the statistics template to the specified .daf
files.

ToGenerate a Statistics Report

1 Select Reports > Generate Statistics Report.
The current .daf file appears in the window with the specified statistics columns.

2 Pick a Report Definition. The definitionmay be obtained from a .daf or .ast file.
3 Change the Report title if desired.
4 Additional .daf files can be added or removed with the Add Files or Remove

Files buttons.
5 Reorder the files as desired by selecting files and then right-click the new loc-

ation in the list and choosemove here. You can Ctrl select multiple files in the
desired order and thenmove all at once by right-clicking in the desired location
and choosingmove here.

6 Click OK.
A prompt will confirm that the .daf file will be saved. The report title namewill be
used as the default file name for the report. In the above example, the file gen-
erated will be named “Report 1.txt”. If the report title contains illegal characters,
such as “\/><“ the default filenamewill change to “Statistics Report.txt”. Tab
delimited text format is used for the report.
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7 The report can be viewed in IDEAS by choosing View Statistics Reportt from
the Reports menu. The report can be copied to the clipboard and pasted into a
spreadsheet program or the .txt file can be opened using a spreadsheet program.
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Reporting Statistics from a Single Graph or Statistics Table
Statistics can also be reported directly from an open .daf from the graph or statistics
tables in the analysis area.

To export graph statistics to the Clipboard

• Right-click a graph and then click Export Statistics To Clipboard. They are
then available for pasting into a third party application.

To copy population statistics from a Statistics Table

• Right-click the table and then click Copy Statistics or Copy Statistics -
transposed. They are then available for pasting into a third party application.
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Exporting Data
You can export feature values for a population to the Clipboard, a text file, or a Flow
Cytometry Standard (FCS) file. You can export pixel intensity values for an object to
the Clipboard or a text file. Later, you can open or paste the FCS file into a spread-
sheet or other programs that uses the FCS file format. Keep inmind, however, that
limitations might exist on the number of values that these programs can import.

Exporting Feature Data
Exporting feature data is useful if you want to create an fcs file or graph the feature
data in a third party graphing application.

To export feature data

1 On the Tools menu, click Export Feature Values.
The Export Feature Data window appears.

2 Add files to the list on the left to export values for multiple files.
3 In the Select a population drop downmenu, select the population that you want.

If you haven’t defined any populations, All is the default. Tomake a new pop-
ulation, refer to Creating Tagged Populations.

4 In the Select feature values to export area, select features by clicking items in
the list or hold down the Ctrl while clicking to select multiple items.

5 Select the Export to option that you want. Note that data exported to the Clip-
board can be pasted directly into a spreadsheet program.

6 Select the Order by option that you want. Note that ordering by object causes
the values to be listed in a column, whereas ordering by feature causes the val-
ues to be listed in a row.

7 Click OK.
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Exporting Pixel Data
Exporting pixel data is useful when importing the data into third-party programs
where you would need to graph the individual pixels.

To export pixel data

1 On the Tools menu, click Export Image Pixel Values.
The Export Image Pixel Values window appears.

2 Select the object to export in the drop downmenu.
3 Select to Export to either the Clipboard or File.
4 Click OK.
5 Paste into desired application.
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Creating TIFs From Population for Export
The IDEAS application allows users to create separate TIF files for channel images
for every event in that population. The exported TIF files can be opened in image
viewing applications that support 8 bit tif format for display or 16 bit tif format for ana-
lysis.

To create TIFs From Population for Export

1 On the Tools menu, click Export .tif Images.
The Create TIFs From Population window appears.

2 Select the population and channels.
3 Type a prefix for the TIF file name.
4 Select the bit depth.
5 Select padded or raw.
6 Click OK.

A TIF file is created for every selected channel within the selected population.
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Printing Data
The IDEAS application provides color mapping from the dark mode that you see in
the Analysis Area to a light mode that has a white background for the printing and
exporting of data. Because the population colors might not show on a white back-
ground, you can change the colors when using the light mode.See Application
Defaults for more information.

To use light background graphs in the Analysis Area

• Click the graph background tool to switch between light or dark mode.

• SeeViewing and Changing the Application Defaults - colors tab to set the
color mapping desired.

To print the Analysis Area data

• Select Reports > Print Analysis Report.
The IDEAS application prints all the graphs, statistics, text panels, and
images that are displayed in the Analysis Area. In version 6.2 and later addi-
tional information has been added to the printed report to assist users in track-
ing changes that may have beenmade in the files. This includes laser
information, compensationmatrix and region coordinates.

To print the ImageGallery data

• Select Reports > Print Image Gallery.
The IDEAS application prints all the images that are visible in the Image
Gallery.
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To print an individual graph

1 Right-click the graph and then select Print Graph on the graph context menu.
The Print Graph window appears.

2 Select the checkboxes Graph, Statistics, Legend, Cursor, Show Sample
Name in Title to include the elements in the report.

3 If necessary, adjust the size scaling factor. Recomended setting is 100%.
4 Click OK to print the graph.
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Chapter 4: Features and Masks
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Understanding the IDEAS® Features and Masks
This section contains the following subsections, which describe the
features that the IDEAS application uses for data analysis:

See the following lists of base features:

Table of Base Features - Alphabetical

Table of Base Features- by Category

Table of Basic Features available for FlowSight without QI

Understanding the Size Features

Understanding the Location Features

Understanding the Shape Features

Understanding the Texture Features

Understanding the Signal Strength Features

Understanding the System Features

Understanding the Comparison Features

About Masks
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Overview of the IDEAS Features and Masks
Objects passing through an Amnis cell analysis system are illuminated in different
directions by lasers and/or brightfield LEDs. Light emitted from the object is focused
through an objective lens and relayed to a spectral decomposition element, which
divides the light into six spectral bands located side-by-side across a charge-
coupled detector (CCD), as shown in the following diagram. Therefore, each object
has six images that can be individually analyzed or, because they are in spatial
register with respect to one another, reconstructed. Each of the separate bands is
called a channel. Below is an example of collecting 6 images. The ImageStreamx
system has a second camera option which enables collection of up to 12 images per
object. The FlowSight system has 12 channels collection on 1 camera.

About Features
The IDEAS application provides a large selection of criteria, or features, for ana-
lyzing images. A feature is described by amathematical expression that contains
quantitative and positional information about the image. A feature is applied to spe-
cific locations of an image by the use of amask that identifies pixels within the
region of interest of the image. A few system features, such as Object Number,
Camera Background and Flow Speed, do not require calculations, masks, or image
intensity information.

There is a slight difference in features created during data acquisition and those in
IDEAS. During acquisition features are created with the INSPIRE mask. Features
andmasks are calculated in IDEAS for files collected with the ImageStream or a
FlowSight with the Quantitative Imaging (QI) upgrade.

New masks and features can be created in files from an ImageStream or FlowSight
with the QI upgrade using theMask and FeatureManager tools. Features are
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created in IDEAS using base feature algorithms,such as Area or Intensity along with
amask and/or a channel image for files created with an ImageStream or with the
QI upgraded FlowSight machine. The default masks are recomputed in IDEAS for
ImageStream or QI enabled files. Combined features can be created using existing
features in mathematical expressions in the FeatureManager.

IDEAS groups the features into eight categories: size, location, shape, texture, sig-
nal strength, comparison, system and combined.

For more information, seeOverview of theMask Manager

To calculate the value of a feature, the IDEAS applicationmaps the channel image
to X and Y coordinates, as illustrated by the following diagram. Each box in the dia-
gram represents a pixel.

The pixel size and field of view per channel is dependent on themagnification used.
See your INSPIRE Users Manual for more information.
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Features Categories

Size
Size features are in microns and include Area, Diameter, Length, Major Axis, Minor
Axis, Major Axis Intensity, Mnor Axis Intensity, Perimeter, Thickness Max andMin,
Spot AreaMin, Width and Height.

Location
Location features include Angle, Angle Intensity, Centroid X, Centroid Y, Centroid X
Intensity, Centroid Y Intensity, Delta Centroid X, Delta Centroid Y, Delta Centroid
XY, Max Contour position, Spot DistanceMin, Valley X and Valley Y.

Shape
Shape features define themask shape and have units that vary with the feature.
They include the Aspect Ratio, Aspect Ratio Intensity, Compactness, Elong-
atedness, Lobe Count, and Symmetry 2,3,4.

Texture
The Texture features determine local intensity variations in images and include
Bright Detail Intensity R3 and Bright Detail Intensity R7, Contrast, Gradient Max,
Gradient RMS, H Texture (H-Contrast, H-Correlation, H-Energy, H-Entropy, H-
Homogeneity, and H-Variance), Modulation, Spot Count, and Std Dev.

Contrast, Gradient Max andGradient RMS are generally used to determine best
focus.

Comparison
The Comparison features describe the difference of intensity measurements
betweenmasks or pixels in different images or the same image with different
masks. These include Bright Detail Colocalization 3, Bright Detail Similarity R3,
Intensity Concentration Ratio, Internalization, and Similarity.

System
The system features do not require amask.
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Table of Base Features - Alphabetical
Feature Name Category
Angle Feature Location
Angle Feature Location
Area Feature Size
Aspect Ratio Feature Shape
Aspect Ratio Intensity Feature Shape

BkgdMean Feature
Signal
Strength

Bkgd StdDev Feature
Signal
Strength

Bright Detail Colocalization 3 Comparison

Bright Detail Intensity R3 and Bright detail Intensity R7 Features
Signal
Strength

Bright Detail Similarity R3 Feature Comparison
Camera Line Number Feature System
Camera Timer Feature System
Centroid Features Location
Centroid Features Location
Circularity Feature Shape
Compactness Feature Shape
Contrast Feature Texture
Centroid Features Location
Centroid Features Location
Diameter Feature Size
Elongatedness Feature Shape
Elongatedness Feature Texture
Flow Speed Feature System
Gradient Max Feature Texture
Gradient RMS Feature Texture
Height Feature Size
H Texture Features Texture
Intensity Concentration Ratio Feature Comparison

Intensity Feature
Signal
Strength

Internalization Feature Comparison
Length Feature Size
Lobe Count Feature Shape
Major Axis andMinor Axis Features Size
Major Axis Intensity andMinor Axis Intensity Features Size
Max Contour Position Feature Location

Max Pixel Feature
Signal
Strength

Mean Pixel Feature Signal
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Feature Name Category
Strength

Median Pixel Feature
Signal
Strength

Min Pixel Feature
Signal
Strength

Minor Axis: seeMajor Axis Intensity andMinor Axis Intensity
Features

Size

Modulation Feature Texture
Object Number Feature System
Objects/ml Feature System
Objects/sec Feature System
Perimeter Feature Size
Spot Intensity Min and Spot Intensity Max Features Location

Raw Intensity Feature
Signal
Strength

Raw Max Pixel Feature
Signal
Strength

Raw Mean Pixel Feature
Signal
Strength

Raw Min Pixel Feature
Signal
Strength

Raw Median Pixel Feature
Signal
Strength

Saturation Count Feature
Signal
Strength

Saturation Percent Features
Signal
Strength

Shape Ratio Feature Shape
Similarity Feature Comparison
Similarity Feature Comparison
Spot AreaMin Feature Size
Spot Count Feature Texture
Spot DistanceMin Feature Location

Spot Intensity Min and Spot Intensity Max Features
Signal
Strength

Std Dev Feature Texture
Symmetry 2, 3, 4 Features Texture
Thickness Max Feature Size
Thickness Min Feature Size
Time Feature System
Valley X and Valley Y Features Location
Width Feature Size
XCorr Feature Comparison
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Table of Base Features- by Category

Feature
category Feature name In Default

Template?

In Expan-
ded Default
Template?

Mask_Image
Used in
Default Tem-
plate

Size Size-based Features are in microns.
Area Feature
The size of themask in squaremicrons. Yes Yes M01-M12,MC

Diameter Feature
Estimates the diameter of themask based on Area. No Yes M01-M12

Height Feature
Based on a bounding rectangle, theWidth is the
smaller side and the Height is the longer side of the
rectangle.

Yes Yes M01-M12

Length Feature
Measures the longest part of themask. Yes Yes M01-M12

Major Axis andMinor Axis Features
Describes the widest part of themask and the nar-
rowest part of themask, respectively.

No Yes M01-M12

Major Axis Intensity andMinor Axis Intensity
Features
Based on a bounding ellipse, theMinor Axis is the
narrow part and theMajor Axis is the widest part.

No Yes
M01_Ch01-
M12_Ch12

Minor Axis:Major Axis andMinor Axis Features No Yes M01-M12
Perimeter Feature
Describes circumference of themask. No Yes M01-M12

Spot AreaMin Feature
The Area of the smallest spot in themask. (See
also Spot DistanceMin Feature, Spot Intensity Min
and Spot Intensity Max Features and Spot Count
Feature.

No No

Thickness Max Feature
Describes the longest width of themask. No Yes M01-M12

Thickness Min Feature
Describes the shortest width of themask. No Yes M01-M12

Width Feature
Based on a bounding rectangle, theWidth is the
smaller side and the Height is the longer side of the
rectangle.

Yes Yes M01-M12

Location
Location Features are in X,Y pixel coordinates
from an origin in the upper left corner, pixels or
contour
Angle Feature
The angle of themajor axis from a horizontal plane
in radians.

No No

Angle Feature No No

Table 1: List of Features by category
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Feature
category Feature name In Default

Template?

In Expan-
ded Default
Template?

Mask_Image
Used in
Default Tem-
plate

The angle of themajor axis intensity from a hori-
zontal plane in radians.
Centroid Features
The central tendency of the pixels along the X Axis
and Y Axis, respectively.

No Yes M01-M12

Centroid Features
The central tendency of the pixels along the X Axis
and Y Axis, respectively, with the pixel intensities
weighted.

No Yes
M01_Ch01-
M12_Ch12

Centroid Features
The distance between the X or Y Centroids of two
images.

No No

Centroid Features
The distance between the Centroids of two images. No No

Max Contour Position Feature
The location of the contour in the cell that has the
highest intensity concentration.

No No

Spot DistanceMin Feature
The shortest distance between two components
(spots). See also Spot AreaMin Feature, Spot
Intensity Min and Spot Intensity Max Features and
Spot Count Feature.

Yes No

Valley X and Valley Y Features
The (X,Y) coordinates of theminimum intensity
within the skeletal lines that are used when creating
the Valley Mask.

No No

Shape
Shape Features define the mask shape and
have units that vary with the feature.
Aspect Ratio Feature
The ratio of theMinor Axis divided by theMajor
Axis.

Yes Yes M01-M12

Aspect Ratio Intensity Feature
The ratio of theMinor Axis Intensity divided by the
Major Axis Intensity.

Yes Yes
M01_Ch01-
M12_Ch12

Circularity Feature
The degree of themask’s deviation from a circle. No No

Describes the density of intensities within the
object.

No No

Elongatedness Feature
The ratio of the Height/Width which use the bound-
ing box.

No Yes M01-M12

Lobe Count Feature
The number of lobes in a cell. (Also see Symmetry) No No

Shape Ratio Feature No Yes M01-M12
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Feature
category Feature name In Default

Template?

In Expan-
ded Default
Template?

Mask_Image
Used in
Default Tem-
plate

The ratio of Thickness Min/Length features.
Symmetry 2, 3, 4 Features
These three features measure the tendency of the
object to have a single axis of elongation, a three-
fold and a four-fold variation of the shapes. See also
Lobe Count Feature.

No No

Texture
Texture features measure pixel or regional vari-
ation and indicate the granularity or complexity
of the image.
Bright Detail Intensity R3 and Bright detail Intensity
R7 Features
The Intensity of the pixels in the bright detail image
using a 3 or 7 pixel structuring element. Also, see
Spot Mask for a description of the bright detail
image.

Yes (R3)
No (R7) Yes

MC_Ch1-
MC_Ch6

Contrast Feature
Enumerates changes of pixel values in the image to
measure the focus quality of an image.

Yes Yes
M01_Ch01-
M12_Ch12

Gradient Max Feature
Themaximum slope of the pixel value changes in
the image tomeasure focus quality of an image.

No Yes
M01_Ch01-
M12_Ch12

Gradient RMS Feature
Enumerates changes of pixel values in the image to
measure the focus quality of an image.

Yes Yes
M01_Ch01-
M12_Ch12

H Texture Features
Measures Haralick texture features. No Yes

M01_Ch01_
5-M12_
Ch12_5

Modulation Feature
Measures the intensity range of an image, nor-
malized between 0 and 1.

Yes Yes
M01_Ch01-
M12_Ch12

Spot Count Feature
Enumerates the number of spots.
See also Spot DistanceMin Feature, Spot AreaMin
Feature, and Spot Intensity Min and Spot Intensity
Max Features.

No No

Std Dev Feature
Describes the overall distribution of pixel intens-
ities.

No Yes
M01_Ch01-
M12_Ch12

Signal
Strength

Signal Strength Features are measured in pixel
values.
BkgdMean Feature
The average intensity of the camera background. Yes Yes Ch01-Ch12

Bkgd StdDev Feature
The standard deviation of the background intens-
ities.

No Yes Ch01-Ch12
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Feature
category Feature name In Default

Template?

In Expan-
ded Default
Template?

Mask_Image
Used in
Default Tem-
plate

Intensity Feature
The sum of the pixel intensities in themask, back-
ground subtracted.

Yes Yes MC_Ch01-
MC_Ch12

Max Pixel Feature
The largest pixel value within themask, background
subtracted.

Yes Yes MC_Ch01-
MC_Ch12

Mean Pixel Feature
The average pixel value within themask, back-
ground subtracted.

Yes Yes M01_Ch01-
M12_Ch12

Median Pixel Feature
Themedian pixel value within themask, back-
ground subtracted.

Yes Yes M01_Ch01-
M12_Ch12

Min Pixel Feature
The smallest pixel value within themask, back-
ground subtracted.

No No

Raw Intensity Feature
The sum of the pixel intensities within themask. No No

Raw Max Pixel Feature
The largest pixel intensity. Yes Yes MC_Ch01-

MC_Ch12
Raw Mean Pixel Feature
The average pixel intensity: Raw does not have
background subtracted.

No No

Raw Median Pixel Feature
Themedian pixel intensity. No No

Raw Min Pixel Feature
The lowest pixel value within themask. Yes Yes MC_Ch01-

MC_Ch12
Saturation Count Feature
The number of pixels in themask that are saturated. Yes Yes M01_Ch01-

M12_Ch12
Saturation Percent Features
The Percentage of pixels in themask that are sat-
urated.

Yes Yes

Spot Intensity Min and Spot Intensity Max Features
The raw intensity (not background subtracted) of the
dimmest component (spot).
See also Spot Count Feature, Spot DistanceMin
Feature, and Spot AreaMin Feature.

No No

Comparison
Difference of intensity measurements between
masks or pixels.
Bright Detail Colocalization 3
Measures the colocalization of 3 image channels No No

Bright Detail Similarity R3 Feature
Measures the correlation of the bright details
between image pairs.

No No

Intensity Concentration Ratio Feature
Given twomasks, the ratio of the intensity in one No No
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Feature
category Feature name In Default

Template?

In Expan-
ded Default
Template?

Mask_Image
Used in
Default Tem-
plate

mask to the total intensity in bothmasks.
Internalization Feature
The ratio of the intensity inside the cell to the intens-
ity of the entire cell.

No No

Similarity Feature
The Similarity is ameasure of the degree to which
two images are linearly correlated pixel by pixel
within amasked region.

No No

XCorr Feature
The XCorr is ameasure of the degree to which two
images frequencies are cross correlated.

No No

System
System features do not require a mask and tend
to deal with system wide metrics.
Camera Line Number Feature
An incremental count of objects. No Yes

Camera Timer Feature
The clock rate in KHz. This is relative time. No Yes

Flow Speed Feature
The calculated flow speed inmm/sec. Yes Yes

Object Number Feature
The sequence of objects. Yes Yes

Objects/ml Feature
A local concentration of all objects per ml.
Note: to get objects per ml of a population, use the
statistic ‘Concentration’.

No Yes

Objects/sec Feature
A local concentration of number of objects per
second. Note: to get objects per ml of a population,
use the statistic ‘Concentration’

No Yes

Time Feature
The camera timer feature, converted to seconds. Yes Yes

Combined
Any combined feature will be listed under Com-
bined

No No
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Table of Basic Features available for FlowSight without QI
The default masks used for FlowSight Basic (non-QI) files is the INSPIRE mask.

Feature Mask_Channel Brief definition
Area M01-GM, MC The size of the mask in square microns.

Aspect Ratio M01-M12 The ratio of the Minor Axis divided by
the Major Axis.

Bkgd Mean Ch01-Ch12 The average intensity of the camera
background.

Bkgd StdDev Ch01-Ch12 The standard deviation of the back-
ground intensities.

Camera Line Num-
ber none An incremental count of objects.

Gradient RMS M01_Ch01-
M12_Ch12

Enumerates changes of pixel values in
the image to measure the focus quality
of an image.

Intensity MC_Ch01 - MC_
Ch12

The sum of the pixel intensities in the
mask, background subtracted.

Minor Axis M01-M12 Describes the narrowest part of the
mask.

Object Number none The sequence of objects.
Raw Centroid X

Raw Centroid Y
none

The central tendency of the pixels
along the X Axis and Y axis respect-
ively

Raw Max Pixel MC_Ch01- MC_
Ch12 The largest pixel value.

Raw Min Pixel MC_Ch01 - MC_
Ch12 The lowest pixel value.

Uncompensated
Intensity

MC_Ch01- MC_
Ch12

The sum of the pixel intensities in the
mask, background subtracted, no com-
pensation applied.

FlowSight Basic Features
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Understanding the Size Features
Size features are in microns and include Area, Diameter, Length, Major Axis, Minor
Asix, Major Axis Intensity, Minor Axis Intensity, Perimeter, Thickness Max andMin,
Spot AreaMin, Width and Height.
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Area Feature
The number of microns squared in amask is equal to the Area. In the following fig-
ure, a 1 symbolizes whether the area is included in themask. The number of pixels
is converted to µm2. Note that 1 pixel = 0.25 µm2. As an example, a cell with a
mask that includes 2000 pixels is therefore equal to 500 µm2.

Application Examples:

— Quantify and compare cell size.
— Identify single cells.
— Calculate the radius, diameter and volume of the cell.
— Identify apoptosis using the Area of the 30% thresholdmask of a nuclear

dye.
— Create a pseudo FSC va. SSC plot for comparing with flow cytometry.
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Diameter Feature
The Diameter feature provides the diameter of the circle that has the same area as
the object. The accuracy of the diameter is highly dependent on a close fittingmask
and roundness of the cell.

The images below depicts beads with a uniform diameter of 9microns.

In the next figure, note that images with longer shapes that have the same area will
have the same diameter value.

Application Example:

— Used to obtain approximate size of the cell.
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Height Feature
Using the bounding rectangle, Height is the number of microns of the longer side and
Width the shorter side. See also Elongatedness Feature.

Application Example:

— These features can be used to separate rectangular shaped objects. For
curved objects, measurement is more accurately obtained using the thick-
ness features.
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Length Feature
Lengthmeasures the longest part of an object. Unlike theMajor Axis feature, Length
canmeasure the object's length even if it folds to form a cashew, banana, or dough-
nut shape, where in many of these cases themajor or minor axis features would not
be able to differentiate these with true circular shaped objects with no hole.

This feature is based on an input mask and is sensitive to the variation of the input
mask shape. Selecting an input mask that can accurately capture the object shape
is important. See the Shape Ratio Feature, Table of Base Features- by Category ,
and Thickness Max Feature for more information.
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Major Axis and Minor Axis Features
TheMajor Axis is the longest dimension of an ellipse of best fit. TheMinor Axis is
the narrowest dimension of the ellipse of best fit. See the Aspect Ratio Feature for
more information.

Application Examples:

— Quantify and compare cell shape.
— Identify small, medium, and large cells.
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Major Axis Intensity and Minor Axis Intensity Features
TheMajor Axis Intensity is the longest dimension of an ellipse of best fit and is
intensity weighted. TheMinor Axis Intensity is the narrowest dimension of the
ellipse of best fit and is intensity weighted.

The figure below illustrates the difference between intensity weighted and non-intens-
ity weightedMajor or Minor Axis and Aspect Ratio. See the Aspect Ratio Intensity
Feature for more information.

Application Examples:

— Quantify and compare the image fluorescence shape.
— Identify single cells.
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Perimeter Feature
The perimeter featuremeasures the boundary length of themask in the number of
microns.

This example uses a 1-pixel widemask created to illustrate how a perimeter would
appear.

Application Examples:

— Quantify and compare cell circumference.
— Identify cells with highly irregular surfaces from smooth cells.
— Perimeter of themorphology or thresholdmasks can identify cells with or

without dendrites.
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Spot Area Min Feature
The Spot AreaMin feature provides the area of the smallest spot (connected com-
ponent) in a spot or peak mask.

This is one of four features that can be used to identify objects with spots that are
close together, dim, bright or small when counting spots in an image. To use these
features, the spots need to be individually masked, such as using the Spot or Peak
Mask. The Spot AreaMin, Spot DistanceMin, and Spot Intensity Min or Max fea-
tures measure properties of different spots in an image and are often used with the
Spot Count feature (under Texture). For more information see Spot DistanceMin
FeatureSpot Count FeatureSpot Intensity Min and Spot Intensity Max Features.

• Spot AreaMin is the Area of spot 1
• Spot DistanceMin is distance 2 inmicrons
• Spot Intensity Max is the Raw Mean Pixel of spot 2
• Spot Intensity Min is the Raw Mean Pixel value of spot 3

Application Example:

— In FISH Spot Counting, these features are used to identify objects with
ambiguous spots that are located too close together, are too dim to count
or are too small in order to remove these objects from the analysis.
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Thickness Max Feature
Thickness Max measures the largest width of an object. This feature is based on an
input mask and therefore sensitive to the variation of the input mask shape. Select-
ing an input mask that can accurately capture the object shape is important. See
also Table of Base Features- by Category , Length Feature and Shape Ratio Feature
for more information.
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Thickness Min Feature
Thickness Minmeasures the smallest width of an object. This feature is based on an
input mask and therefore sensitive to the variation of the input mask shape. Select-
ing an input mask that can accurately capture the object shape is important. See
also Thickness Max Feature, Length Feature and Shape Ratio Feature for more
information.
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Width Feature
Using the bounding rectangle, Width is the number of microns of the smaller side
and Height the longer side. See also Elongatedness Feature.

Application Example:

— These features can be used to separate rectangular shaped objects. For
curved objects, measurement is more accurately obtained using the thick-
ness features.
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Understanding the Location Features
Location features include Angle, Angle Intensity, Centroid X, Centroid Y, Centroid X
Intensity, Centroid Y Intensity, Delta Centroid X, Delta Centroid Y, Delta Centroid
XY, Max Contour position, Spot DistanceMin, Valley X and Valley Y.
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Angle Feature
Angle is the angle of themajor axis from a horizontal plane in radians.

Application Example:

— Identify the orientation of an image relative to the image frame.

Angle Intensity Feature
Angle Intensity is the angle of themajor axis intensity from a horizontal plane in radi-
ans.

Application Example:

— Identify the orientation of an image relative to the image frame.
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Centroid Features

Centroid X and Centroid Y Features

Centroid X is the number of pixels in the horizontal axis from the upper, left corner of
the image to the center of themask. Centroid Y is the number of pixels in the vertical
axis from the upper, left corner of the image to the center of themask.

In this example, the Centroid X=54 and the Centroid Y=32.

Application Examples:

— Identify the center of themask.
— Calculate the Delta Centroid or the distance between two fluorescent

markers.
— Used by IDEAS to calculate the Delta Centroid X, Y, or XY.

Centroid X Intensity and Centroid Y Intensity Features
Centroid X Intensity is the intensity weighted X centroid and is shifted from the cen-
ter of themask toward the center of fluorescence. The Centroid Y Intensity is the
intensity weighted Y centroid. X and Y pixel coordinates are calculated from an origin
in the upper left corner.
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Application Examples:

— Identify the center of peak fluorescence.
— Calculate the distance between two fluorescent markers.
— Used by IDEAS to calculate the intensity weighted Delta Centroid X, Y or

XY.

Delta Centroid X and Delta Centroid Y Features
Both the Delta Centroid X and Y features measure the distance between the Cen-
troids X or Centroids Y, respectively, of two images using the user-providedmasks
for each image. Either one or both the centroids of the images may be intensity-
weighted. X and Y pixel coordinates are calculated from an origin in the upper left
corner to obtain the centroid positions and the distance between the centroids is con-
verted tomicrons.
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An example is shown below.

The graph below illustrates using the Delta Centroid X versus Delta Centroid Y to
identify cells with a variation of location of a protein with respect to the nucleus.

Cells with no spatial shift of signal between the nuclear stain(Ch6) and protein of
interest(Ch4) have a low Delta Centroid X and Y and are found in the lower left
corner. Cells with a large shift between the images in both the X and Y direction are
found in the upper, right section and those with a large shift in X but not Y are found
in the lower, right. Similarly a cell with a large shift in the Y direction and not X are
found in the upper, left. See Delta Centroid XY Feature tomeasure the X and Y shift
together.
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Application Example:

— Used to identify capped versus not capped cells.
— Used tomeasure shifts in X or Y direction between two images.

Delta Centroid XY Feature
The Delta Centroid XY featuremeasures the distance between the Centroid feature
of two images using the user-providedmasks for each image. Either one or both the
centroids of the images may be intensity-weighted. X and Y pixel coordinates are cal-
culated from an origin in the upper left corner to obtain the centroid positions and the
distance between the centroids is converted tomicrons. In the example, below an
image pair is shown stained with the nuclear dye Draq 5 and a PE labeled antibody
that is differentially expressed two cells, either uniformly or in the pseudopod. The
two cells are identified by their different Delta Centroid XY values.

- 199 -



Chapter 4

Below is an example of using the Delta Centroid XY. A bivariate graph of a shape
ratio versus Delta Centroid XY can identify cells with caps as shown here:

Application Examples:

— Quantify the spatial relationship between two fluorescent probes.

- 200 -



Understanding the Location Features

— Identify false apoptotic positive cells in the TUNEL and Annexin V
assays.

— Quantify shape change.
— Quantify capping of cell surface antigens.

Raw Centroid X and Raw Centroid Y Features
The centroid X and Y of the original position of the image during acquisition before it
was centered IDEAS. Data analyzed in IDEAS versions 4.0 or later cut and center
objects that were collected as one image in INSPIRE.
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Max Contour Position Feature
TheMax Contour Position is defined as the location of the contour in the cell that has
the highest intensity concentration. It is invariant to object size and can accom-
modate localized intensity concentrations. The actual location in the object is
mapped to a number between 0 and 1, with 0 being the object center and 1 being the
object perimeter, which allows one to compare the results across cells of different
sizes. An example is shown below.

Application Example:

— Used in conjunction with the Internalization feature to determine the dis-
tribution of intensity within a cell.
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Shift X and Shift Y Features
The Shift X or Shift Y feature is the location of the highest cross-correlation of a pair
of images. When two identical images are aligned perfectly the cross-correlation is
at it's maximum. The shift X or Shift Y is the shift required to get the highest cross-
correlation value for the 2 images. This feature is usedmainly for troubleshooting
cross-camera alignment.
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Spot Distance Min Feature
The Spot DistanceMin feature provides the shortest distance inmicrons between
two spots (connected components) in a spot or peak mask.

This is one of four features that can be used to identify objects with spots that are
close together, dim, bright or small when counting spots in an image. To use these
features, the spots need to be individually masked, such as using the Spot or Peak
Mask. The Spot Area, Distance, and Spopt Intensity Min or Max features measure
properties of different spots in an image and are often used with the Spot Count fea-
ture (under Texture). For more information see Spot AreaMin Feature; Spot Count
Feature; Spot Intensity Min and Spot Intensity Max Features.

• Spot AreaMin is the Area of spot 1
• Spot DistanceMin is distance 2 inmicrons
• Spot Intensity Max is the Raw Mean Pixel of spot 2
• Spot Intensity Min is the Raw Mean Pixel value of spot 3

Application Example:

— In FISH Spot Counting, these features are used to identify ambiguous
spots that are located too close together, too dim, to bright or too small to
count and can be eliminated from the analysis.
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Valley X and Valley Y Features
The Valley X and Y are the exact X,Y coordinates of theminimum intensity within
the skeletal lines of the input mask. The objects condensed shape, typically 1-pixel
wide skeletal line is determined from the startingmask. This is also the origin of the
Valley mask. See Valley Mask and SkeletonMask.

In the figure below, the Valley X and Valley Y position of the 7AAD image is shown.
In this example a protein of interest in the PE image localizes to the synapse
between two cells.

These features define the origin of the Valley mask.
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Application Example:

— Measure the exact center of where a synapse between two cells is loc-
ated.
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Understanding the Shape Features
Shape features define themask shape and have units that vary with the feature.
They include the Aspect Ratio, Aspect Ratio Intensity, Compactness, Elong-
atedness, Lobe Count, and Symmetry 2,3,4.
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Aspect Ratio Feature
Aspect Ratio is theMinor Axis divided by theMajor Axis and describes how round or
oblong an object is. See also: Major Axis andMinor Axis Features.

See also Elongatedness Feature and Shape Ratio Feature for other shape ratios.

Application Examples:

— Quantify the roundness of themask.
— Identify single cells vs. doublets.
— Cell classification based on shape change.
— Identify recently divided cells in mitosis.
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Aspect Ratio Intensity Feature
Aspect Ratio Intensity is theMinor Axis Intensity divided by theMajor Axis Intens-
ity. See also: Major Axis Intensity andMinor Axis Intensity Features.

The figure below illustrates the difference between Aspect Ratio Intensity and
Aspect Ratio. See also: Aspect Ratio Feature.

Application Examples:

— Quantify the roundness of the fluorescent image.
— Better resolution for identifying single cells vs. doublets in experiments

using a DNA dye.
— Cell classification based on fluorescent morphology.
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Circularity Feature
This featuremeasures the degree of themask’s deviation from a circle. Its meas-
urement is based on the average distance of the object boundary from its center
divided by the variation of this distance. Thus, the closer the object to a circle, the
smaller the variation and therefore the feature value will be high. Vice versa, the
more the shape deviates from a circle, the higher the variation and therefore the Cir-
cularity value will be low. See also .

Below is an example using Circularity and Compactness to characterize the shape
of peripheral bloodmononuclear cells stained with the DNA dye Draq 5.
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Application Examples:

— Distinguish singlets and doublets.
— Separate circular and non circular shapes.
— Used in the Shape ChangeWizard
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Compactness Feature
Compactness measures the degree of how well the object is packed together. This
feature is similar to the Circularity feature but unlike Circularity, this feature includes
all of the pixels within themask and is intensity weighted. The higher the value, the
more condensed the object.

Below is an example using Circularity and Compactness to characterize the shape
of peripheral bloodmononuclear cells stained with the DNA dye Draq 5.

Application Example:

— Differentiate between rounded objects with smooth boundary to less reg-
ular objects.
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Elongatedness Feature
Elongatedness is the ratio of the Height overWidth of the object’s bounding box.
See alsoWidth Feature.

See also Aspect Ratio Feature and Shape Ratio Feature for other shape ratios.

Application Examples:

— Measure object shape properties to differentiate between long and narrow
versus short and thick objects.

— Quantify the roundness of themorphology mask.
— Identify single cells and doublets.
— Cell classification based on shape change.
— Identify recently divided cells in mitosis.
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Lobe Count Feature
The Lobe Count feature counts the number of lobes in a cell. It is determined based
on themaxima of the weighted Symmetry features. The feature reports the values
1,2,3 or 4. If an object does not have a high value for Symmetry 2, Symmetry 3, or
Symmetry 4 it is reported as 1 for no lobes. An example is shown below. See also
Symmetry 2, 3, 4 Features.

Application Example:

— Used in cell classification studies. Also used to differentiate small round
cells from small square cells of similar area.
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Shape Ratio Feature
The Shape Ratio is Thickness Min divided by Length.

The Shape Ratio feature is based on an input mask and is sensitive to the variation
of the input mask shape. Selecting an input mask that can accurately capture the
object shape is important.

See also Aspect Ratio Feature and Elongatedness Feature for other shape ratios.

Application Example:

— Measure object's elongatedness to provide shape classification.
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Symmetry 2, 3, 4 Features
The Symmetry 2 featuremeasures the tendency of the object to have a single axis
of elongation and therefore 2 lobes. The Symmetry 3 featuremeasures the tendency
of the object to have a three-fold axis of symmetry and likewise, Symmetry 4 a four-
fold axis. The absolute value of these features are dependent on the number of
lobes. For example an image that has high 4 lobe symmetry will also have high 2
lobe symmetry. See the Lobe Count Feature for more information.

Application Example:

— Classify different white blood cells based on themorphology of the nuclear
image.
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Understanding the Texture Features
The Texture features determine local intensity variations in images and include
Bright Detail Intensity R3 and Bright Detail Intensity R7, Contrast, Gradient Max,
Gradient RMS, H Texture (H-Contrast, H-Correlation, H-Energy, H-Entropy, H-
Homogeneity, and H-Variance), Modulation, Spot Count, and Std Dev.

Contrast, Gradient Max andGradient RMS are generally used to determine best
focus.
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Bright Detail Intensity R3 and Bright detail Intensity R7
Features

The Bright Detail Intensity R3 and Bright Detail Intensity R7 features compute the
intensity of localized bright spots within themasked area in the image. Bright Detail
Intensity R3 computes the intensity of bright spots that are 3 pixels in radius or less,
while Bright Detail Intensity R7 computes the intensity of bright spots in the image
that are 7 pixels in radius or less. In each case, the local background around the
spots is removed before the intensity computation.

The figure below shows the process of obtaining the localized bright spots in the
image.

The graph below illustrates the use of the Bright Detail Intensity R3 feature on a nuc-
lear image to separate apoptotic cells from non-apoptotic cells.
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Application Example:

— Identify cells that have bright specks such as Apoptotic cells.

— Used in the Cell Cycle - Mitosis Wizard.
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Contrast Feature
The Contrast featuremeasures the sharpness quality of an image by detecting large
changes of pixel values in the image and is useful for the selection of focused
objects or apoptotic brightfield images. For every pixel, the slopes of the pixel intens-
ities are computed using the 3x3 block around the pixel. This is similar to the Gradi-
ent RMS calculation with different weighted assignments to the pixel arrays with no
background subtraction. Example images are shown in the figure below.

Application Examples:

— Find apoptotic images with high contrast in brightfield imagery.
— Determine overall focus quality of images.
— Use with Gradient RMS to determine focus quality.
— Characterize texture.

See also: Gradient Max Feature andGradient RMS Feature.
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Ensquared Energy Feature
The Ensquared Energy feature is ameasure of image quality. Computes the intens-
ity of the square block around the brightest pixel using the diameter input as the side
for the square divided by the intensity of the total intensity. The closer this ratio is to
1.0 the better focused the image. This feature is mainly used for single, uniform
particles such as beads.

The figure below shows the image quality test using the Ensquared Energy feature.
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Gradient Max Feature
TheGradient Max featuremeasures the sharpness quality of an image by detecting
largest change of pixel values in the image and is useful for the selection of focused
objects.

This figure shows the change in intensity across the red line. The top image has a lar-
ger slope change than the lower image.

Application Example:

— Determine peak focus quality of images.
— Also used to characterize texture. However, the Gradient RMS and Con-

trast feature aremore robust for these applications.

See also: Gradient RMS Feature and Contrast Feature.
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Gradient RMS Feature
TheGradient RMS featuremeasures the sharpness quality of an image by detecting
large changes of pixel values in the image and is useful for the selection of focused
objects. TheGradient RMS feature is computed using the average gradient of a pixel
normalized for variations in intensity levels. This is similar to the Contrast cal-
culation with different weighted assignments to the pixel arrays and with background
subtracted. Example images are shown in the figure below.

Application Examples:

— Determine overall focus quality of images.
— Used with Contrast to determine focus quality.
— Characterize texture.

See also: Gradient Max Feature and Contrast Feature.
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H Texture Features
H Texture features include the following: H Energy Mean and Std, H Entropy Mean
and Std, H Contrast Mean and Std, H Homogeneity Mean and Std, H Correlation
Mean and Std, H VarianceMean and Std Features.

The user defines the texture grain by assigning a granularity value. For very fine tex-
tures, this value is small (1-3 pixels), while for very coarse textures, it is large (>10).
In the IDEAS default template, the granularity value is 5.

While these features have value for distinguishing cellular texture when used indi-
vidually, images often contain amixture of different textures at different grains.
Therefore, these features aremost powerful when combined.

Texture features are used to determine if pixel values in an image follow a pattern or
are randomly distributed. An image with random greyscale values might look like a
grey color swatch with individual pixel values ranging from themin to themax cen-
tering on amean. If light and/or dark patterns are visible, it means the pixel values
are not randomly distributed and some texture has emerged. So texture features can
be thought of as measuring the presence or absence of randomness. If pixel values
are non-random, then defined patterns are likely to be present in the image. Patterns
in the imagemay be biologically significant, such as the clustering of LC3 proteins
from a random distribution in the cytoplasm as cells enter autophagy, or formation of
H2AX clusters in DNA damage and repair studies.

The Haralick texture features are a set of texture features based on the 2nd order
statistics computed from the joint 2-D probability distribution of pixel intensities in
the image. This distribution is referred to as the Gray Level Co-occurrenceMatrix
(GLCM). To understand how this matrix works, consider the outcome of two dice
thrown on a table. The probability matrix in this case is 6 possible outcomes from the
first die and 6 from the second, or 36 possible combinations. There are 6 possible
doubles and the odds of rolling them are 6/36 or 16.7%. To analyze the texture of
images, a similar probability matrix can be used to determine if pixels in a given
neighborhood occur randomly or (like the toss of two dice) are somewhat pre-
dictable. If pixels in an image have a high level of co-occurrence, then there is likely
some sort of detectable pattern.

Texture features in IDEAS are calculated in a four step process by first converting
the pixel data to 8 bits, then applying the granularity to calculate the GLCM, next
computing the 6 Haralick texture features and finally outputting themean and stand-
ard deviation for each of the 6 texture features.
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The first step in the three step process is to convert the raw 12 bit image under the
boundingmask into a 4 bit image. This is done so that the GLCM does not have too
many 0 entries which will ensure amore robust estimate of the texture and reduce
the noise. This effectively bins the raw data into 2^4 or 16 bins with resulting values
between 0 and 15. For full range images that have pixel values between 0 and 4096
this would bin pixels by 16/4096 or 256 counts, such that pixels between 4096 and
3840 would be assigned a value of 15, pixels between 3840 and 3584 would be
assigned 14, and so on.

Second the granularity is applied to the feature to calculate the GLCM. In IDEAS the
granularity defines the distance from the anchor pixel to the pixel array used to cal-
culate the texture features. A granularity of 1 would pair the anchor pixel with those 1
pixel above, below, right, left and on the angles. The default granularity in IDEAS is
set to 5 and for 40x imagery this wouldmean the texture features are comparing
pixel pairs 2.5um away from the anchor pixel

Next the GLCM is calculated by comparing neighboring pixel values and calculating
how uniform or variant those values are. TheGLCM is a function of the texture gran-
ularity d and orientation,q. The entry pij in the ith row and jth column of the GLCM
matrix is defined as the probability of having pixel pairs in the image with intensities
{i,j} at a distance d from each other along an orientationq. Thus, the GLCM is an N x
N matrix, where N is determined by the range of intensities in the cell. For very fine
textures, granularity d is typically very small – about 1-2 pixels. For medium textures,
d is about 4-8. For very coarse textures, d can be very large, about 12-16 pixels. The
specific value of the orientationqis less important in our applications since we are
not interested in the actual orientation of the texture, but only if orientation exists. For
this reason, we compute the GLCM for a number of orientations {0, 45, 90, 135, 180,
225, 270, 315 degrees}. Assuming symmetry in orientation, we combine the ori-
entations (0,180), (90,270), (45,225) and (135,315) to obtain 4 separatematrices.

Finally themean and standard deviation (std) of each texture feature are calculated
where themean is the average value at each of the four orientations theta, and the
standard deviation is the variation of those values. Themean texture values are
good indicators of the average texture in the cell, while the standard deviations are
good indicators of orientation in the texture. Large standard deviation values indicate
that some directions have very different textures from other directions.

Texture features have been useful for analyzing changes in staining patters for
applications like LC3 clustering in cells progressing through autophagy, H2Ax foci
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formation in DNA damage and repair studies, nuclear condensation and frag-
mentation in apoptotic assays, changes inmitochondrial membrane potential and
other applications where a given treatment induces changes in a fluorochromes pat-
tern of staining. For amore detailed description of the Haralick features see the
paper referenced below.

1Haralick, R.M., K. Shanmugan, and I. Dinstein, "Textural Features for Image Clas-
sification", IEEE Transactions on Systems, Man, and Cybernetics, Vol. SMC-3,
1973, pp. 610-621.

Contrast measures the intensity variation in a cell. A highmean value indicates that
neighboring pixels tend to have very different intensity values, and would describe
an image with lots of adjacent light and dark areas. Contrast will range between 0
and 1.
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Correlation measures how similar pixel pairs are, and is the opposite of contrast.
Images with high correlation will be very uniform and lack variant texture.
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Energy is ameasure of intensity concentration in the cell. At one extreme is the
case where we have a uniform distribution with all probabilities being equal. This
image likely has several intensity variations with no noticeable concentration of high
intensity and thus has low energy. At the other extreme is the case where we have a
very narrow distribution with a few elements having high values. This image will
have notable intensity concentrations and thus, has high energy.
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Entropy is also ameasure of high intensity concentration in the cell. However, this
feature relates to the randomness of the intensities in the image. Images that have
distinct areas of intensity concentration are less random and thus, have low entropy.
Images that have a range of equally likely intensity pairings have less distinct intens-
ity concentrations, and correspondingly, have higher entropy. Entropy is the oppos-
ite of energy.
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Homogeneity is ameasure of how close pixels value are, if pixel pairs are the same
or similar then a high homogeneity value is given. If there are very few pixels with the
same value, then a lower homogeneity score is generated. Images with high homo-
geneity would look very uniform and lack texture. Homogeneity is the inverse of con-
trast and very similar to correlation.
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Variance measures the spread of pixel values within the granularity. Images with
high variance values will have a large spread in pixel intensities visually identified by
very dark and very bright spots throughout the image.

Application Example:

— Quantify texture in cells.

1Haralick, R.M., K. Shanmugan, and I. Dinstein, "Textural Features for Image Clas-
sification", IEEE Transactions on Systems, Man, and Cybernetics, Vol. SMC-3,
1973, pp. 610-621.
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Modulation Feature
TheModulation featuremeasures the intensity range of an image, normalized
between 0 and 1.

The formula is: Modulation = Max Pixel - Min Pixel / Max Pixel + Min Pixel

The following example illustrates Modulation on brightfield images and Intensity of
scatter in channel 1.

HighModulation

Low Modulation

Low Modulation

Application Example:

— Quantify image quality and characterize contrast and texture in cells.
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Spot Count Feature
The Spot Count feature provides the number of connected components in an image.
The connected component algorithm examines the connectivity of each pixel based
on whether this pixel is connected to a particular spot or the background. In order to
count the number of connected components themask input is very important. See
Spot Mask, Peak Mask, and RangeMask for information onmasking spots. See
also Spot AreaMin Feature, Spot DistanceMin Feature, andSpot Intensity Min and
Spot Intensity Max Features for more information.

The following figure illustrates the application of Spot Counting to quantify parasitic
infection of Babesia in erythrocytes by staining nuclei with YOYO (green).

Connectivity Option

The spot count feature offers a choice of 4 or 8 connectivity for the connected com-
ponents algorithm. This option determines how a component is defined based on con-
nected pixels.
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The default selection, 4-connectivity (left), only considers neighbor pixels oriented
vertically or horizontally from the pixel of interest. Pixels are included in the com-
ponent if the are touching on the diagonal when the option eight is chosen.

Application Examples:

— Counting parasites.
— Counting phagocytosed particles.
— FISH spot counting.
— Counting punctate spots in images.
— Used in the Spot Wizard.
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Std Dev Feature
The Std Dev feature describes the overall distribution of pixel intensities.

The Std Dev is the standard deviation of the pixel intensity values in themask. The
Std Dev value provides an indication of the texture or complexity of an object.

The following illustrates that apoptotic cells (AnxnV positive) exhibit higher Std Dev
values in the darkfield channel (scatter) and higher brightfield Modulation values than
non-apoptotic cells (AnxnV negative).

Application Example:

— Quantify intensity variation within amask.
— Distinguish apoptotic and necrotic cells.
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Understanding the Signal Strength Features
Signal Strength features include the following:

• BkgdMean and Bkgd StdDev features describe the background of the image.
• Intensity and Raw Intensity features quantify the intensities in the region of

interest.
• Raw Max, Raw Min, Raw Mean and Raw Median Pixel report single pixel val-

ues in an image.
• Max, Min, Mean andMedian Pixel report background subtracted single pixel

values in an image.
• Saturation Count and Saturation Percent quantify the saturated pixels.
• Spot Intensity Min is used when counting spots.

Note that when the name includes ‘Raw’, this means that there is no background
subtraction.
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Bkgd Mean Feature
The BkgdMean feature estimates the average camera background level in an image
by taking themean of the background pixels.

Application Examples:

— Obtain estimate of themean camera background level.
— Compute background-subtracted pixel values in other feature com-

putations.
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Bkgd StdDev Feature
The Bkgd Std Dev feature estimates the standard deviation of the camera back-
ground level in an image computed using the background pixels.

Application Example:

— Obtain estimate of the camera background noise.
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Intensity Feature
The Intensity feature is the sum of the background subtracted pixel values within the
masked area of the image.

Application Examples:

— Quantify relative levels of fluorescence between cells and within different
regions of the same cell.

— Immunophenotyping.
— Cell cycle analysis.
— Protein expression.
— Protein activation.
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Max Pixel Feature
TheMax Pixel feature is the largest value of the background-subtracted pixels con-
tained in the input mask. An example plot is shown below that demonstrates the
advantage of using this feature over the Intensity feature for identifying true positive
events. For a concentrated signal, Max Pixel is more sensitive than Intensity as
shown in the figure below.

The relationship of Max, Mean, Median, andMin Pixel is shown in the figure below:

Application Examples:

— Used to estimate the true peak fluorescence activity. Is preferred over the
Raw Max Pixel for this application.
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— Max Pixel to Mean Pixel ratio identifies bright punctate staining vs. uni-
form staining.
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Mean Pixel Feature
TheMean Pixel feature is themean of the background-subtracted pixels contained in
the input mask. This is computed as Intensity/number of pixels.

The relationship of Max, Mean, Median andMin Pixel is shown in the figure below:

Application Examples:

— Estimate the average fluorescence activity. This feature is preferred over
the Raw Mean Pixel feature.

— Quantify relative levels of mean fluorescence between cells.
— Identify bright punctate spots by calculating themax tomean pixel ratio.
— Track internalization of surface bound antibodies.
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Median Pixel Feature
TheMedian Pixel feature is themedian of the background-subtracted pixels con-
tained in the input mask. It is more robust than themean as an estimate of the aver-
age fluorescence since it is less influenced by outliers.

The relationship of Max, Mean, Median andMin Pixel is shown in the figure below:

Application Example:

— Estimate the average fluorescence activity. This feature is preferred over
the Raw Median Pixel feature.
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Min Pixel Feature
TheMin Pixel feature is the smallest value of the background-subtracted pixels con-
tained in the input mask. There will be some negative numbers due to the back-
ground subtraction, therefore the Raw Min Pixel feature is preferred.

Application Examples:

— Obtain theminimum value in an image after background subtraction. Very
likely to be negative in brightfield imagery.

— Quantify spectral absorbance using the brightfield image.
— Identify over compensated images.
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Raw Intensity Feature
The Raw Intensity feature is the sum of the pixel values within themask including
camera background.

Application Example:

— Estimate raw fluorescence activity. This feature is less relevant than the
Intensity feature because it includes camera background intensity.
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RawMax Pixel Feature
The Raw Max Pixel feature is the largest value of the pixels contained in the input
mask.

Application Examples:

— Determine the presence of saturated events.
— May also be used to estimate the peak fluorescence activity, though the

Max Pixel feature is recommended for this application.
— Measure themaximum pixel value within themask.
— Identify cells that saturate the CCD, Saturation Count feature can also be

used for this application.

- 246 -



Understanding the Signal Strength Features

RawMean Pixel Feature
The Raw Mean Pixel feature is themean of the pixels contained in the input mask.
This is computed as Raw Intensity/number of pixels.

Application Example:

— Estimate the raw average fluorescence activity. This feature is less rel-
evant that theMean Pixel feature.
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RawMedian Pixel Feature
The Raw Median Pixel feature is themedian of the pixels contained in the input
mask.

Application Example:

— Estimate the raw average fluorescence activity that is robust to outliers.
This feature is less relevant than theMedian Pixel feature.
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RawMin Pixel Feature
The Raw Min Pixel feature is the smallest value of the pixels contained in the input
mask. The example below illustrates quantifying the level of malarial infected cells
by usingMin Pixel values of brightfield imagery.

Application Example:

— Quantify spectral absorbance using the brightfield image.
— Identify over compensated images.
— Measure the level of malaria infection in RBCs.
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Saturation Count Feature
The Saturation Count feature reports the number of saturated pixels in an object.
See also Saturation Percent Features.

In the figure below, objects with saturated pixels are lined up at the Raw Max Pixel
value of 4095 and a selected image is shownwith saturated pixels in red.

Application Example:

— Measure the validity of the experiment setup. Saturated datamay not pro-
duce useful information.
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Saturation Percent Features
The Saturation Percent feature reports the percentage of saturated pixels in an
image. Pixel intensities aremeasured on the camera pixels from 0 to 4095 (12 bit)
and therefore become saturated and cannot be quantified after 4095. See also Sat-
uration Count Feature.

An object with saturated pixels shown in red:

Application Example:

— Measure the validity of the experiment setup. Saturated datamay not pro-
duce useful information.
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Spot Intensity Min and Spot Intensity Max Features
Spot Intensity Min provides the smallest Raw Mean Pixel value (not background sub-
tracted) of the dimmest spot (connected component). The Raw Mean Pixel values
for each spot is computed and the smallest value is reported.

Spot Intensity Max provides the largest Raw Mean Pixel value (not background sub-
tracted) of the brightest spot (connected component). The Raw Mean Pixel values
for each spot is computed and the largest value is reported.

These are two of four features that can be used to identify objects with spots that are
close together, dim, bright or small when counting spots in an image. To use these
features, the spots need to be individually masked, such as using the Spot or Peak
Mask. The Spot Area, Distance, and Intensity Min or Max features measure prop-
erties of different spots in an image and are often used with the Spot Count feature
(under Texture). Spot AreaMin (Size) provides the area of the smallest spot. Spot
DistanceMin (Location) provides the shortest distance between two spots. See also
Spot AreaMin Feature, Spot DistanceMin Feature, and Spot Count Feature.

The following diagram illustrates these features:

• Spot AreaMin is the Area of spot 1
• Spot DistanceMin is distance 2 inmicrons
• Spot Intensity Max is the Raw Mean Pixel value of spot 2
• Spot Intensity Min is the Raw Mean Pixel value of spot 3

Application Example:

— In FISH Spot Counting, these features are used to identify ambiguous
spots that are located too close together, too dim, to bright or too small to
count and can be eliminated from the analysis.
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Uncompensated Intensity
The Uncompensated Intensity feature is the sum of the background subtracted pixel
values within themasked area of the image with no compensation applied. This is
the Intensity of the uncompensated image. This feature is calculated in INSPIRE
during acquisition.
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Understanding the Comparison Features
The Comparison features describe the difference of intensity measurements
betweenmasks or pixels in different images or the same image with different
masks. These include Bright Detail Similarity R3, Intensity Concentration Ratio,
Internalization, and Similarity.
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Bright Detail Colocalization 3
Delete this text and replace it with your own content.
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Bright Detail Similarity R3 Feature
The Bright Detail Similarity R3 feature is designed to specifically to compare the
small bright image detail of two images and can be used to quantify the co-loc-
alization of two probes in a defined region, such as that of endosomes. The Bright
Detail Similarity R3 feature is the log transformed Pearson’s correlation coefficient
of the localized bright spots with a radius of 3 pixels or less within themasked area
in the two input images. Since the bright spots in the two images are either cor-
related (in the same spatial location) or uncorrelated (in different spatial locations),
the correlation coefficient varies between 0 (uncorrelated) and 1 (perfect correlation),
and does not assume negative values. The coefficient is log transformed to increase
the dynamic range between {0, inf}.

The following figure shows the Bright Detail Similarity R3 graph of two populations,
one that has colocalization and one that has no colocalization.

The figure below illustrates the process of obtaining the localized bright spots. The
bright areas are eroded from the original image and the detail eroded image is sub-
tracted from the original image resulting in the bright detail image.
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The figure below shows the correlation analysis between an image pair.

Application Examples:

— Quantify the degree of colocalization between two probes.
— Track internalization and intracellular trafficking of antibody drug con-

jugates to either the endosomes or the lysosomes.
— Colocalization of Rituxan and compliment C3b.
— Used in the Co-localizationWizard
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Intensity Concentration Ratio Feature
The intensity concentration ratio is defined as the ratio of the intensity inside the first
input mask to the intensity of the union of the twomasks - the higher the score, the
greater the concentration of intensity inside the first mask. All pixels are background-
subtracted. The ratio is invariant to cell size and can accommodate concentrated
bright regions and small dim spots. The ratio is mapped to a log scale to increase the
dynamic range to values between {-inf, inf}. This feature is a generalization of the
Internalization feature. See Internalization Feature for more information.

Application Example:

— Quantify relative intensity concentrations between different cellular com-
partments. Internalization is a special case of this where the first mask is
the internal compartment and the second is themembrane region.

- 258 -



Understanding the Comparison Features

Internalization Feature
The Internalization feature is defined as the ratio of the intensity inside the cell to the
intensity of the entire cell. The higher the score, the greater the concentration of
intensity inside the cell. All pixels are background-subtracted. The user must create
amask to define the inside of the cell for this feature (see About Masks andOver-
view of theMask Manager). The feature is invariant to cell size and can accom-
modate concentrated bright regions and small dim spots. The ratio is mapped to a
log scale to increase the dynamic range to values between {-inf, inf}. Internalized
cells typically have positive scores while cells with little internalization have neg-
ative scores. Cells with scores around 0 have amix of internalization andmembrane
intensity.

Composite Images of brightfield and channel 6 are shown for High, Medium, and
Low Internalization values.

Application Examples:

— Quantify internalization when supplied with the internal mask.
— Quantify the intensity ratio of a region of interest to the whole cell.
— Used in the InternalizationWizard.
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Similarity Feature
The Similarity feature is the log transformed Pearson’s Correlation Coefficient and is
ameasure of the degree to which two images are linearly correlated within amasked
region.

The following figure shows two image pairs that are in spatial registry to one another.
On the left the NF-kB (green) is predominantly located in the cytoplasm of the cell
and has a dissimilar distribution compared to the 7-AAD image (red). When the
intensity of the green is high, the intensity of the red is low and vice versa. The Sim-
ilarity value for this cell is -2.067 indicating that the image pair has a high degree of
dissimilarity. Analysis of the image pair on the right shows that when the intensity of
the green is high, the intensity of the red is high and the Similarity value is a high pos-
itive number.

Below are examples of cells with varying amounts of similarity between the NFkB
image in green and 7-AAD image in red shown here as a composite image. Themost
dissimilar image pairs in the upper left to themost similar image pairs in the upper
right.

Application Examples:
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— Quantify translocation.
— Identify copolarization of two probes.
— Used in the Nuclear LocalizationWizard
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XCorr Feature
The XCorr feature is ameasure of similarity or 'sameness' between two images - the
higher the value, themore similar the images. It is robust to intensity variations and
relative shifts between the images and is typically used with the combinedmask
MC. It is computed using the normalized cross correlation between the two input
images.

Application Examples:

— Used as amask-independent measure of similarity between two images.
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Understanding the System Features
The system features do not require amask.
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Camera Line Number Feature
The Camera Line Number feature returns the camera line number values. This fea-
ture is obtained from INSPIRE.

Application Example:

— Used in objects per mL feature.
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Camera Timer Feature
The Camera Timer feature returns the camera timer values that are in ticks. This fea-
ture is obtained from INSPIRE.

Application Example:

— Used in Time feature.
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Flow Speed Feature
The Flow Speed is the calculated flow speed, in mm/sec, of the object.

The Flow Speed feature is the speed of flow of the cells. It is obtained from
INSPIRE. It should be very consistent across all cells in a file.

Application Example:

— Determine consistency of flow.
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Object Number Feature
TheObject Number feature denotes the serial number of a cell in a file.

Application Example:

— Reference an object in a file.
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Objects/ml Feature
TheObjects per mL feature returns the object concentration with respect to local
volume.

Application Example:

— Monitor the object flow during the run. Note: Use the statistic Con-
centration to obtain objects/ml of a population.
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Objects/sec Feature
TheObjects per sec feature returns the local object concentration with respect to
time.

Application Example:

— Monitor the throughput during a run. Note: Use the statistic Concentration
to obtain objects/ml of a population.
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Time Feature
The Time feature returns the camera timer values that are in ticks, converted to secs
with a formula.

Application Example:

— Obtain the time taken to collect a sample
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About Masks
The set of pixels that contains the region of interest is called themask. In the fol-
lowing picture, themask consists of the set of pixels on the right image that are
colored cyan. The cell is represented in the greyscale image on the left. Calculating
some feature values, such as the Area value, requires only amask. Calculating oth-
ers, such as Intensity value, requires amask and a channel image.

There are three types of masks: Default masks, CombinedMasks and Function
Masks:

1 Default masks namedM01 throughM12 are either created in INSPIRE during
acquisition or created in IDEAS when a .rif file is opened. The default mask used
by INSPIRE during acquisition (Inspire) is different than the default mask created
in IDEAS (Default Object) when a .rif file is opened with QI or from an
ImageStreamX. Thesemasks are stored in the .cif file and cannot be changed by
the user.
Conversion note: Versions of IDEAS prior to 3.0 were using the System function
mask with a weight of 5 for the default masks which was more permissive and
resulted in larger masks.
Below is an example of the difference between the default masks.

2 Combinedmasks are created using Boolean logic to combine and subtract
masks. For example, the cytoplasmic mask is created by taking the brightfield
mask and not themorphology mask of the nuclear image.
You can use theMask Manager to combinemasks of different regions or images.
The IDEAS application default template provides a combinedmask namedMC
that is the union of the pixels from all channel masks and a NMC mask that is
everything outside of MC. The following illustration shows two channel masks
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that are combined into onemask, which is shown in the right-most panel.

Below is an example of making amembranemask using Boolean Logic.

3 Functionmasks are created with user input. There are fourteen types of function
masks, Dilate; Erode; Fill; Inspire; Intensity; Interface; Morphology; Threshold;
Spot; System; Object; Peak; Range; Skeleton; and Valley. Each of the functions
masks are defined here.

Refer to Creating New Masks with theMask Manager for more details about how to
create new masks.
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AdaptiveErode Mask
The AdaptiveErodemask identifies pixels that will form a circle that touch the input
boundary with at least a prescribed radius threshold. The radius threshold is
inversely proportional to the user input. Therefore the larger the input threshold value,
the smaller the circle radius which will includemore pixels and vise versa. The result
is an adaptive erosion that takes shape into account instead of a strict pixel number
erosion. For a strict pixel number erosion see "ErodeMask" on page 277.

Example 1:

Masking the head of sperm with the AdaptiveErodemask with the threshold value
set to 55.

Example 2:

Masking the labeledmidpiece section of sperm with the AdaptiveErodemask
threshold set to 75.

Application examples:

-Can be used to identify the head of sperm.

-Can be used in combination with the default channel mask tomask the cell mem-
brane.

-Can be used in applications where it is critical to erode amask based on the shape
of the input mask.
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Component Mask

Given an input mask with multiple pieces, each piece can be identified as a com-
ponent based on a selected feature. The components can be sorted in ascending or
descending order and each ranked order can be chosen as a separate component
mask.

Example 1: This object's mask has multiple pieces defined by a LevelSet mask.

In this example the area feature is used to define the largest component. The ranking
feature is area, sorted descending (highest to lowest/ largest to smallest) and the
first ranked object is shown, therefore the largest piece.

Example 2: Here is the image that has amask with multiple pieces. Themask is
shown in blue, on the right side image.

Choosing area as the ranking feature, if the “ascending” sorting order is selected,
then the components of themask will be sorted from smallest to largest.
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Selecting rank 1 in conjunction with an ascending sort order and the area ranking fea-
ture will return the smallest component, as seen on the left side image. Selecting the
“descending” sorting order will return the largest component, as seen on the right
side image.

Application Examples

-Can be used to identify separate components within amask

-Can be used in combination with theWatershedmask to identify an individual cell in
a conjugate or dividing cell

-Features may be calculated on individual components, for example Intensity of a
probe in each daughter cell can be used tomeasure asymmetric cell division

From left to right, nomask, watershedmask, component largest area, component
second largest area. This is a jurkat cell in telophase.
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Dilate Mask
The Dilate mask adds the selected number of pixels to all edges of the starting
mask.
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Erode Mask
The Erodemask removes the selected number of pixels from all edges of the start-
ingmask.
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Fill Mask
The Fill mask fills in any holes in the startingmask.

- 278 -



Component Mask

Inspire Mask
The Inspire mask masks pixels above background and is themask used during data
acquisition in INSPIRE. This mask is available to understand what is beingmasked
during collection and is not generally used for feature calculations.

Note: this mask is new in IDEAS versions 4.0 or later.
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Intensity Mask
The Intensity mask masks pixels between the lower and upper raw intensity
thresholds not background subtracted. See also ThresholdMask.

In the example below, cell #10678 is bright and cell #11992 is dim. The 50%
Thresholdmask is similar for both images whereas the Intensity mask 250+ is quite
different, since only a few pixels in the dim image are greater than 250 counts, while
most of themetaphase plates in the bright image aremasked.
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Interface Mask
The interfacemask identifies pixels in an object where the object is in contact with a
second object. Three input parameters are defined. First, themask of one of the
objects (cell of interest). Next, themask that covers both objects (conjugate). A
close fittingmask using another functionmask such as Object (tight) can be used for
the cell of interest mask. A brightfield mask can be used for the conjugate. Finally,
the width of the interfacemask from the contact point towards the cell of interest is
entered.

Examples are shown below:

Application Examples:

— Used to quantify synapses in T cell APC (antigen presenting cell) con-
jugates.
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LevelSet Mask
The LevelSet mask is an extension of theMorphology mask that identifies pixel in
non-homogeneous regions into three different levels: dim, middle and bright and the
combination of all three. Contour detailed level can be adjusted such that the smaller
the scale, the finer the image structure identified by the individual levels. This mask
is particularly helpful for masking complex brightfield images.

Application examples

-Used tomask bright, medium or dim areas of an object

-Can be used to get a closely fittingmask (combined option) in lieu of object or mor-
phology masks

-Can be used on brightfield and fluorescent channels

Example 1: From left to right, nomask, LevelSet (Bright), LevelSet (Middle),
LevelSet (Dim), Level Set (Combined). This is an image of a protein aggregate.

Example 2: Themask on the left is showing the LevelSet mask set to Dim with a
contour level of 6. On the right, we are showing amiddle level with a contour detail of
2.

Example 3: Image shows the use of LevelSet Mask with dim (first column), middle
level (second column), bright (third column), and combinedmasks (forth column) for
each cell.
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Morphology Mask
TheMorphology mask includes all pixels within the outermost image contour. This
mask, which is used in fluorescence images, is best used for calculating the values
of overall shape-based features.
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Object Mask
TheObject mask segments images to closely identify the area corresponding to the
cell. It is based on the assumption that background pixels exhibit high uniformity to
each other. This helps distinguish the background from the cell pixels. Themask
characterizes the background pixels using a set of features and then segments the
image by determining all the pixels that deviate from the background feature set. The
default option is used for the default segmentationmasks. The tight option uses a dif-
ferent set of features to characterize the background which results in a tighter fit
around the cell.

Examples are shown below:

Image
Object
(default)

Object
(tight)

Application Examples:

— Used to get a close fit around the cellular area (tight option).
— Can be used in lieu of themorphmask for applications where themorph is

so tight that it provides incompletemasking, sometimes splitting cells into
two regions, such as a nuclear dye image of cells in anaphase or telo-
phase.

— Can be used in lieu of themorphology mask with the Similarity feature
whenmeasuring nuclear translocation for better separation between
untranslocated and translocated cells (tight option).

— Used as the default segmentationmasks (default option).
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Peak Mask
The Peak mask identifies intensity areas from an image that have local maxima
(bright) or minima (dark). Initially, the peak mask will identify all peaks in the image.
To select peaks which have certain brightness, the spot to cell background ratio is
used. This is the ratio between the spot pixel value to themean camera background
value in the original image.

Below is an example of the Peak, bright option.

Application Examples:

— Used with the Spot Count feature to quantify the speckleness of cells.
— Separate connected spots in a Spot Mask into individual components.
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Range Mask
The Rangemask provides a capability to select components in an image within a
selected size and/or aspect ratio by setting aminimum andmaximum area andmin-
imum andmaximum aspect ratio.

To select pixels within a range of intensity values, see Intensity Mask.

Application Examples:

— Use with a Spot Mask to constrain the Spot Count feature to round spots.
— Use on any other mask that has multiple components to define unwanted

objects such as debris, objects that are too small or whose shapes are not
circular.
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Skeleton Mask
The skeletonmask provides the barebone structure of the object from the starting
mask. Two options are available: thin or thick skeletons. The thin option produces
the condensed shape of the object and typically takes a form of 1-pixel wide skeletal
line. The thick option is intensity weighted. The thin option is dependent on the
shape of startingmask; thick uses the pixel intensities and is less sensitive to the
shape of the startingmask. The user will need to pay careful attention to the starting
mask. In the example below theMorphology mask of the image was used as the
startingmask for creating the skeleton.

Application Examples:

— Thick skeletons can be used with shape-based features such as sym-
metry to accentuate the shape of an object, and provide greater sep-
arations.

— Separate singlets and doublets by computing the area of the thin skeleton
mask. We have used the object(tight) for this case.

— Nuclear morphology measurements with lobe count feature for cell clas-
sification cells.
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Spot Mask
The Spot Mask has two options: bright or dark. The bright option obtains bright
regions from an image regardless of the intensity differences from one spot to
another. The ability to extract bright objects is achieved using an image processing
step that erodes the image and leaves only the bright areas. The dark option obtains
dark regions. The spot to cell background ratio andminimum andmaximum radius
are specified by the user. The spot to cell background ratio is the spot pixel value
divided by the background in the bright detail image. A maximum radius of x and a
minimum radius of y implies the image contains spots with a thickness less than
2x+1 and greater than 2y+1 pixels.

The figure below illustrates the open residue process. The bright areas are eroded
from the original image and the detail eroded image is subtracted from the original
image resulting in the bright detail image.

- 289 -



Chapter 4

The image pairs below show objects in grayscale next to their corresponding Spot
Masks in cyan. Spot masks can be further refined using the Peak and/or Range
masks. See Peak MaskRangeMask.

Application Examples:

— Used with the Spot Count feature to enumerate spots in images such as
for FISHIS®.

— Used with Intensity features to quantify intensity in spots.
— Dark spot finds valleys in images such as the low intensity between 2

stained nuclei and is useful for finding immune synapses.
— Identifies the dark areas in red blood cells or parasitic infections in bright-

field imagery.
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System Mask
The Systemmask segments objects in an image based on a probability model of
how pixels should be grouped together. The user sets a weight value that defines a
loose or tight grouping. A low weight value groups in amore permissivemanner.

Shown is an example of a cell with a apoptotic bleb that is not masked with the Sys-
temmask weight set at 5 but is masked with the Systemmask weight set at 2.

Application Example:

— Used on brightfield images to capture a low contrast areas such as cells
that undergo a blebbing process, tails of sperm or other low contrast type
of structures.
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Threshold Mask
The Thresholdmask is used to exclude pixels, based on a percentage of the range of
intensity values as defined by the startingmask. The user chooses the starting
mask when creating the Thresholdmask. See also Intensity Mask.

In the example below, cell #10678 is bright and cell #11992 is dim. The 50%
Thresholdmask is similar for both images whereas the Intensity mask 250+ is quite
different, since only a few pixels in the dim image are greater than 250 counts, while
most of themetaphase plates in the bright image aremasked.

Application Example:

— Used with the Area feature to define apoptotic cells in the Apoptosis Wiz-
ard.
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Valley Mask
The Valley mask is a rectangular mask that sits between two bright regions in a start-
ingmask, such as between two nuclei. It is constructed by finding theminimum
intensity along the skeletal line between these two bright regions. The skeletal line is
obtained internally using the skeleton (thin) masking as described in SkeletonMask.
This minimum intensity identifies the intersection between the two objects. The
mask is drawn perpendicular to this skeletal like. The length of the valley mask rect-
angle is equal to theminor axis of the object and the width of themask is defined by
the user in pixels.

Application example:

— Quantify the intensity of a probe in an immune synapse.
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Watershed Mask
The watershedmask is used to separate a single mask intomultiple components.
There are several user inputs to optimize themask. Here is the user interface and fol-
lowing is the detailed explanation with examples.

In image 4587 below, there are two components masked together as one. The water-
shedmask can be used to “erase” part of themask in between the two components.
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If the “intensity weighted” option is selected, themask will be computed based on
the image intensity values.

The watershed algorithm works by treating the image as a surfacemap and filling it
with “water” from the bottom. When the pools of water meet, a border is created.
Choose “peaks” or “valleys” to set the orientation of bright and dark points. If “val-
leys” is chosen, low intensities will represent low points and high intensities will rep-
resent high points. As shown below, this results in poor segmentation for this image.
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If “peaks” is chosen, then high intensities are used as the basins and low intensities
represent high points. This results in much better segmentation for this example
image.

The next adjustable parameter is smoothing. A low amount of smoothing can result
in over-segmentation, as seen below.

A large smoothing value can also result in poor segmentation results.
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A good smoothing value will result in the best segmentation results.

The final parameter is Line Thickness. This sets the thickness of the dividing line
between components.
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Application Examples

-Can be used to separate two attached cells based on DNA content, for example cell
conjugates or dividing cells

-Can be used in combination with the component mask to analyze individual cells in
conjugates or dividing cells

From left to right, brightfield nomask, DAPI Ch7 nomask, brightfield watershed
mask. This a jurkat cell in telophase.
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Chapter 5: Troubleshooting
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Troubleshooting
This chapter covers common issues and provides solutions.

Always make sure you are using the most up-to-date version of
IDEAS by logging in to your account at www.amnis.com and down-
loading the software.

Application Hanging
If the IDEAS application is hanging, theremay be amemory issues, especially with
large file processing. Youmust use the Task Manager to force quit the application.

1 Press and hold Ctrl + Alt + Delete.
2 TheWindow Task Manager appears.
3 Under the Applications tab, select IDEAS Application.
4 If the status is Not Responding, select End Task.
5 Themanager will force quit the application after a confirmation.

Compensation
Sometimes an appliedmatrix produces poorly compensated data. This can happen
for a number of reasons: 1) miscalculation of the compensationmatrix by inclusion
of inappropriate events (such as doublets, saturated pixel events, or artifacts), 2)
controls used for matrix calculation differ significantly from the experimental
samples (different cell type, different probe), or 3) cells exhibit substantial auto-
fluorescence. This protocol describes amethod for manually adjusting and validating
a compensationmatrix for difficult samples.

To troubleshoot and repair a compensationmatrix:

1 Create a population of cells that aremiscompensated using the tagging tool. See
Creating Tagged Populations. Choose single cells that are exhibiting crosstalk.
Choose a range of intensities from negative to bright but not saturated, preferably
single color. If single color cells are not available, choose cells with a distinct
staining pattern in the peak channel.

2 Create Intensity scatter plots of adjacent channels in order to observe the over-
or under-compensation.

3 Identify thematrix values that need adjusting by inspecting the scatter plots and
images. Each column contains the coefficients for the peak channel into the cor-
responding crosstalk channels (rows). For example the crosstalk of channel 2
(green) into channel 3 is highlighted in thematrix below.
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• Undercompensation (crosstalk coefficient is too low):
Plots: Intensity mean for the single color positive population is higher than the
unlabeled population in the crosstalk channel or the intensity in the crosstalk
channel trends diagonally upwards.
Images: the crosstalk channel contains an apparent fluorescent mirror-image.

• Overcompensation (crosstalk coefficient is too high):
Plots: Intensity mean for the single color positive population is lower than the
unlabeled population in the crosstalk channel or the intensity in the crosstalk
channel trends diagonally downwards.
Images: the crosstalk channel contains dark spots corresponding to the bright
spots in the fluorescent channel of interest.

4 In the Compensationmenu choose View/Edit Matrix andmanually change the
incorrect crosstalk matrix values identified above. Start with changes of ~.1 or
~.05 and use smaller and smaller increments as you refine thematrix.

5 Click Preview and choose the tagged population to view the results of the
changed coefficient.

6 Repeat steps 4 and 5 until thematrix is corrected.
7 Click Save, appendmanual to thematrix name, then click OK.
8 Open the .cif file and use the new matrix to create a new .daf file.

Creating a TIFF
If you cannot see the TIFF image that you created, trying changing the resolution to
8-bit.
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Deleting a Population and Region
Often, a user deletes a population but forgets to delete the region. Deleting a pop-
ulation does not delete the region. Youmust delete the region itself.

Object Number set to Zero
When opening a .daf file, theremay be an error if the object number is set to zero.
This can happen if the data was collected during a crash within INSPIRE. This error
can be corrected with the following procedure.

1 Select Tools > Merge .rif Files.
2 Click Add Files to select the single .rif file.
3 Click OK. Enter a new name if desired. The single .rif file will merge with itself

and rewrite the file with the proper object count.

Buttons or options in windows are not appearing
When the font size setting is set to large somewindows will not size properly caus-
ing buttons or text boxes to not appear. To change the font size inWindows go to the
Control Panel>Display>Appearance and select Font size Normal.
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Term Definition

acquisition
The process of collecting data from the ImageStream cell analysis
system.

brightfield
A type of illumination that uses transmitted light. On the
ImageStream cell analysis system, this light is provided by a halogen
lamp.

brightfield image
An image that is produced by transmitted light. On the ImageStream
cell analysis system, this light is provided by a halogen lamp.

brightfield The camera channel that the brightfield image appears in.

calibration
The precise adjustment of instrument components based on test res-
ults for the purpose of optimizing functionality.

CCD See charge-coupled detector (CCD).
One of the six physical partitions on the camera. Each camera chan-
nel collects a different spectral band of imagery, which allows for the
collection of brightfield, darkfield, and up to four fluorescence images
per object.

charge-coupled
detector (CCD)

A sensor for recording images that consists of a particular type of
integrated circuit—one that contains an array of linked, or coupled,
capacitors. Under the control of an external circuit, each capacitor
can transfer its electric charge to either of its neighbors.

coefficient of variation
(CV)

Themean-normalized standard deviation, expressed as a per-
centage. The CV measures the variation of a feature value inde-
pendent of the populationmean value. The formula is: CV = 100 ×
standard deviation / mean

CV See coefficient of variation (CV).

compensation

The process of removing intensity—specifically, intensity that was
derived from fluorescence crosstalk that originated from dyes
centered in other channels. The IDEAS application performs com-
pensation on a pixel-by-pixel basis.

compensation matrix
The set of values that report the relative amount of fluorescence of
each probe in each channel. The compensationmatrix is used to sub-
tract intensity originating from dyes centered in other channels.

crosstalk
Leakage of fluorescence signal from a fluorochrome into adjacent
channels.

darkfield

A type of illumination in which the sample is illuminated at angles that
do not directly enter the objective. On the ImageStream cell analysis
system, 90-degree angle side scatter from the 488-nm laser provides
the darkfield imagery.

FISH See fluorescent in situ hybridization (FISH).

fluorochrome
A fluorescent dye used to label cellular constituents or specific
probes of cellular constituents.

fluorescence Light emitted by a fluorescent dye following excitation.

Table 1: Glossary of Terms
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Term Definition
fluorescence com-
pensation

The adjustments made to remove the fluorescence emissions of a
fluorochrome into adjacent channels.

fluorescent in situ hybrid-
ization (FISH)

A physical mapping approach that uses fluorescent tags to detect the
hybridization of probes with metaphase chromosomes or the less-con-
densed somatic interphase chromatin.

gain The amplification of a detector signal.

grayscale
The brightness level, ranging from black to white, of a pixel or group
of pixels.

pixel
A pixel is equal to a half micron in length with the 40X objective, 1
micron with the 20X objective and 0.33microns with the 60X object-
ive. Note that 1 pixel = x µm2.

saturation
The state of a pixel that has a value at or above 1023 for the IS100 or
4095 for the ImageStreamX.

segmentation The process of discriminating an object from its background.

spectral decomposition
element

A custom set of longpass dichroic filters arranged in an angular array.
The spectral decomposition element directs different spectral bands
to laterally distinct channels on the detector. With this technique, an
image is optically decomposed into a set of six sub-images, each cor-
responding to a different color component and spatially isolated from
the remaining sub-images.

spatial offset
The registration error of the six channel images for a single cell. The
spatial offset is measured during calibration and the values are saved
to the image database.

Table of Coefficients
The table used by the compensationmatrix to place the detected light
that is displayed in each image into the proper channels, on a pixel-
by-pixel basis.

template

A file that saves the set of instructions for an analysis session. Note
that a template contains no data; it simply contains the structure for
the analysis. This structure includes definitions of features, graphs,
regions, and populations; image viewing settings; channel names;
and statistics settings.
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Index

A

Acquisition information 77

Advanced Analysis 52

Analysis Area

adding an image panel 111

adding text 118

overview 102

printing 155, 166

tools 103

Apoptosis

wizard 36

Application defaults 7, 142

Area 183

ast

about 21

B

Batch processing 79

Brightfield information 78

Building Blocks 50

Fluorescence Positives-one color 50

Fluorescence Positives-two color 50

Focus 50

Single Cell 50

Single Cell Default 50
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Size/SSC 50

Tool 103

C

Camera settings information 78

Cell Classifiers 78

Cell Cycle

using a wizard 38

Channels collected 78

cif

merging 75

opening 56

saving 59

cif;about 20

Co-localization

using a wizard 40

Color

mapping dark/light mode defaults 13, 148

Show in Image Gallery 85

Compare, FlowSight, FlowSight QI, ImageStream 17

Compensation

adjusting compensation population 68

creating 62

definition 18

editing the matrix 70

overview 61

validating matrix 66
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view matrix 78

Compensation matrix file

about 21

creating 62

Composites 90, 152

Copying images 92

Corrections information 77

ctm

about 21

creating 62

D

daf

about 20

opening 58

saving 59

Data analysis steps 24

Data analysis tools

about 83

Data files

ast 21-22

cif 20, 22

ctm 21-22

daf 20, 22

new from populations 76

opening 53

rif 20, 22
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type 22

Defaults

application 6

color mapping dark/light mode 13, 148

compensation matrix 17

directories 8, 143

graph export 10, 145

graphs 10, 145

image export 12, 147

mask 17

mask color 9, 144

population color 9, 144

population symbol 9, 144

Diameter 184

Directories

changing default 8, 143

Display

making composites 87, 149

setting properties 87, 149

setting properties using a wizard 30

views in the Image Gallery 87, 149

E

EDF

kernels 78

Example data files 6
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Exporting data 163

features 163

pixel intensity values 164

F

Feature Finder

wizard 32

Feature Manager

overview 121

tasks 126

tools 122

Features

angle 195

angle intensity 195

Area 183

aspect ratio 208

aspect ratio intensity 209

Bkdg mean 237

Bkgd std dev 238

bright detail intensity 218

camera line number 264

camera timer 265

categories 173

centroid delta x and y 197

centroid delta xy 199

centroid x and y 196

circularity 210
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compactness 212

contrast 220

create combined 125

create multiple 123

create new 123

delete 126

diameter 184

elongatedness 213

Feature Finder Wizard 34

find a feature 127

flow speed 266

gradient max 222

gradient RMS 223

height 185, 193

intensity 239

internalization 259

lobe count 214

major and minor axis intensity 188

major axis and minor axis 187

max contour position 202

min pixel 244

modulation 232

object number 267

object per mL 268

object per sec 269

overview 171
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perimeter 189

raw intensity 245

raw max pixel 246

raw mean pixel 247

raw median pixel 248

raw min pixel 249

saturation count 250

saturation percent 251

shape ratio 215

similarity 260

similarity texture R3 256

size 182

spot area min 190

spot count 233

spot distance min 204

spot intensity min 252

std dev 235

symmetry 2 216

table alphabetical list 174

table by category 176

thickness max 191

time 270

valley x and y 205

viewing 122

viewing value on image 90, 152

width and height 185, 193
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without QI 181

File name extensions 6, 53

Fluorochromes

table for IS100 64

table for ISX 1 camera 64

table for ISX 2-camera 64

Focus building block 50

G

graphs

copy and paste 110

Graphs

apply or remove region 110

creating 104

creating regions 107

defaults 10, 145

exporting defaults 10, 145

legend 106

moving 107

printing 167

resizing regions 109

statistics 106

zoom 109

Guided Analysis 25

H

Hardware requirements 5
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Histogram tool 103

I

IDEAS

getting started 24

Image

copy 92

exporting defaults 12, 147

individual image 91

show feature value 90, 152

Image Display intensity mapping 88, 150

Image Gallery

channel view 85

composites 90, 152

ordering objects 85

overview 84

population 85

printing 155, 166

properties 86-87, 148-149

properties tool 84

resize 86

see mask or feature used in view 86

show-hide color 86

show-hide masks 85

show saturation 86

tools 84

using 84
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views 89, 151

Image panel size

change in Image Gallery 87, 149

Individual image

display properties 114

manipulating 91

measurement tool 112

pixel intensities 112

show-hide mask 116

Internalization

using a wizard 42

L

Large data files 55, 80

Laser information 78

Line Region Tool 103

M

Mask

AdaptiveErode 273

Component 274

LevelSet 282

Watershed 294

Mask Manager

overview 93

tools 96
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Masks

about 271

combining 96

creating new 93

default color 9, 144

dilate 276

edit 96

erode 277

examples 98

fill 278

intensity 280

list of 94

morphology 284

object 285

peak 286

range 287

show in Image Gallery 84

skeleton 288

spot 289

system 291

threshold 292

valley 293

viewing definitions 96

Merging cif files 75

Merging raw images files 74
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Mitosis

using a wizard 38

N

Name and Color

Image Gallery 87, 149

Nuclear Localization

using a wizard 44

Nuclear translocation

using a wizard 44

O

Object Data 116

Object Feature Values Table 103

One color histogram building block 50

Opening files

using a wizard 28

Oval Region Tool 103

P

Pointer tool 103

Polygon Region Tool 103

Population Manager 133

tools 134

Population Statistics 119

Population Statistics table 103

Populations

creating 136
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creating a new data file from 76

creating combined 134

deleting 133

display properties 133

during acquisition 78

viewing 133

Printing 155

R

Rectangle Region Tool 103

Region Manager 138

Regions

editing 138

viewing 138

Reporting 140

changing color mapping 154

graphs and statistics 156

Images 155

Images and Graphs 154

light mode graphs 154

statistics 158

statistics from multiple files 160

Reports

printing data 155, 166

rif

about 20

merge 74
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opening 53

S

Sample Information

view 77

Saturation

view in Image Gallery 85

Saving data files 59

ast 60

cif 59

daf 59

Template 60

Scatter plot tool 103

Scatter plots

show-hide populations 110

Screen resolution 6

Segmenting large rif files 80

Select All Panels Tool 103

Shape Change

using a wizard 46

Single Cell Building Block 50

default 50

Size/SSC Building Block

default 50

Software requirements 5

Spot Count

using a wizard 48
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T

Tagging tool 84, 103

Template file

about 21

default 17

definition 18

saving 60

Text tool 103

TIFs

creating 165

Two color scatter plot building block 50

V

Views

custom 89, 151

Volume information 77

W

Wizards

Apoptosis 36

Begin Analysis 31

Cell Cycle - Mitosis 38

Co-localization 40

Display Propertes 30

Feature Finder 32

Internalization 42

list 26
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Nuclear Localization 44

Open File 28

Shape Change 46

Spot Count 48

Tool 103

Workflow; data analysis workflow 18

Z

Zoom

Image Gallery 85
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